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Chapter 1

1: Welcome 

WHAT IS groov VIEW?

groov View is Opto 22’s operator interface tool that is simple, browser-based, and connected to automation 
systems, software, databases, and devices of all kinds. We call it Mobile Made Simple®.

Simple: groov View requires only a web browser to connect to devices, build operator interfaces, and monitor 
and control them. groov View puts ready-made gadgets at your fingertips: just drag, drop, and tag. Create 
real-time trends up to 5 years; define events and operator notifications. Authorize users and groups. 
groov View makes it simple to build, deploy, and view effective, scalable operator interfaces. 

Browser-based: To view your groov View interface, use any brand computer or mobile device with a current 
web browser, from smartphones and tablets, to laptops and computers, to a web-enabled big-screen TV. For 
mobile, get the free groov View app for Android® or iOS®. groov View can augment existing human-machine 
interfaces (HMIs) and SCADA systems by making specific data available to authorized users at any time and in 
any location. Use event notifications to alert selected personnel anywhere about system events based on one 
or more conditions.
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Connected: In your groov View operator interface, you can use tags from all the sensors, equipment, and 
software connected to your groov EPIC®, groov Server™ for Windows®, or legacy groov Box™—which may be 
from a wide variety of manufacturers and software companies. Mix data and controls from all of these 
connected things in your operator interface in any way that suits your application. You can also test project 
ideas without connecting to a live machine or system using the built-in Data Simulator. 

groov View brings key data from processes, sensors, OEM machines, manufacturing and building systems, 
software, databases, and online services into the hands of those who need it. 

Connecting Data and Users

groov View connects to a variety of data sources and presents that data to users for visualization and action. 
Your groov View users may be human operators or software that uses the groov Data Store API.

The image below shows how groov View connects data sources and users. Automation data sources are on 
the left; they interact directly with groov View. On the right are software users that write data to a groov Data 
Store or read data from that store via the API. (In a groov EPIC system or legacy groov Edge Appliance 
(groov Box™), you may also have Node-RED and Ignition Edge® OPC-UA® and MQTT tags as sources of data.) 

At the bottom of the image are human operators who interact with your groov View interface. They can 
securely view and act on data from automation sources, Data Stores, and other sources that you determine. 
You manage all users and control what each one can see and do. 

Build your Operator Interface

To build your groov View operator interface, you have a library of pre-built gadgets you can simply drag and 
drop onto the screen. Then, you import and use tags from systems and equipment including Modbus®/TCP 
devices, Opto 22 groov EPIC processors and groov RIO® modules, SNAP PAC™ controllers and I/O units, and 
many other manufacturers’ systems, equipment, and databases. You can also manage user accounts and set 
up email or text message event notifications in Build mode.
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View your Interface

The groov View operator interface you build resides on a groov EPIC processor, groov Server, or a legacy 
groov Box. Your human users access the interface using any device with a current web browser and a network 
connection to groov View running on one of those groov devices, or using the free groov View app on an iOS 
or Android smartphone or tablet. 

Mobile Device Apps

groov View for iOS and groov View for Android are free native apps for your tablet or phone. You can run 
groov View in your browser, but these apps display your interface in full-screen mode. 

groov View on a tablet and a smartphone
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These native apps add other advantages as well. You can add another layer of security by setting up passcodes 
in the app. If you have more than one groov View project, you can easily access all of them from the app. The 
iOS app is also ideal for OEMs and machine builders who want to use a tablet as an operator interface to a 
machine. You can lock the device so it runs only groov View.

Get groov View for iOS. 
Get groov View for Android. 

Comparing Build Mode and View Mode

The following chart shows some key points about building and viewing your operator interface.

Build mode View mode

Use for

Building an operator interface:
• Connect to devices and systems
• Build screens
• Create events and notifications
• Authorize users
• Back up projects

Viewing an operator interface:
• Monitor and control 

equipment/systems
• View or change data

Who uses it

Authorized users: 
• An Admin has full control
• An Editor can change pages but cannot 

authorize users

Authorized users: 
• An Operator can log in/out and 

change password
• Kiosk users cannot log out or change 

password

Passwords and 
API keys

Password:
• An Admin sets the username and 

password at first login to groov View. 
• An Admin user can assign usernames and 

passwords (and API keys, for software 
users) to all users.

Password:
A username and password are assigned 
to each user by an Admin.

View in browser View in app

https://itunes.apple.com/us/app/groov-view-for-ios/id639797810?mt=8
https://itunes.apple.com/us/app/groov-view-for-ios/id639797810?mt=8
https://itunes.apple.com/us/app/groov-view-for-ios/id639797810?mt=8
https://play.google.com/store/apps/details?id=com.opto22.aWD
https://play.google.com/store/apps/details?id=com.opto22.aWD
https://play.google.com/store/apps/details?id=com.opto22.aWD


CHAPTER 1: WELCOME

groov View User’s Guide 5

Products that Include groov View

groov View is part of the groov EPIC processor, the PC-based groov Server for Windows software, and the 
legacy groov Edge Appliance (groov Box).

groov EPIC (edge programmable industrial controller, part number GRV-EPIC-PR1 and GRV-EPIC-PR2) is a 
system for automation and industrial internet of things (IIoT) applications. groov EPIC provides real-time 
control, connectivity to industrial and IT equipment and systems, data handling at the edge of the network, 
and visualization for your system. Learn more about the groov EPIC system.

groov Server for Windows (part number GROOV-SVR-WIN-BASE) provides visualization only and can be 
installed on a Microsoft® Windows® PC. Once installed, groov Server runs as a service on your computer. 

groov Edge Appliance (part number GROOV-AR1-BASE), also called the groov Box, is an industrially 
hardened appliance that provides connectivity, data handling, and visualization. It is a legacy product as of 
June 2021 and not recommended for new development. For new projects, choose the groov EPIC system.

No matter which of these groov products you use, your groov View operator interface can be viewed on 
almost any mobile device or computer. And, you can develop on one groov product and later move your 
project to another: for example, develop on groov Server and then move the project to groov EPIC.

For more information about:
• groov EPIC: see the groov EPIC Processor Data Sheet (form 2245).

How to get 
there

1. Open a web browser. For the URL, enter:
groov EPIC or groov Box
https://[hostname]/ or 
https://[IP address]/
groov Server
https://localhost/ or 
https://[Server’s hostname 
or IP address]/

2. From groov View, click Settings (gear in 
upper right), and choose Switch to 
Build mode.

groov EPIC
1. Open a web browser. For the URL, 

enter:
https://[hostname]/ or 
https://[IP address]/

2. Click groov View.

groovBox
Open a web browser. For the URL, enter:
https://[hostname]/ or 
https://[IP address]/

groov Server
Open a web browser. For the URL, enter:
https://localhost/ or 
https://[Server’s hostname 
or IP address]/

On a mobile device, use the free
groov View app for iOS or Android. Open 
the app and log in with your username 
and password.

How to get 
there in 
groov Find 
(Windows or 
Mac®)

For a groov EPIC or groov Box (does not 
apply to groov Server for Windows): 
• Click Search For Devices. 
• Find the label on the groov device that 

shows its serial number. 
• For groov EPIC, click groov Manage and 

then groov View. For a groov Box, click 
groov View.

[Not normally used]

Build mode View mode

https://documents.opto22.com/2245_groov_EPIC_Processor_Data_Sheet.pdf
http://www.opto22.com/site/pr_details.aspx?cid=4&item=GROOV-SVR-WIN-BASE
https://www.opto22.com/products/grv-epic-pr1
http://www.opto22.com/site/pr_details.aspx?cid=4&item=GROOV-AR1-BASE
http://www.opto22.com/products/groov-epic-system
http://www.opto22.com/products/groov-epic-system
https://www.opto22.com/products/grv-epic-pr2
http://www.opto22.com/products/groov-epic-system
http://www.opto22.com/products/groov-epic-system
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• groov Server: see the groov Server for Windows User’s Guide (form 2078).
• groov Box: see the groov Box User’s Guide (form 2104).

SYSTEM REQUIREMENTS

To build operator interfaces with groov View, you need:
• Any computer with a web browser (does not need to be a Windows PC; see the Release Notes for 

groov View for currently supported browsers and operating systems)
• One of the following:

– groov EPIC
– groov Server for Windows
– a legacy groov Box Edge Appliance (groov View version 4.4 and lower only)

You can connect to any of the following devices or services to get and send data:
– A Modbus/TCP device
– A database, online service, or software program to get data from or put data into a Data Store using 

the groov View API
– An Opto 22 groov EPIC processor or SNAP PAC controller (SNAP PAC S-series, R-series, or SoftPAC 

with firmware R9.2a or newer) running a PAC Control strategy
– An Opto 22 groov EPIC I/O unit
– An Opto 22 groov RIO module
– An Opto 22 SNAP PAC I/O unit 
– (groov EPIC or legacy groov Box only) A database, cloud application, API, or serial device accessible 

via a Node-RED node. (For a groov Box, see requirements in the user’s guide.)
– OPC UA-compatible automation system or equipment. Ignition® Edge® supplies an internal server 

and drivers for groov EPIC or a legacy groov Box. An external OPC UA server is required for 
groov Server; an external server and additional drivers may be required for your equipment.

NOTE: Browser-based groov View software works on a large number of device/operating system/browser 
combinations including HDTVs, smartphones, tablets, and computers. If a browser is causing issues, see the list of 
currently supported browsers in the groov View Release Notes. For Product Support, see page 7. 

ABOUT THIS GUIDE

This user’s guide teaches you how to build and view an operator interface with groov View.

This guide assumes that you have already set up your groov product, that you are already familiar with your 
personal computer’s operating system, and that you know how to use your tablet or smartphone.

To set up groov EPIC, see the groov EPIC User’s Guide (form 2267).

To install groov Server for Windows, see the groov Server for Windows User’s Guide (form 2078).

To set up groov Box, see the groov Box User’s Guide for GROOV-AR1 (form 2104).

In this Guide

Chapter 1: Welcome introduces this user’s guide and groov View.

Chapter 2: Building a Project walks you through building a sample project, and then describes how to 
create pages, add devices and tags, and configure gadgets.

Chapter 3: Managing groov View describes how to manage user accounts, back up and restore your 
project, and update groov View and your license.

https://documents.opto22.com/2267_groov_EPIC_Users_Guide.pdf
https://www.opto22.com/support/resources-tools/documents/rm-groov-view-readme
https://www.opto22.com/support/resources-tools/documents/rm-groov-view-readme
https://documents.opto22.com/2104_groov_Box_Users_Guide_for_GROOV-AR1.pdf
https://www.opto22.com/support/resources-tools/documents/rm-groov-view-readme
https://www.opto22.com/support/resources-tools/documents/rm-groov-view-readme
https://documents.opto22.com/2078_groov_Server_Users_Guide.pdf
https://documents.opto22.com/2078_groov_Server_Users_Guide.pdf
https://documents.opto22.com/2104_groov_Box_Users_Guide_for_GROOV-AR1.pdf
https://documents.opto22.com/2104_groov_Box_Users_Guide_for_GROOV-AR1.pdf
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Chapter 4: Gadget Reference provides details on how to configure gadget properties.

Chapter 5: Using Events and Notifications describes how to set up user accounts and event conditions in 
groov so that users can be notified about system status. Events can also be used as tags with gadgets.

Chapter 6: Viewing Your Operator Interface describes how to open and use a groov View HMI on any 
device with access to the Internet.

Chapter 7: Troubleshooting and Additional Help provides troubleshooting information and answers 
questions you may have about groov View. 

Appendix A: IP Cameras describes the IP cameras that work with the Video gadget.

Appendix B: OPC UA Data Types Supported lists the OPC UA data types supported in groov View and the 
corresponding groov View names. 

Appendix C: Data Simulator Tags lists the Data Simulator tags and briefly describes what they do.

OTHER groov RESOURCES

Get free online training for groov View and related products at training.opto22.com. For additional information 
on related products, visit the Opto 22 website: www.opto22.com.

PRODUCT SUPPORT

If you have any questions about groov View, you can call, fax, or email Opto 22 Product Support.

Phone: 800-TEK-OPTO 
(800-835-6786 toll-free in the U.S. and Canada)
951-695-3080
Monday through Friday, 
7 a.m. to 5 p.m. Pacific Time

Email: support@opto22.com

Opto 22 website: www.opto22.com

NOTE: Email messages and phone calls to Opto 22 Product Support are grouped together and answered in the order 
received.

When calling for technical support, be prepared to provide the following information about your system to 
the Product Support engineer:
• groov product you are using (groov EPIC, Server, or Box) and license 
• groov version. In Build mode, select Help > About.
• A description of your system equipment:

– Computer type, speed, memory, and operating system
– Brand and model numbers for the controllers or devices you are monitoring and controlling through 

groov
• A description of the network
• Specific error messages or other diagnostic indications

mailto:support@opto22.com
https://www.opto22.com
https://training.opto22.com/
http://www.opto22.com/
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Chapter 2

2: Building a Project

This chapter describes the basic aspects of creating an operator interface in groov Build mode including how 
to create pages, add devices and tags, and configure gadgets. The operator interface you build resides on the 
groov EPIC processor or groov Box, or on the PC where groov Server is installed. Your authorized users can 
access it from a computer, smartphone, tablet, or other device with a web browser.

In this chapter:
Opening Build Mode on groov EPIC..................................................................10
Opening Build Mode on a legacy groov Box.................................................10
Opening Build Mode in groov Server for Windows....................................10
Building a Sample Project ......................................................................................11
Working with Pages ..................................................................................................21
Working with a Device.............................................................................................29
Adding Gadgets..........................................................................................................72
Editing Gadgets ..........................................................................................................74
Optimizing Layouts ...................................................................................................77

OPENING BUILD MODE ON groov EPIC

To create your groov View HMI, you must be on a computer. Once the HMI is built, you can use it on the 
groov EPIC processor’s built-in high-resolution touchscreen. 

These steps assume you have already installed and initialized your groov EPIC processor following the steps in 
the groov EPIC User’s Guide (form 2267). 

To open Build mode on a groov EPIC:
1. From a computer, log into the groov Manage Home screen.
2. Click the groov View button . 

groov View opens first in View mode. 
3. Click Menu (gear icon) on the top right-hand side and click Switch to Build mode.

Gear icon

https://documents.opto22.com/2267_groov_EPIC_Users_Guide.pdf
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OPENING BUILD MODE IN groov SERVER FOR WINDOWS

When opening groov View for the first time in groov Server for Windows, make sure you follow the instructions 
in the groov Server for Windows User’s Guide (form 2078).

To open Build mode in groov Server:
1. Open Google® Chrome®, Mozilla® Firefox®, or another supported browser (see the groov View Release 

Notes for current information), and do one of the following:
– If groov Server is installed on the same computer, type https://localhost in the address bar 

of your browser.

– If groov Server is installed on a different computer, type https:// and the computer’s hostname. 
For example, if the computer’s hostname is RStarr-w10, you type https://RStarr-w10
You can use the IP address of the host PC instead of the hostname. However, if the PC is on a 
network with DNS and DHCP, the IP address is subject to change.

NOTE: If groov View does not open, see Chapter 7: Troubleshooting and Additional Help.

2. When groov View opens, log in. 
groov View opens first in View mode.

3. Click Menu (gear icon) on the top right-hand side and click Switch to Build mode.

OPENING BUILD MODE ON A LEGACY groov BOX

When opening groov View for the first time on a groov Box, make sure you follow the instructions in the 
groov Quick Start for GROOV-AR1 (form 2103). For additional information, see the groov Box User’s Guide for 
GROOV-AR1 (form 2104).

NOTE: To use a URL hostname, your network must have a DNS. If it doesn’t, see page 166 for information on how to 
use groov Find.

To open Build mode on a groov Box:
1. Enter https:// followed by your groov Box’s hostname as the URL. The hostname is printed on the 

bottom of the groov Box (see the following image).
For example, if the hostname is opto-00-d2-dc, you type: 
https://opto-00-d2-dc

NOTE: If you assigned a static IP address to the groov Box, use the IP address instead of the hostname.

Address bar

Gear icon

https://documents.opto22.com/RM_GROOV_VIEW.pdf
https://documents.opto22.com/RM_GROOV_VIEW.pdf
https://documents.opto22.com/2078_groov_Server_Users_Guide.pdf
https://documents.opto22.com/2103_groov_Quick_Start_for_GROOV-AR1_web.pdf
https://documents.opto22.com/2104_groov_Box_Users_Guide_for_GROOV-AR1.pdf
https://documents.opto22.com/2104_groov_Box_Users_Guide_for_GROOV-AR1.pdf


CHAPTER 2: BUILDING A PROJECT

groov View User’s Guide 11

2. When groov View opens, log in. 
groov View opens first in View mode. 

3. Click Menu (gear icon) on the top right-hand side and click Switch to Build mode.

BUILDING A SAMPLE PROJECT

To get started, let’s build a page using tags in the Data Simulator and then view it on the computer. Here’s 
what we’ll do:
• Add a page
• Add a device (page 13)
• Add device tags (page 14)
• Add gadgets (page 14)
• Save the project (page 17)
• View the project on your computer (page 17)
• Explore (page 17)

When Build mode opens, you see the workspace where you’ll build your operator interface:

Hostname

Gear icon
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Add a Page

1. In the Pages panel on the left side of the workspace, click Add Page. 

2. Enter a name for the page in the Page Name field.
3. Click the color block to choose a background color.
4. For now, leave the page as Uncategorized.
5. For now, leave All Users in the Access Rights field.
6. Click OK.

The blank page appears in the center of the workspace.

List of all pages in your 
interface

Page you’re working 
on appears here.

Add pages and 
organize them into 
categories.

See properties for the 
page highlighted in 
the list. 

Page as viewed on computer or tablet Page as viewed on smartphone
Choose gadgets and tags.

Assign gadget properties.
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Add a Device

1. In the Gadget Palette panel (lower right), click Configure Devices & Tags.

2. On the right side of the Configure Devices and Tags window, click Add New Device.
3. Select Data Simulator.

4. Click Close.
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Add Device Tags

1. In the Gadget Palette panel, click the plus sign (+) next to Data Simulator.

2. Click the plus signs (+) in the tree to see the tags in the device.

Add Gadgets

1. Expand the Data Simulator tree and click the bool Variable A tag.
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A list appears showing all the gadgets that work with this tag. 

2. Click the LED gadget and drag it to the page you are building. 
3. Click the gadget to highlight it and notice that properties appear in the Gadget Properties panel (upper 

right). 

4. Scroll down to see all the possible properties you can choose and adjust. Enter the following properties 
and watch how the LED gadget changes after each one.

Property You choose... Result

Label Line 21 Tag name is replaced with label.

Alignment Right Label moves to right of gadget.

Text Size

12 Label text becomes smaller (default is 16 pixels).

Click 
Button changes to show link broken. This means that the 
label text size you just chose (12) will affect only the 
Desktop & Tablet view, not the Handheld view. 

Font Verdana Font on the label text changes.

Text Styling B Label text is boldfaced (thicker).
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5. Notice that part of the LED and its label text are hidden. Use your mouse to grab a corner handle on the 
gadget and expand it so everything is visible. 

6. In the Gadget Palette, click bool Variable A again.
7. Click Button and drag it to the page next to the LED.
8. Click to highlight the button.
9. In the Gadget Properties area, enter the following: 

10. With the button highlighted, use the handles to make it as large as the LED gadget so you can see all the 
text.
Your page now looks something like this:

Colors
Text: Deep Green Text changes color.

Background: Silver Silver background appears in gadget area.

Graphic Size
Uncheck Auto and 
choose 6

LED becomes larger.

On/Off Colors
True: Dark Green LED color changes.

False: [Leave as is] No change

Property You choose... Result

Confirm Writes Check the box
When someone pushes this button, they arerequired 
to verify the button’s action before it happens.

Display Mode [Leave as Button] No change

Label Turn ON/OFF Button text changes.

Text Size
12
Click link icon

Text becomes smaller on Desktop view.
Text size remains the default on Handheld view.

Font Verdana Text font changes.

Text Styling B Text is boldfaced.

Colors

On indicator: Green LED embedded in the button changes color.

Off indicator: [As is (black)] No change.

Text: Deep Green Text color changes slightly.

Button: White Button color changes.

Property You choose... Result
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Save the Project

From the File menu, choose Save All Changes and Switch to groov View. 

View the Project on your Computer

Your saved project opens in groov View. 

Try it out! Click the button and see what happens.

Explore

1. Go back to Build mode by clicking Menu in the upper-right corner of the window and choosing Switch 
to Build mode. 

2. Click the Handheld tab (just above your page in the center of the workspace).
While you were building your page in the Desktop & Tablet tab, groov View automatically put the same 
gadgets in the Handheld tab, which shows the page layout for a smartphone. However, you may want 
the page to look different on a phone. Maybe some data or controls are more important and should be at 
the top of the page, or maybe some don’t need to be on the phone at all. In this tab, you can resize, 
rearrange, change, or delete gadgets to suit your needs.

3. Click to highlight each gadget and change its size and position the way you want.
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Remember when you made the text size smaller (12 instead of 16) for both the LED and the button? You 
also broke the link between the two views for that property, which means you changed it for one view 
only. So, the text is smaller for Desktop & Tablet, but it remains at the default of 16 for Handheld.
You can make the two views different in other ways as well. For example, suppose you want smartphone 
users to be able to see the status of Line 21 but not be able to turn it on or off. You can stash the Turn 
ON/OFF button so it’s not visible in the Handheld view.

4. In the Handheld tab, notice the area off to the right of the page with a dotted line around it. Drag the 
Turn ON/OFF button into this area, which is called the page stash.

The button still shows on a computer or tablet but is not visible on a smartphone. You can also stash 
gadgets in the Desktop & Tablet tab if you don’t want them to appear on these devices, so you can 
customize the view on large and small devices. 

Let’s explore some more. 

Images

When we added the Turn ON/OFF button, one of the properties was Display Mode. Let’s take another look at 
that now.
1. In the Desktop & Tablet tab, select the Turn ON/OFF button and look in the Properties panel.
2. For Display Mode, choose Image. 

Notice that instead of a simple button, you could skin the button with images: one image indicates that 
the button is On and the other that it is Off. 

Page stash
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3. Click a broken image to open the Image Library, where you can add images to your project. 
All the images for your groov project are stored in the Library. You can add and delete images. You can 
use the same image in multiple places, and it is automatically updated every place it is used if you 
change it. Compatible file types for images are BMP, GIF, PNG, JPG, and SVG. For more on the Image 
Library, see page 88. 
Here’s what the Image Library looks like before you add any images:

4. For now, click Cancel to exit the Image Library. In the Properties panel, change Display Mode back to 
Button.

Round Gauge

Let’s look at a gauge.
1. In the Gadget Palette, expand the tag tree again. Under Basic > Variables, choose float32 Variable A. 
2. In the gadget list, click Round Gauge and drag it to your page. 
3. Highlight the new gadget and look at its properties. To understand all the options, see “Round Gauge 

Gadget” on page 126. But for now, change only the following: 

Property You choose... Result

Range Min value 0, Max value 100 The gauge changes to show 0-100.

Units Gallons
“Gallons” appears below the numeric value on the 
gauge.

Click to open the Image Library and 
choose or add the On Image.

Change how your images are 
shown in the library.

After you add them, your 
images appear here.
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4. Scroll down to Color Ranges and click Add Range.

5. Click the blue rectangle and choose Red.
6. Enter 0 for Min Value and 20 for Max Value.
7. Click Add Range to configure another range: choose Orange, enter 20 for Min Value, and enter 40 for 

Max Value.
8. Click Add Range to configure another range: choose Dark Green, enter 40 for Min Value, and enter 

100 for Max Value.
Your gauge now looks like this:

What’s Next?

Now that you have an idea of what groov View can do, you can get to work on your real project.

To connect to your systems and equipment, see these sections:
• “Add a Modbus/TCP Device” on page 35
• “Add an Opto 22 Controller” on page 29
• “Add an OPC UA Server” on page 45

To add more pages, see “Working with Pages” on page 21.

Precision 0
Value will be shown in whole numbers (no digits 
after the decimal point).

Colors
Needle: Black
Background: Dark Orange

Colors change on the gauge.

Property You choose... Result

Click to choose the color for this range.

This gauge is easy for an operator to understand at a glance. Anything 
in the green range is OK, but if the needle dips down into the red, you 
have a problem. 

The numeric value appears in blue at the bottom of the gauge. 
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To learn more about gadgets, see “Editing Gadgets” on page 74. For help with choosing gadget 
properties, see Chapter 4: Gadget Reference on page 107.

To set up users and passwords and control who accesses your groov interface, see “Managing User Access” 
on page 81.

To notify authorized people when events occur, see Chapter 5: Using Events and Notifications on page 135.

WORKING WITH PAGES

Your operator interface can consist of one or many pages depending on your application’s needs. You may 
have separate pages for different functions, different people, or different locations. You use the Page Navigator 
gadget to provide a link so users can go from one page to another. 

Add Pages

1. In Build mode, click Add Page in the Pages panel on the left side.

2. Type a name for the page.
3. If you wish, choose any of the following options:

– Click the Background Color square to choose a color for your page. 

– If you have added page categories (see page 94), select a category for this page. 
– Limit access rights based on user security level (see “Create a User” on page 82). Or, if you want only 

specific users to see this page, choose Limited Access. If the page is Limited Access and you have 
already added user groups (see page 81), select the groups that should see this page. 

4. Click OK.
Your new page appears in the middle of the workspace. 

Change Page Properties

You can change an existing page’s name, permissions, or other properties.
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NOTE: When you import a page, any permissions limitations it may have had are not imported. If you want the page 
to be limited, you must change its permissions after importing.

1. In the Pages panel on the left side of the workspace, click the page 
you want to change. 
In the Page Properties panel just below, you see the current page 
properties. (Both panels are shown at right).

2. Change Name or background Color as needed.
3. To hide the page so no users can see it, check Hidden (useful when 

you are building a new page).
4. To change user permissions for the page, click Edit Page 

Permissions. 

You can limit access rights based on user security level (see “Create a User” on page 82). Or, if you want 
only specific users to see this page, choose Limited Access. If the page is Limited Access and you have 
already added user groups (see page 81), select the groups that should see this page.

5. Click OK.

Page Size, Grid, and Layout Tools

groov View gives you tools to help place your gadgets where you want them while building your HMI. These 
tools include a grid, rulers, and guides that you can make visible in Build mode if you wish.

How the Grid Works

When you place or move gadgets on the page in Build mode, they automatically snap to a grid so they are 
aligned. When users view your HMI, this grid is scaled to meet the size of the browser window's viewport, so 
that gadgets appear in an appropriate size for the device. 

The width of the grid depends on the device it’s viewed on. For Desktop and Tablet devices, the grid is 96 units 
wide; for Handheld devices, the grid is 32 units wide. To determine a gadget's position in the browser 
viewport at runtime, groov View calculates a pixel size for a grid unit based on the width of the viewport. The 
grid unit size is calculated by dividing the viewport's size in pixels by the width of the active layout in grid units 
(96 or 32) and rounding down to the nearest integer. 

As you resize your browser window, groov View adjusts the grid unit size and re-renders gadgets at new sizes 
as necessary. Because the gadget position calculation rounds down, you may see a small space at the side or 
bottom of the window. 
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Making Pages Larger

Since the width of your page is fixed at 96 or 32 grid units, pages cannot scroll horizontally. However, you can 
make pages as long as you want. 

When you need more room on a page, click the Increase Height button at the bottom of the work area. If 
you switch to another page and then return, the page shrinks to fit the content or returns to the default page 
size, whichever is larger.

Displaying the Grid

Seeing the grid can help you line up gadgets as you place them on the page. To show the grid, check Show 
grid at the bottom of the work area, or click View > Show Grid from the top menu bar.

Displaying Rulers

Rulers along the top and left sides of your page can also help you lay out your gadgets consistently. To see the 
rulers, click View > Show Rulers from the top menu bar.

When rulers are visible, darker lines on the ruler show your mouse's current position. Also, a coordinate 
indicator in the lower-right corner of the workspace tells you where your mouse is in grid units.

Viewable area with 
grid turned on

Click to make page longer.
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Using Layout Guides

Layout guides help you position your gadgets consistently. The guides can remain in place in Build mode but 
are not visible in View mode. Each layout (Desktop or Handheld) for each page has its own set of guides. 
Guides can help you easily set up a template because when you duplicate a page, its guides are duplicated 
with it.
1. If rulers are not visible, click View > Show Rulers from the top menu bar so you can see grid units.
2. To add a layout guide, click View > New Guide from the top menu bar.
3. In the dialog box, choose a horizontal or vertical guide. Look at the left or top ruler and determine where 

you want the guide to appear. Enter the grid unit number for the guide’s initial position on the page. 
The guide appears as a line on the page behind any gadgets.

• To move the guide, click and drag it.

Rulers visible at 
top and left

Cursor position 
indicated by darker 
lines on rulers

Cursor position 
indicator in grid units

Layout guide (in this 
example horizontal at 
left grid unit number 6) 
appears behind any 
gadgets on the page.
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• To delete the guide, right-click it and click Delete.
• To delete all guides, choose View > Clear Guides.

Fitting Designs on a Page (Page Size Overlay)

Because devices, operating systems, and browsers vary widely, it can be difficult to know for sure that all your 
gadgets will fit the way you want on your users’ screens. If you know the device your users will use, however, a 
debugging page size overlay can help.
1. In Build mode, choose File > Save all changes.
2. In the device your users will use (tablet, phone, smart TV, or PC), open groov View (see “Opening View” on 

page 151). Make sure the device’s browser is at the size your project will be viewed (for example, full 
screen or maximized).

3. Leave that page open on your target device and open Build mode on your desktop.
4. Choose Configure > Project Settings.
5. Scroll down to the View Mode box and check Show page size overlay. 
6. Scroll to the top and click Save Settings.
7. Close the Project Settings window.
8. Back in your target device, watch until you see an overlay in the upper right corner that displays the 

current visible page size in grid units (see the following image).

In this example, the visible portion of the page is 96 units wide (the standard width for a desktop layout) 
and 60 grid units high. 

9. Back in Build mode on your desktop workstation, add a horizontal layout guide at position 60 to indicate 
the bottom of the visible page.

Page size overlay
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Use the Page Stash

The workspace for each page has a page stash where you can put gadgets that are not yet part of the project. 
For example, if you don’t want a gadget to appear in the Handheld layout, you can move it to the page stash; 
the gadget still appears in the Desktop & Tablet layout. 

To see the page stash in the Desktop & Tablet view, select Zoom out to show page stash at the bottom of 
the work area. In the Handheld view, the page stash is always visible to the right.

Delete a Page

1. In the Pages panel on the left, hover over the page or category name, and click the red X that appears.

2. To verify, click OK.

Page stash

Click the red X.
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Rename a Page

1. In the Pages panel, right-click the page name and select Rename.

2. Enter a new label, and press Enter or left-click in the work area.

Duplicate a Page

1. In the Pages panel, right-click the name and select Duplicate.

A copy appears in the same page category.

2. Right-click the copy and select Rename to give the page a new name.
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3. If you want, you can drag it to a new position in the list or to a different page category.

Export and Import Pages

You can move pages from one groov project to another by exporting and importing them. When you export, 
only the page layout with gadgets is exported. Associated tags, images, and page navigators are not exported. 
In addition, if you limited viewing permissions to specific user groups, those limitations are not exported. 

The export file is downloaded to your PC with a date and time stamp as its filename. 

Exporting a Page

1. In Build mode, choose File > Export Page. 
The file is immediately downloaded with a filename that looks something like this: 
Groov_Page_D04242017.T211956.json

2. Save the file with a filename you recognize in the location you want. Make sure you retain the .json file 
extension.

Importing a Page 

1. Open the groov project you want to import the page to.
2. Choose File > Import Page.

a. Click Browse and find the file you exported. 
b. In the Page Name field, enter the name for the page in this project. 
c. (Optional) Choose a category for the new page.

3. Click Import.
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A new page is created in the project containing the gadgets and layout from the imported page.
4. Complete the new page by:

– Adding tags for each gadget
– Replacing any images
– Adding page navigators appropriate for this project
– Editing page permissions

5. Save the page.

WORKING WITH A DEVICE

When you first open groov View, only tags for the Data Simulator are available for use. Any other device, 
system, or software you want to monitor, control, or exchange data with using your groov View operator 
interface—including the groov EPIC, Server, or Box itself—must be added to groov View as a device. When you 
add the device, you also add its tags so that you can connect the tags to the groov View gadgets to make 
them operational. 

With any groov View project, you can add as many groov EPIC processors and I/O units, groov RIO I/O units, 
SNAP PAC controllers and I/O units, Modbus devices, and Data Stores as you like. You can also add an OPC UA 
Server—either the internal Ignition Edge® OPC UA server in groov EPIC or groov Box, or an external OPC UA 
server with any groov product. In addition, any events you create (see Chapter 5: Using Events and 
Notifications) automatically appear as tags in a device named Events. 

NOTE: Devices cannot talk with each other directly. For example, a Modbus/TCP device cannot write data to a Data 
Store; an Opto 22 controller cannot read groov System data. However, you can use Node-RED in groov EPIC, 
groov RIO, or groov Box to create a logical flow that exchanges data between devices that have Node-RED nodes. For 
more on Node-RED, see nodered.org, developer.opto22.com, and these user’s guides:

• groov EPIC User’s Guide (form 2267)

• groov RIO User’s Guide (form 2324)

• groov Box User’s Guide for GROOV-AR1 (form 2104)

This section includes:
• “Add an Opto 22 Controller,” page 29
• “Add an Opto 22 I/O Unit” on page 31
• “Add a Modbus/TCP Device,” page 35
• “Add an OPC UA Server,” page 45
• “Add a Data Store” on page 67
• “Add System Tags,” page 54
• “Add a Computed Tag,” page 57
• “Edit Device Information,” page 68
• “Disable Communication to a Device,” page 69
• “Delete a Device,” page 70
• “View Device Health,” page 71

Add an Opto 22 Controller

Follow these steps to add an Opto 22 controller—either a groov EPIC processor or a SNAP PAC controller—
that the operator interface will communicate with. When you add a controller and the .idb.txt file 
associated with the strategy that runs on the controller, the strategy’s tags become available in groov View for 
you to use. Repeat the steps to add additional Opto 22 controllers.

https://nodered.org/
http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4441
http://developer.opto22.com/
https://www.opto22.com/support/resources-tools/documents/2267-groov-epic-user-s-guide
https://www.opto22.com/support/resources-tools/documents/2324-groov-rio-users-guide
https://www.opto22.com/support/resources-tools/documents/2104-groov-box-users-guide
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1. In the Tags tab under Gadget Palette on the right side, click Configure Devices & Tags (or choose 
Configure > Devices and Tags from the top menu bar).

2. Click Add New Device and select Opto 22 Controller.

3. Enter the following details:

a. Controller Address: Enter the hostname or IP address of the controller running the strategy you 
want to use. For a SoftPAC controller, use the full name of the computer running SoftPAC as in this 
example: 
JAlvarez-w10.ACME.com

b. Controller Port, Connection Timeout, Scan Interval, and String Encoding: Change if 
necessary for your application.
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c. Strategy File: Click Select file to locate the .idb.txt file you want to use, select the file, and 
click Open.

NOTE: When PAC Control compiles a strategy, it automatically generates an .idb.txt file and places it 
in the same directory as the strategy. If you are setting up groov on a computer other than the one used to 
develop the PAC Control strategy, copy the .idb.txt file into a directory that is accessible to the 
computer you are using to set up groov.

4. After you complete your changes, click Create Device. 
Build imports the .idb.txt file. In the Gadget Palette, you see the name of your strategy and the IP 
address of your Opto 22 controller.

5. Click the plus signs (+) to expand the tree and see all the tags.

Updating a Strategy

If a controller’s strategy has been changed, you need to update it in groov View by importing its new 
.idb.txt file.
1. Select Configure > Devices and Tags.
2. Highlight the controller you want to update, and click Update Strategy.

CAUTION: Be very sure you are updating the correct strategy. If you use the wrong one, all of the controller tag 
connections can break. This is critical because re-importing the correct strategy does not fix the broken gadgets. 
You can only fix the connections by restoring your project with a recent backup.

3. Browse to the strategy you want to use, select the new .idb.txt file, and then click Open.

NOTE: The .idb.txt file is in the same directory as the strategy. If groov is on a different computer than the 
strategy, copy the .idb.txt file into a directory accessible to the computer you are using for groov.

4. Click Close to close the Configure Devices and Tags window.

Add an Opto 22 I/O Unit

Your groov View operator interface can read tags from the OptoMMP memory map in the following I/O units:
• A groov EPIC I/O unit or a groov RIO unit. Before adding it to your groov View project, configure the points 

in PAC Control or groov Manage.
• An Opto 22 SNAP PAC I/O unit. Before adding it to your groov View project, configure the I/O modules 

and points in PAC Control or PAC Manager.
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When you add an I/O unit, the unit’s memory map tags become available in groov View. Some memory map 
address tags are automatically imported (called Auto tags), and you can manually configure others. The 
following instructions add the Auto tags.
1. In the Tags tab under Gadget Palette on the right side, click Configure Devices & Tags (or choose 

Configure > Devices and Tags from the top menu bar).

2. Click Add New Device and select Opto 22 I/O Unit.

3. Enter the following details:

a. Name: Enter a name for the I/O unit.
b. Address: Enter the IP address or hostname of the I/O unit.
c. OptoMMP Port: Leave at the default of 2001 (unless you have changed it on the I/O unit).
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d. Connection Timeout, Scan Interval, or String Encoding: Change if necessary for your 
application.

4. Click Add Device.
5. In the Gadget Palette, notice the name of your I/O unit. Click the plus signs (+) to expand the tree and see 

all the tags that were automatically imported. The following images show two examples.

NOTE: For SNAP PAC I/O units, empty module slots on the I/O unit may appear as digital modules in the tree. 

If the tag you need is not there, you can add individual OptoMMP memory map address tags. See 
“Adding OptoMMP Memory Map Addresses Manually” on page 34.

Updating Auto Tags 

If you add an I/O module to an I/O unit, to add the Auto tags for the new module:
• For groov EPIC I/O units, collapse (-) and then expand (+) the tree to see the new tags.
• For SNAP PAC I/O units, if you configured the points on the new module prior to adding it in groov View 

(for example, through PAC Manager), then you can collapse (-) and then expand (+) the tree to see the 
new tags.

If you remove an I/O module from the I/O unit, remove the missing tags from their associated gadgets, and 
then update or remove those gadgets:
1. In the Gadget Palette, click Configure Devices & Tags.
2. Highlight the name of the I/O unit in the list of devices.

Line 1 LC-R1 is a 
SNAP PAC I/O unit with several 
I/O modules on the rack. The 
image on the left shows the tree 
for the first module (Module 0) 
expanded and four configured 
points.

Line 2 (RIO) is a 
groov RIO unit. The image on 
the right shows its tree 
expanded and the first four 
configured channels.
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3. Click Update Auto Tags. A report lists any deleted tags.
4. Click Update Auto Tags to confirm that you want to disconnect the deleted tags from their associated 

gadgets.
5. Click Close on the Configure Devices and Tags window.
6. Update or remove the associated gadgets.

Adding OptoMMP Memory Map Addresses Manually

To do this, you need to know the memory map address and data type for the tag you want. You can find 
these in the OptoMMP Protocol Guide (form 1465) or:
• For groov EPIC I/O units or groov RIO units, you can find memory map addresses through groov Manage. 

Navigate to the I/O > I/O Services > MMP Calculator page.
• For SNAP PAC I/O units, you can find memory map addresses by connecting to the I/O unit through 

PAC Manager and then click Tools > Inspect.

Be aware that your groov View interface cannot show hexadecimal values. Hex values are shown as their 
decimal equivalents in your interface.
1. In the Gadget Palette, click Configure Devices & Tags.
2. Highlight the name of the I/O unit in the list of devices and click Configure Tags.

3. Click the plus sign (+) in the upper left of the Configure Opto 22 I/O Unit Tags window.

4. Enter a name for the tag in the Tag Name field.
5. Choose the correct data type from the Data Type drop-down list.

https://documents.opto22.com/1465_OptoMMP_Protocol_Guide.pdf
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6. In the Destination Offset (hex) field, enter the complete memory map address with no spaces. 
For example, for Unit Type, you would enter FFFFF0300020. 

7. Click Save, or click Save & Add Another to configure more tags manually.
In the Gadget Palette, the tag appears under the I/O unit’s name in the User Configured folder.

You can use manually added tags just like any other tag in your groov View interface. In this example, you 
see that the hex value returned from the Unit Type memory map address is shown in the interface as its 
decimal equivalent:

Add a Modbus/TCP Device

Modbus is an open protocol widely used in automation and other industries. Although it was originally 
designed for a serial network, Modbus has since been adapted to work over Ethernet as well. Over Ethernet, 
the protocol is called Modbus/TCP. groov has a communication driver that allows groov to act as a 
Modbus/TCP master and communicate with Modbus/TCP slave devices that have an Ethernet connection. 
Note that groov does not support communication with serial devices via a Modbus serial-to-TCP gateway due 
to high latency in serial networks.

Follow these steps to add tags for a Modbus/TCP slave device for use in the operator interface.
1. In the Tags tab under Gadget Palette on the right side, click Configure Devices & Tags (or choose 

Configure > Devices and Tags from the top menu bar).

Manually added tags appear 
under the I/O unit in the
User Configured folder.

Decimal equivalent of hex 
value from the memory map
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2. Click Add New Device and select Modbus Device.

3. Enter the following details:

a. Name: Enter a name to identify this Modbus device.
b. Address: Enter the Modbus device’s IP address or hostname. A hostname is converted to an 

IP address by the DNS server.
Your device may have a static IP address, which you can find in the device’s documentation. The 
device may also come with software that allows you to set its IP address or view the address 
assigned to it by a DHCP server.

c. Port: The standard Modbus port is 502. Some Modbus devices may use a different port. Refer to 
your device’s documentation to determine which port number it uses.
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d. Unit ID: Typically used to address individual devices or memory segments located at a single IP 
address.
Check your device’s documentation to determine whether the slave ID is required for any reason. If it 
is not, leave this box at the default of 0.

e. Connector Timeout, Scan Interval, and String Encoding: Change these only if your application 
requires it.

f. 32-bit and 64-bit Value Order: The Modbus protocol does not specify memory mapping. As a 
result, devices that store multi-register data types store the data differently. Use these settings to set 
the byte order of the data coming from your Modbus device for data types that span more than one 
16-bit register/address. See your device’s documentation to determine whether either of these 
settings needs to be changed. The device’s manual may use terms like high or low order or registers, 
or MSB (Most Significant Bit) or LSB (Least Significant Bit).

NOTE: Setting either of these settings incorrectly may result in garbage values for the affected data types. 
If you receive data that makes no sense, try changing these settings.

– 32-bit: First register is least significant: For 32-bit data types that span two 16-bit registers, this 
indicates that the first (lower) register read contains the least significant byte (LSB). 

– 64-bit: First 32-bit value is least significant part of 64-bit values: For 64-bit data types that span four 
16-bit registers, this indicates that the LSB is contained within one of the first two registers read. 

Example: Assume register values are:
– register 1 = A
– register 2 = B
– register 3 = C
– register 4 = D

Here’s how data appears based on your settings:

4. Check the following settings:

NOTE: Be sure to check the documentation that came with your Modbus device for additional information 
about these settings. For more information about Modbus function codes, see 
www.modbus.org/docs/Modbus_Application_Protocol_V1_1b.pdf. 

– Use base-one addressing
If your device documentation specifies zero-based addressing or you simply prefer zero-based 
addressing, you can uncheck this option to make tag addressing easier.

– Use function code 06 when writing a single register
If your device does not support Modbus function code 06 (0x06, Write Single Register), uncheck this 
option. If it is not checked, groov uses function code 16 (0x10 Write Multiple Registers) for 
single-register writes.
If this option is checked and your device does not support function code 06, you may receive errors. 
The error occurs with writes to any tag having a data type sized 16 bits or smaller.

Settings Results

32-bit 64-bit
32-bit value 

from registers 
1 & 2

64-bit value 
from registers 

1-4

Second register Second 32-bit value AB ABCD

First register Second 32-bit value BA BADC

Second register First 32-bit value AB CDAB

First register First 32-bit value BA DCBA

http://www.modbus.org/docs/Modbus_Application_Protocol_V1_1b.pdf
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– Use function code 05 when writing a single coil
If your device does not support Modbus function code 05 (0x05, Write Single Coil), uncheck this 
option. If it is not checked, groov uses function code 15 (0x0F, Write Multiple Coils) for single coil 
writes.
If this option is checked and your device does not support function code 05, you may receive errors. 

– Use function code 22 when writing a single register bit
If your device supports Modbus function code 22 (0x16, Mask Write Register), you can check this 
option to optimize writes. (Using function code 22 makes writes faster and ensures that the write 
operation is atomic.) 
If this option is not checked, groov uses other functions to first read the whole register, modify the 
bit, and then write to the whole register. 

NOTE: Keep this option unchecked for an Opto 22 SNAP PAC controller or brain.

5. When finished, click Add Device.
The Modbus device appears in the list of configured devices.

Next, add tags either manually (see page 38 below) or by importing them from a file (page 44).

Adding Modbus Tags Manually through groov View

Use the following steps to manually add Modbus tags in Build mode. You can also add Modbus tags by 
importing them from a file. See “Importing Modbus Tags from a CSV File” on page 44.
1. In the Tags tab under Gadget Palette on the right side, click Configure Devices & Tags (or choose 

Configure > Devices and Tags from the top menu bar).
2. Highlight the Modbus device and click Configure Tags.

3. Click the Add button .
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4. Enter the following details:

a. Tag Name: (Required) Give the tag a descriptive name.
b. Data Type: (Required) Select the tag’s data type. If your Modbus/TCP device’s registers contain 

multiple status or command bits or bit fields in a single register, choose Boolean to access 
individual bits.

c. Tag Address: (Required) The Tag Address Builder helps you construct valid tag addresses. After you 
see what a valid tag address looks like, you can enter the addresses manually in the text box to save 
time. Available options depend on the data type.
– Address Type: Identifies which memory segment is accessed. Discrete Inputs and Coils are 

single-bit registers that represent Boolean values only. Input and Holding Registers are 16-bit 
registers that can be used for any data type.
Data types larger than 16 bits are mapped onto consecutive registers, starting at the register 
located at Start Address. Coils and Holding Registers are default Read/Write while Discrete 
Input and Input Registers are Read Only.
To access individual bits in a register, choose Input Registers (Read Only) or Holding 
Registers (Read/Write).

– Start Address: Specifies where the tag value starts in memory. Strings may span multiple 
registers. Data types larger than 16 bits always span multiple registers.
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To configure 0- or 1-based addressing, click Edit Device on the previous dialog box (Configure 
Devices and Tags) and then click the Access Config tab.

– String Length: Determines how many registers are accessed to read or write the full string.
Strings are composed of ASCII characters (1 byte), so a single register may hold up to 
2 characters.

– Byte Order: Specifies how the characters are ordered within each register. H–>L indicates that 
the first character, when read left to right, starts at the most significant bit (MSB) and the last 
character ends at the least significant bit (LSB). If you are unsure about order, you can play with 
this setting to determine which one works.

– Bit Index: Identifies the bit within a register to be accessed. Valid bit values are 0–15.
– Array Size: To access multiple (contiguous) values of this data type using the same tag, set 

this size to 2 or more (up to a maximum of 65535 depending on the data type).
For example, if you want to access 10 contiguous floats that start with the specified Tag 
Address, set Array Size to 10.
String arrays are not supported.

d. Access: (Optional) The options available depend on the data type. If you omit this value, the tag 
assumes the register type default setting.

e. Scaler: (Optional) Use the Scaler if a read/incoming value spans a much larger data range than you 
require or to convert from one unit of measure to another. If you use this option, you must provide 
all components.

A Scaler

– None: The raw input value is not modified in any way.
– Linear Scaler: The raw input value is mapped linearly from the specified input range to the 

specified output range and data type. To flip the sign of the result (negative to positive or 
positive to negative), select Negate the result (D).

Here is the function used to scale the input:
Output = (((Scaled High - Scaled Low) / (Raw High - Raw Low)) * (Raw 
Value - Raw Low)) + Scaled Low

– Square Root Scaler: The raw input value is mapped from the specified input range to the 
specified output range and data type using the following function:

Output = (√ ((Raw Value - Raw Low) / (Raw High - Raw Low)) * (Scaled 
High - Scaled Low)) + Scaled Low

B Raw Input Limits

– High/Low: The High and Low Raw Input Limits must be within the range of values that the 
tag data type can store.

A

B C

D
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C Scaled Result

– Data Type: Select an available data type. Not all Modbus data types are valid output types for 
scaled values, so some data types are not listed.

– Limit High and Limit Low: These values must be within the range of values that the scaled 
output data type can store.

D Negate the result: Select this option to flip the sign of the result (negative to positive or positive to 
negative).

5. Click Save, or click Save & Add Another to configure more Modbus tags manually.

Creating a Valid Modbus Tags Import File (CSV)

You can create a valid comma-separated values (CSV) file (.csv extension) that contains Modbus tags for 
importing. See also “Exporting a Modbus Tags Import File (CSV)” on page 43. 

A valid Modbus CSV file contains one tag per line and has this form: 
Tag Name, Data type, Tag address [, [Read/Write setting] [, Value scaler 
name, Scaled output data type, Input limit low, Input limit high, Output 
limit low, Output limit high, Negate]]

When viewed in a text editor, a CSV file containing Modbus tags might look like this:

Here is the same file viewed in Microsoft Excel:

Tag Name: (Required) Give the tag a descriptive name.

Data Type: (Required) 

Tag Address: (Required) Use a basic 6-digit address (exception: if you access individual bits within a register, 
the address includes 6 digits plus a point and the bit number, for example: 302000.12). 
The first digit defines the register type:

0 = Coil

1 = Discrete Input

Tag Name Data Type Tag Address Access

Scaler

Tag Name Data Type Tag Address Access

Scaler
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3 = Input Register

4 = Holding Register

The next five digits are the start address:
• For devices with a base 0 addressing, the start address range is 0–65535.
• For devices with a base 1 addressing, the start address range is 1–65536.

NOTE: The start address is decimal by default but may be expressed in hexadecimal format. For hex:
- Place an “H“ or “h“ character in front of the entire address (for example, H30009F). 
- Follow the H with the address type byte plus a 0 (zero).
- Then show the hex address using 4 hex bytes. The most significant digit will always be 0.
Examples: 000001, 400203, H10FFFF

Registers 0 (Coils) and 1 (Discrete Input) are single bit registers and may be used for Boolean data types only. All 
other data types must use one of the 16-bit register types (3 or 4).

There are limits on the tag start address. The following formula is used to determine if the tag address is within 
bounds of the registers:

OK if: 65536 <= Start Address + (ArraySize * Data Type Byte Size) / 2

For the String data type: Use the basic address followed by a “ . “ and then a decimal number in the range 
2–240 to designate the number of characters in the string. Use either an “L“ or “H“ to designate character 
ordering within the registers. Only ASCII characters are supported (1 byte each); therefore, each 16-bit register 
can contain up to 2 characters. “L“ indicates a Low-to-High byte ordering (the first character contains the LSB) 
and “H“ indicates the opposite.

Examples: 300001.20H, H4000F9.120L

For all other data types: Data types other than strings may be represented as arrays using a basic address 
followed by a space, an opening bracket “[“, a positive integer value in the range 2–65536, and a closing 
bracket “]“. 

Examples: 100003 [50], 300045 [20])

The array starts at the start address and extends through the designated number of elements. The start 
address + array size may not exceed 65536 registers. The size of the data type must also be factored in 
because many data types span multiple registers.

Access: (Optional) This setting must match one of the options available for this data type in Build mode (for 
example, Read/Write, Read Only). It is not case sensitive. If this value is omitted, the tag assumes the register 
type default setting. If a value scaler is set, the Read/Write setting must be provided or have an empty place 
reserved for it with commas (Tag address, ,Value scaler).

Scaler: (Optional) If this option is used, all components must be provided.

B C

...Linear,16-bit Signed Integer,-3.4028235E38,3.4028235E38,-32768,32767,false

A D E

Scaler
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A Scaler Name: The scaler name must be None, Linear, or Square Root. The name is not case sensitive. 
The Scaler allows you to modify and control raw data values. There are many reasons why a scaled 
value may be useful or necessary. For example, if a raw value spans a much larger data range than 
you require or if you need to digitize an analog value that comes in as a floating point number. Below 
are the available scaling functions.
None: The raw input value is not modified in any way.
Linear: The raw input value is mapped linearly from the specified input range to the specified output 
range and data type. Selecting “Negate the result” causes the sign of the result to be flipped 
(negative to positive or positive to negative). Below is the function used to scale the input:
Output = (((Scaled High - Scaled Low) / (Raw High - Raw Low)) * (Raw 
Value - Raw Low)) + Scaled Low

Square Root: The raw input value is mapped from the specified input range to the specified output 
range and data type using the function below:
Output = (√ ((Raw Value - Raw Low) / (Raw High - Raw Low)) * (Scaled 
High - Scaled Low)) + Scaled Low

B Data Type: The scaled result data type must match one of those offered in the UI. Not all Modbus 
data types are valid output types for scaled values so check Build mode to see the current list of types.

C Raw Input Limits: The Low and High Raw Input Limits must be within the range of values that the 
tag data type can store.

D Limit Low and Limit High: Must be within the range of values that the scaled output data type can 
store.

E Negate the result: True or False. Causes the sign of the result to be flipped (negative to positive or 
positive to negative).

Exporting a Modbus Tags Import File (CSV)

If you already have tags attached to the device, you can export a CSV file containing all of the device tags. 
Exporting some pre-configured tags is the fastest way to see what a valid tag CSV file looks like. 
1. In the Tags tab under Gadget Palette on the right side, click Configure Devices & Tags (or choose 

Configure > Devices and Tags from the top menu bar).

2. Highlight the Modbus device and click Configure Tags.



WORKING WITH A DEVICE

groov View User’s Guide44

3. Click Export to send the CSV file to the default downloads directory. Or, right-click Export and select 
Save link as to choose the target directory.

4. Click Save.

A CSV file with the Modbus device tags is created and downloaded to the default or designated directory.

Importing Modbus Tags from a CSV File

If you have a properly formatted CSV file containing Modbus tags you want to use, you can import the tags 
directly into groov. See also “Creating a Valid Modbus Tags Import File (CSV)” on page 41.
1. In the Tags tab under Gadget Palette on the right side, click Configure Devices & Tags (or choose 

Configure > Devices and Tags from the top menu bar).

2. Highlight the Modbus device and click Configure Tags.

3. Click Import.
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4. Browse to a valid CSV file and click Open.
A Tag Import Report appears.

5. Click Close. The tags appear in groov.

Add an OPC UA Server

Equipment that is neither a Modbus/TCP device nor manufactured by Opto 22 can still be monitored and 
controlled in groov View if it is an OPC UA-compatible hardware device or if you have an OPC UA server. 

You can add both internal and external OPC UA servers, and you can use multiple servers in the same 
groov View project:
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• Internal server: If you have a groov EPIC or a groov Box, you can use the internal Ignition Edge OPC UA 
server and drivers for Allen-Bradley®, Siemens® S7, and other systems. See the groov EPIC User’s Guide 
(form 2267) or the groov Box User’s Guide (form 2104) for more information.

• External server: You can also use external OPC UA servers. For cybersecurity, use servers that comply 
with one of the security profiles defined in the OPC-UA specification (section 6.6). 

To add an OPC UA-compliant server or equipment to groov View:
1. In the Tags tab under Gadget Palette on the right side, click Configure Devices & Tags (or choose 

Configure > Devices and Tags from the top menu bar).

2. Click Add New Device and select OPC UA Server. The Add OPC UA Server window appears.

3. Enter the name of the OPC UA server in the Name field.
4. In the Server URL field: 

a. If you’re adding the internal Ignition Edge server in groov EPIC or the groov Box, enter:
– For Ignition Edge version 7: 127.0.0.1:4096 
– For Ignition Edge version 8: 127.0.0.1:6254

b. For any external server, use the following format to enter the IP address or hostname of the 
computer where the OPC UA server is installed and the port. You can also enter the path of the OPC 
server endpoint.

https://documents.opto22.com/2267_groov_EPIC_Users_Guide.pdf
https://documents.opto22.com/2104_groov_Box_Users_Guide_for_GROOV-AR1.pdf
https://reference.opcfoundation.org/Core/Part7/v104/docs/6.6
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Check your server for the correct values.
Example server URLs
10.20.30.40:49320
10.20.30.40:49320/Path
MyServer:49320
MyServer:49320/Custom/Path
MyServer.MyDomain.com:49320
MyServer.MyDomain.com:49320/Path
Default ports 
Different OPC UA servers use different ports. Here are the default ports for some servers:
CODESYS Controller: 4840
groov EPIC Data Service: 14840
KEPServerEX: 49320
TOP Server: 49380
Ignition OPC UA: 4096 (Ignition 7) or 62541 (Ignition 8)
MatrikonOPC UA Wrapper: 21381
MatrikonOPC Universal Connectivity Server: 4846

5. If you’re adding the internal server, skip to step 12. For an external server, continue.
The defaults for the Authentication and Message Security fields (Anonymous and None 
respectively) provide no security for an external OPC UA server. Follow step 6 through step 11 to change 
these fields to meet the server’s profile requirements for secure connections. 

6. If you don’t know your server’s User Token Policy (authentication) options but can connect to it, click 
Test Connection. 

7. Next to the Authentication field, click Edit. 

If your connection was successful, the user token policies your server supports are available to choose. If 
one is not available (for example, if the server doesn’t allow anonymous connections), it is grayed out.

8. Select Username and Password, enter them in the fields, and click OK.
9. Again, if you don’t know your server’s Message Security options but can connect to it, click Test 

Connection. 
a. If a message says that the server does not trust the client certificate, follow instructions in the server 

documentation to accept groov View's certificate. 

MyComputer.MyCompany.com:49320/path

Computer hostname Port
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b. If the client (groov View) does not trust the server’s certificate, select one of the following options in 
the Certificate Trust dialog box:
– Click Trust to add the Server’s Certificate to the Trusted Server List.
– Click Reject to add the Server’s Certificate to the Rejected Server List. (A rejected certificate can 

be trusted later and vice versa.)
10. Next to the Message Security field, click Edit. 

If your connection was successful, you can select Sign or Sign & Encrypt, and the security policies your 
server supports are available to choose from in the right-hand column. Grayed out options are 
unavailable.

11. Select the Message Security Mode and Security Policy options that your server supports and you 
want to use. Click OK.

12. Change the Connection Timeout or Scan Interval fields only if required for your application.
13. Click Add Server.

Using Static Tags

When you add an OPC UA Server, groov View accesses the controller’s static tags and makes them available so 
that you can directly browse the tags on the server. groov View keeps the server’s tag hierarchy and displays 
the tags in a tree format. As long as you are connected to the server, you can browse to find the tag you need 
in the Gadget Palette or by clicking the dynamic link next to Tag on a gadget’s properties panel. The tags load 
automatically as you expand the tree. For more information about tags and folders for an internal Ignition 
Edge OPC UA server, see the groov EPIC User’s Guide (form 2267) or the groov Box User’s Guide (form 2104).

https://documents.opto22.com/2267_groov_EPIC_Users_Guide.pdf
https://documents.opto22.com/2104_groov_Box_Users_Guide_for_GROOV-AR1.pdf
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Updating Static Tags

If you know that static tags have changed or if a link to a tag is broken, you can update the static tags on an 
OPC UA server. When you update the static tags, groov View displays a report that lists any deleted or modified 
tags so that you can choose different tags as necessary.

To update static tags, select an OPC UA server in the Configure Devices and Tags window and click Update 
Static Tags.

Any deleted or modified tags are listed in the Update Static OPC UA Tags dialog box.

Expand a server’s tag tree to 
load its static tags

Select an 
OPC UA server

Click Update 
Static Tags
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Using Dynamic Tags

NOTE: This section on dynamic tags does not apply to the internal Ignition Edge OPC UA server in groov EPIC or the 
groov Box. See the groov EPIC User’s Guide (form 2267) or the groov Box User’s Guide (form 2104) for how to configure 
individual tags in the Edge server. 

Dynamic tags are tags used with an external OPC UA server that you enter manually one at a time in 
groov View. They are not configured on the OPC UA server. Dynamic tags allow you to add as many or as few 
tags to groov View as you want, making it easier to find the tag you want.

To add dynamic tags:
1. In the Configure Devices and Tags window, select the OPC UA server, and click Configure Dynamic 

Tags.

2. In the Configure Dynamic Tags dialog box, click Add.
3. In the Add Dynamic Tag dialog box, enter a tag name in the Name field and select the Data Type.

Make sure the data type selected in groov View matches the type retrieved from the device.
4. If this tag is an array of objects with the same data type, select Array and enter the array size.
5. For Access, choose the Read or Write attributes as needed.

Leave this dialog box open while you identify the NodeId Value in the next step.

Select the 
server

Click Configure 
Dynamic Tags

https://documents.opto22.com/2104_groov_Box_Users_Guide_for_GROOV-AR1.pdf
https://documents.opto22.com/2267_groov_EPIC_Users_Guide.pdf
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6. To find the NodeId Value for your device, open your OPC UA server configurator and find the configured 
device associated with this tag. 
You’ll find part of the NodeId information here. The remainder comes from the device itself. The 
addressing syntax is different for each type of device, so you’ll need to check the OPC UA server’s 
documentation for this tag’s device type.
As an example, here’s how you find the NodeId for a Rockwell Automation® Logix tag on a 
KEPServerEX™ 5 server:
a. Open the KEPServerEX 5 Runtime configurator.
b. Locate the device and tag from which the dynamic tag in groov will obtain data.

Use this format for the NodeId Value field:
[Channel name].[Device name].[Tag group name].[protocol specific address]
So now you can extract the information you need from the server’s configurator and the device 
itself:
[Channel name]=DTOL
[Device name]=Cmplx5370
[protocol specific address]=Program:MainProgram.i32Counter@Long

NOTE: The protocol-specific address is obtained from the device. If you have a Kepware® server, the help file 
provides the protocol-specific addressing information. To access help for a specific tag, click the device 
name in the Kepware configurator, choose Properties, and click the Help button.

Channel name

Device name
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In this example, the “@Long” portion specifies the data type as an unsigned 32-bit integer. This forces the 
server to report data to this type. If the default data type on the Kepware server is different from the tag’s 
data type, the link fails in groov unless you specify the data type in the NodeId Value field. For more 
information on your specific data type, see the server’s documentation.

Putting it all together, here’s the NodeId Value for this dynamic tag:
DTOL.Cmplx5370.Program:MainProgram.i32Counter@Long

7. Return to the Add Dynamic Tag dialog box in groov Build mode, enter the value in the NodeId Value 
field.

8. In most cases, the Namespace Index field should stay at 2. However, for some servers (such as Ignition 
by Inductive Automation) you should change the Namespace Index to 1.
A tag’s Namespace Index is an integer (0 or higher) that tells groov how to find the tag on the server.

9. Click Add Dynamic Tag.
10. Close the open dialog boxes.

The new dynamic tag appears in the Gadget Palette.

Now you’re ready to add gadgets to a page using the new tags you just created. For instructions, see “Adding 
Gadgets” on page 72.

After you add some gadgets and associated tags to them, select File > Save All Changes and Switch to 
groov View. It might take a few moments for the OPC UA connection to be established and live values to 
appear.

Configuring the Windows Firewall for an OPC UA Server

Use this section only if:
• You are using groov Server for Windows and the OPC UA server is installed on a different computer, OR
• You are using an external OPC UA server with the groov Box.

Do not use this section for the following:
• Native OPC UA server in groov EPIC.
• Internal Ignition Edge server in groov EPIC or groov Box.

If your OPC UA server is not on the same computer as groov View, inbound traffic to the OPC UA server needs 
to be able get through the firewall on the port used by the server. To allow access through the firewall requires 
adding an inbound rule to the Windows Firewall on the computer where the OPC UA server is installed.

As an example, the following instructions describe how to add the inbound rule for port 49320, which is the 
default port for the KEPServerEX 5 server. 
1. After you have successfully installed the server, open the Windows Control Panel.

New dynamic tag
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2. If Control Panel items appear as icons, click Windows Firewall (or Windows Defender Firewall in later 
Windows versions). If they appear as categories, click System and Security and then click Windows 
Firewall (or Windows Defender Firewall).

3. In the left panel, click Advanced settings.

The Windows (Defender) Firewall with Advanced Security dialog box opens.
4. In the left panel, click Inbound Rules.

5. In the right panel, click New Rule.

6. For Rule Type, select Port and click Next.



WORKING WITH A DEVICE

groov View User’s Guide54

7. For Protocol and Ports, keep the default selected for TCP/UDP, select Specific local ports, enter 49320 
(the default Kepware port), and click Next.

8. For Action, select Allow the connection and click Next.

9. For Profile, select Domain and Private, and click Next.

10. In the Name field, enter a descriptive name such as “Kepware OPC-UA Server.”
11. Click Finish.
12. Exit the Windows (Defender) Firewall and Control Panel dialog boxes.

Add System Tags

You can get tags for information about a groov product itself (called System tags) and use them in your mobile 
interface. For example, you might want to show operators the current time and date, or an Admin page might 
include system uptime, number of current user sessions, and so on. To make these tags available, you add a 
new System device.

To add System tags:
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1. In the Tags tab under Gadget Palette on the right side, click Configure Devices & Tags (or choose 
Configure > Devices and Tags from the top menu bar).

2. Click Add New Device and select System.

System now appears in the list of devices.

3. Click Close, and notice that System tags are added in the Gadget Palette.
4. Click the plus signs (+) to expand the tree and see all the tags.

All possible tags are shown in the list, but some may not apply to 
your groov product. For example, groov Admin Version applies only 
to a groov Box, not to a groov EPIC or a groov Server. 

The following table shows information about these tags.

NOTE: It’s possible to choose an LED or Image Indicator gadget for Time 
or Date, but since time and date values are strings, you cannot set a 
numeric range for these gadgets. For example, you can set an LED to be 
blue at exactly 8:00 and black at any other time, but you cannot set it to 
be blue between 8:00 and 12:00. 
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System tags

Tag Meaning

groov > Admin Version
(groov Box only) Version of groov Admin running on the Box. (This 
information is also available in groov View; click the gear icon and 
choose About.)

groov > App Version
Version of groov View software running on this groov product. (This 
information is also available in groov View; click the gear icon and 
choose About.)

groov > groov CPU Usage (%) 

Current CPU usage by the groov View software on either the 
groov EPIC processor, the PC where groov Server is running, or the 
groov Box, shown as a percentage. A negative value means the 
current CPU usage is not available.

groov > groov Uptime How long groov View software has been running.

groov > groov Heap Usage (MB)
Amount of memory allocated within groov View software. Normal 
values depend on the size of your groov View project.

groov > Number of Active Sessions
Number of user sessions currently viewing your groov View 
interface. Typically the number of current users, but one user 
logged in through two devices or browsers is counted twice.

Time > 

Time of day. For groov Server, the time on the PC groov Server runs 
on. For groov EPIC or a groov Box, see the product’s user’s guide to 
set time, set time zone, or synchronize with a time server. 
Choose the format you want. HH indicates a 24-hour clock; hh 
indicates a 12-hour clock.

Date > 

From the groov EPIC processor, the PC groov Server runs on, or the 
groov Box. Choose the format you want. MM means the month is 
shown in digits; MMM means the month is written out. For 
example, DD MMM YYYY might appear as 26 Jul 2017.

Operating System* > 
System CPU Usage (%)

Current CPU usage for the whole system, shown as a percentage. A 
negative value means the current CPU usage is not available.

Operating System* > System 
Uptime

How long the hardware (the groov EPIC processor, the PC 
groov Server runs on, or the groov Box) has been running.

* Operating System refers to the hardware the groov View software runs on, either the groov EPIC 
processor, the PC that groov Server runs on, or the groov Box.
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Add a Computed Tag

A computed tag is a tag you create that is the result of a JavaScript function performing a calculation on one or 
more source tags. A source tag can be a tag from another device or a data store. For example, you might want 
to create a computed tag to:
• Convert a temperature value from Fahrenheit to Celsius
• Sum the number of gallons in multiple tanks to get a total value

You need to know JavaScript to create computed tags. (Many references and training are available online such 
as W3Schools.) The data type of the final output of the JavaScript function (which becomes the data type of 
the computed tag) can be boolean, integer, float, or string.

Creating a Computed Tag

Before you create a computed tag, make sure you add the devices or data stores that contain the source tags.

To create a computed tag:
1. In the Tags tab under Gadget Palette on the right side, click Configure Devices & Tags (or choose 

Configure > Devices and Tags from the top menu bar).

2. Highlight Computed Tags and click Configure Tags.

https://www.w3schools.com/js/
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3. Click Add New Tag. The Add Computed Tag window appears. (For a description of the fields, see 
page 65.)

4. In the Name field, type a name for the computed tag.

In the next few pages, we will create two computed tag examples to help explain the instructions. The first 
one (converting a source tag) will be named Temp (Celsius). The second one (summing several source 
tags) will be named Sum All Tanks.

To create a computed tag that converts a source tag to another value:
a. Click the text box of the Inputs field (by default, the text box has the word Input followed by a 

number). Type in a name that identifies the source tag in the JavaScript function. 
This name must comply with the syntax rules of pre-Javascript 1.5, which limits the range of 
characters to ASCII. In the following example, we named the input degreesFahrenheit.
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b. Click Choose Tag, navigate through the Update Tag for Gadget window to find your desired tag, 
select the tag, and click Update Gadget.
In the following image, we selected the Store_Temperature tag as the source for 
degreesFahrenheit.

c. From the Output Type drop-down, select the data type that your JavaScript function will return. 
This is the data type of the computed tag and determines which gadgets can use it. For the 
temperature example, we selected Float.

d. In the Script field, click in the white space to type in the JavaScript function that converts the 
source tag to your desired output, making sure the data type it returns matches the selected 
Output Type. 
In the example we started in step a, we can convert the store temperature from Fahrenheit to 
Celsius with the following function: return (degreesFahrenheit - 32) / 1.8;
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The following image shows the completed window:

e. Click Save Tag.
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To create a computed tag that uses multiple source tags:
a. Click the text box of the Inputs field (by default, the text box has the word Input followed by a 

number). Type in a name that identifies the source tag.
This name must comply with the syntax rules of pre-Javascript 1.5, which limits the range of 
characters to ASCII. The following image shows the name we assigned to the first input: Tank_1.

b. Click Choose Tag.
c. Navigate through the Update Tag for Gadget window to find your desired tag and select it
d. Click Update Gadget.
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e. In the Add Computed Tag window, click Add Input to add another input. Repeat the previous steps 
to configure the new input with a name and another source tag. Repeat this step until you have 
added all your source tags.
The viewable area of the Inputs field is limited, so if you specify more than two inputs, you have to 
scroll through the box to see the other inputs. The following image shows the scroll bar to the right 
of the Inputs field:
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f. From the Output Type drop-down, select the data type that your JavaScript function will return. 
This is the data type of the computed tag and determines which gadgets can use it. For this 
example, we selected Float.

g. In the Script field, click in the white space to type in the JavaScript function that manipulates the 
source tags into your desired final value, making sure the data type of the final value matches the 
selected Output Type.
For our example, adding the three inputs gives us the desired final value:

h. Click Save Tag.
After you have finished creating a computed tag, the tag appears in the Configure Computed Tags 
window.
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5. Click Close to close the Configure Computed Tags window.
6. Click Close to close Configure Devices and Tags window.

In the Gadget Palette, you can expand the Computed Tags branch to view the computed tags you created as 
well as click a tag to view the gadgets you can use with it:

Click on the name of a 
computed tag to view 
gadgets that can use the 
tag.
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Add Computed Tag Window

Here is an overview of the fields for this window:

A Name for the computed tag. groov View displays this name under the Computed Tags branch of 
the tag tree.

B Name of the input to the JavaScript function. This name must comply with the syntax rules of 
pre-Javascript 1.5, which limits the range of characters to ASCII. groov View updates the first line (in 
gray) of the Script field with this name.

C Click Choose Tag to identify the source tag for this input.
D Click Add Input if you need to add more than one input.
E Select the data type of the computed tag. This determines which gadgets can use it.

– Boolean
– Integer
– Float
– String

F Click in the white space of the Script field to add your JavaScript. You cannot edit the first line (in 
gray) of this field. If you want to change any of the names in the first line, edit the corresponding 
input.

A

B C

D

E

F
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Configure Computed Tags Window

You can add, edit, duplicate, delete, export, and import computed tags through the Configure Computed Tags 
window:

A For instructions on how to add a computed tag, see “Add a Computed Tag” on page 57.
B Select a tag from the list on the left and click Edit.
C Select a tag and click Duplicate Tag. groov View makes a copy of the tag and lists it immediately 

below the original tag.
D Select a tag and click Delete Tag. To confirm, click Delete Tag.
E Select all the tags you want to export and click Export Tag. In the Save As window, navigate to the 

folder where you want to store the file. To change the name, type the new name in the File Name 
field. Click Save.

F Click Import Tags. In the Open window, navigate to the folder where the file is stored. Select the file 
and click Open. groov View imports the tags found in the file and adds them to the Configure 
Computed Tags window, highlighting them and indicating any changes you need to make. In the 
following example, two tags were added that need inputs configured:

Select a tag and click Edit to make the changes needed.

A

B

C

D

E

F
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Add a Data Store

A Data Store provides a way in which users of your groov View operator interface can interact with data from 
an online service, a database, or another software application. For example, your company’s SQL database 
could place production or maintenance data into a groov Data Store for users to see, or your groov View users 
could enter production or service data for the database to pull in. 

Your application uses the groov View REST API to either put 
data in groov View or get data from groov View. 

To see the full groov View REST API, in Build mode choose Help > 
groov Public API as shown at right. You can also find the API on 
developer.opto22.com. 

You add a Data Store for each application that will interact with 
groov View, and then add the tags you want the application to 
read or write to. 

NOTE: A groov View Data Store is another device in groov View like a Modbus/TCP serial device or a SNAP PAC 
controller. Devices cannot talk with each other directly. For example, a SNAP PAC cannot read data from a Data Store. 
However, you can use Node-RED in groov EPIC or the groov Box (or on your PC) to create a logical flow that exchanges 
data between devices that have Node-RED nodes. For more on Node-RED, see nodered.org and the user’s guide for 
your groov EPIC or groov Box. 

To add a Data Store in groov View:
1. In the Tags tab under Gadget Palette on the right side, click Configure Devices & Tags (or choose 

Configure > Devices and Tags from the top menu bar).

2. Click Add New Device and select Data Store.

3. Give the Data Store a name and click Create. 
The Data Store appears in the list of devices. 

https://nodered.org/
http://developer.opto22.com/
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4. Highlight the Data Store and click Configure Tags. Click the Add button  in the upper left.

5. Enter the following tag attributes:
Tag Name: (Required) Give the tag a descriptive name. 
Data Type: (Required) Select the data type that will be written to or read from this tag. 

Table: (Optional) If the tag is an array, check Table and enter the table length. From a practical 
standpoint, table length can be whatever you need (within the limits of your system’s capacity).

6. Click Save or click Save & Add Another if adding another tag. 
7. When your tag appears in the list, note the Tag Id; you use it when accessing the tag.

8. When you finish adding tags, click Close. Click Close again and notice that your Data Store appears in 
the Gadget Palette with the name you gave it. Click the plus sign (+) to see the tags in the store.

Edit Device Information

If a device’s hostname or static IP address has changed, you need to edit the hostname or address in Build 
mode. You can also change other information for a device such as its port, timeout, or scan interval.
1. In the Tags tab under Gadget Palette on the right side, click Configure Devices & Tags (or choose 

Configure > Devices and Tags from the top menu bar).
2. Select the device and click Edit Device.
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3. Change the information as needed and click Edit Device.
4. Close the Configure Devices and Tags window.

Disable Communication to a Device

Disabling communication to a device can be helpful in situations where a device incurs communication costs 
or for testing when a device is not installed yet or is not available. You can disable communication during time 
periods when you don’t need to communicate to the device.
1. In the Tags tab under Gadget Palette on the right side, click Configure Devices & Tags (or choose 

Configure > Devices and Tags from the top menu bar).
2. Select the device and click Edit Device.

3. Click the Enabled box to remove the check mark. 
For example, the following image shows the location of the Enabled box in the “Edit Opto 22 Controller” 
dialog box.
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4. Click Update Device to close the Edit Device window.

When you return to View mode, any gadgets that refer to tags from that device display an error message 
similar to the following:

Delete a Device

You can a remove a device from your project. However, be aware that any tags from the removed device are 
removed from all gadgets.
1. In the Tags tab under Gadget Palette on the right side, click Configure Devices & Tags (or choose 

Configure > Devices and Tags from the top menu bar).
2. Highlight the device you want to remove and click Delete.
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3. Click Delete Device.
4. Close the Configure Devices and Tags window.

View Device Health

The Configure Devices and Tags window shows you the status of each device connected to groov View. 
1. In the Tags tab under Gadget Palette on the right side, click Configure Devices & Tags (or choose 

Configure > Devices and Tags from the top menu bar).
2. Highlight the device you’re interested in and notice the Status column:

Possible status notations are:

3. To see more information about this device, click Device Health on the right.

Status Meaning

Idle 
groov View is not currently connected to the device; nothing is being scanned 
on it.

Scanning groov View is reading tag data from the device: everything's working fine.

Degraded 
groov View is reading tag data from the device, but it isn't responding fast 
enough to keep up with all requests.

Error
groov View encountered an error while connecting to the device. This status 
usually means the device is offline, or there's a network issue.
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Response Times—Tracks how long a device takes to fully respond to a request. A typical request would 
be reading a batch of tags (up to 20 at a time) or writing a single tag. Response Times are tracked over the 
last 5 minutes and show Minimum, Maximum, and Average response times. Values in the 75th and 
99th percentiles mean, for example, 75% of your requests finish in the reported time.
Request and Error Rates—Tracks the number of read and write requests sent to the device over the 
last 15 minutes, and reports the average requests per minute over the last 1, 5, and 15 minutes. Read 
requests typically involve more than one tag while writes are typically one tag at a time.
Dropped Requests result from too many requests in the queue. If the queue is too full, the oldest read 
requests may be dropped. If Dropped Requests are more than 1.0 for the last minute, device health 
status changes to Degraded. 
Errors indicate connection errors and are also reflected in the health status column until either the 
connection is successful or the device no longer needs to be scanned (for example, if no one is viewing a 
page that includes tags from that device). 

ADDING GADGETS

There are two basic methods for adding a gadget and associating a tag. You can start with a gadget and add a 
tag to it. Or you can start with a tag and then add the tag’s gadget.

See “Method 1: Add a Tag to a Gadget,” page 72

See “Method 2: Add a Gadget to a Tag,” page 73

Method 1: Add a Tag to a Gadget

To add a tag to a gadget:
1. Select the Gadgets tab in the Gadget Palette.
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2. Double-click a gadget or drag it to the work area.
3. Select the gadget in the work area.

4. In the Gadget Properties panel (upper right), click the tag icon next to No Tag Selected.
5. In the Update Tag for Gadget window:

a. Click the plus signs (+) to browse to the tag you want to use.
b. Select the desired tag.
c. Click Update Gadget (or double-click the tag in the list).

6. Configure the gadget’s properties. See “Configure Gadget Properties” on page 75.
7. Choose File > Save All Changes.

Method 2: Add a Gadget to a Tag

To add a gadget to a tag:
1. Click the Tags tab in the Gadget Palette panel.
2. Click the plus signs (+) to expand the tree and locate the tag you want.

Expand the tag’s 
category
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3. Click the tag to see a list of gadgets that work with the selected tag.

4. Double-click a gadget or drag it to the work area.
5. Configure the gadget’s properties. See “Configure Gadget Properties” on page 75.
6. Select File > Save All Changes.

EDITING GADGETS

You can edit gadgets such as resizing, moving, and configuring them.

Resize and Move Gadgets

When you resize or move gadgets in either the Desktop & Tablet layout or the Handheld layout, the change 
does not affect the other layout. See “Optimizing Layouts” on page 77 for more information on layouts.

• To move a gadget, grab it with the left mouse button and drag it. To move multiple gadgets, click on an 
empty part of your page and drag a box around the gadgets, or hold down the CTRL key while selecting 
gadgets.

• To resize a gadget, click it, grab a graphic handle, and drag to the new size.
If a gadget is behind another gadget, you can make its sizing handles available by clicking on an exposed 
portion of the gadget.

Resize

Move

Sizing handles
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Configure Gadget Properties

To configure a gadget, click the gadget to display its Properties panel (in 
the upper right corner of the workspace). 

Each gadget has its own specific properties. For example, part of the LED 
Gadget Properties panel is shown at right. 

See Chapter 4: Gadget Reference for information on specific gadget 
properties.

Properties and Layouts

Any property with a link icon next to it can be changed in one 
layout (Desktop & Tablet, or Handheld) without affecting the other layout. See “Optimizing Layouts” on 
page 77 for more information on layouts.

Depending on the gadget, you can change the gadget’s visibility, label name, text size, alignment, color of text 
and its background, value precision, indicator colors, orientation (vertically or horizontally), and more.

For example, suppose you want a gadget’s label to appear on the left side of the gadget in the Desktop & 
Tablet layout, but on the right side in the Handheld layout. To change it:
1. Click the Desktop & Tablet tab and click the gadget you want to change.
2. In the Properties panel, make sure Alignment is to the left. 

3. Click the link icon so it changes to a broken link , indicating that changes to this property affect 
only the current layout. 

4. Click the Handheld tab and click the same gadget.
5. In the Properties panel, notice that the link is broken and change Alignment to the right.

6. Check both tabs to see how the label on this LED appears in the two layouts:

Languages in Buttons and Labels

When adding text to a gadget, groov has full Unicode support and uses very common fonts such as Arial with 
broad support for most languages.

Link icon

Label alignment: left of gadget

Broken link

Label on left

Label on right
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Cut and Paste Gadgets

• To cut or copy a gadget: right-click it and select Delete, Duplicate, Copy, or Cut from the menu. 
• To paste a copied or cut gadget: left-click the workspace, right-click, and select Paste from the menu. 
• To select more than one gadget at a time: hold down the CTRL key as you click them, or draw a box 

around multiple gadgets.
• Duplicated gadgets appear at the bottom of both the Desktop and Mobile views. If you select more 

than one gadget to duplicate—for example a label and an LED—the duplicated gadgets maintain their 
relative positions.

As indicated in the popup menus, you can also use keyboard shortcuts for Copy (CTRL + c), Cut (CTRL + x), and 
Paste (CTRL + v). You can also choose Copy, Cut, or Paste from the Edit menu.

Make a Gadget Visible Based on a Tag

You can change a gadget’s visibility in groov View based on:
• An integer variable. A value of 0 hides the gadget and any non-zero value shows the gadget. To 

indicate which integer variable:
a. Click the Tag symbol.
b. Navigate through the Update Tag for Gadget window to select the integer variable.
c. Click Update Gadget.

• A boolean tag. A value of 0 hides the gadget and a value of 1 shows the gadget. To indicate which 
boolean variable:
a. Click the Tag symbol.
b. Navigate through the Update Tag for Gadget window to select the integer variable.
c. Click Update Gadget.

• The bit of an integer variable or element of an integer table. A value of 0 hides the gadget and a 
value of 1 shows the gadget. To indicate which bit:
a. Click the Tag symbol.
b. Navigate through the Update Tag for Gadget window to select the integer variable or integer 

table (array).
c. Specify the bit:

– For integer variables, specify the bit number in the Bit field.
– For an element of an integer table, specify the element number in the Array index field and 

the bit number in the Bit field.
d. Click Update Gadget.

Move a Gadget to the Front or Back

If gadgets overlap and you want to change the order of the stack, right-click a gadget and select Bring To 
Front or Send To Back from the popup menu.

If you don’t want a gadget to move, choose Lock Position from the popup menu.

You can also select Bring To Front, Send To Back, or Lock Position from the Edit menu.

Button gadget
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Align Gadgets

To align multiple gadgets, click on an empty part of your page, drag a box around the gadgets (or hold down 
the CTRL key while selecting them), right-click, and choose the alignment type. The Align commands are also 
available in the Edit menu.

Adjust the Size of Multiple Gadgets

To make multiple objects the same size, drag the cursor around the gadgets (or hold down the CTRL key while 
selecting them), right-click, and choose how to size them. The Size commands are also available in the Edit 
menu.

OPTIMIZING LAYOUTS

In Build mode, there are two different layouts: Desktop & Tablet and Handheld. The Desktop & Tablet layout 
shows you how gadgets will appear when viewed on a computer monitor or a tablet. The Handheld layout is 
for viewing on a smaller handheld device such as a smartphone.
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groov View automatically shows the appropriate layout for the device being used. Or, if you are using the 
groov View app for iOS or Android on a mobile device, you can choose which layout to view.

If most of your users will view your groov operator interface on a smartphone, you may want to start building 
your project in the Handheld layout tab. No matter where you start, you can adjust both layouts to optimize 
them for the people who will use them.

For any given page, by default both layouts contain identical gadgets and properties, but you can make the 
layouts different in several ways. 

To work on a layout, click the tab for either Desktop & Tablet or Handheld at the top of the page.

You can switch between tabs as needed to make each layout the way you want. You can:
• Change a gadget’s size and position in one layout without affecting the other one. For example, you can 

move the most important gadgets to the top in the Handheld layout. See “Editing Gadgets” on page 74.
• Hide a gadget in one layout and show it in the other. See “Use the Page Stash” on page 26.

Desktop & Tablet layout

Handheld layout

Click tab



CHAPTER 2: BUILDING A PROJECT

groov View User’s Guide 79

• Change the size, color, and alignment of gadget text in one layout (for example, to fit more on a smaller 
screen). Be careful not to make text too small to read or the controls too small to use with your finger. See 
“Properties and Layouts” on page 75. 

• Show a different gadget label on one layout than on the other. See “Properties and Layouts” on page 75.
• Orient a gadget horizontally in one layout and vertically in the other. See “Properties and Layouts” on 

page 75.

Each gadget has individual properties that may limit or expand what you can do with it in a layout. See 
Chapter 4: Gadget Reference for information on each gadget. 
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Chapter 3

3: Managing groov View

This chapter describes how to manage user accounts, back up and restore your project, update groov View 
and your license, and more.

In this chapter:
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Managing Images in the Image Library...........................................................88
Managing Security Certificates ............................................................................91
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Viewing the Tags in Use ..........................................................................................95
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Changing the General Project Settings............................................................98
Saving Your Project and Opening groov View ........................................... 100
Backing Up and Restoring Your Project......................................................... 100
Resetting your groov Project ............................................................................. 102
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Updating Your License/Renewing groov Maintenance......................... 104

MANAGING USER ACCESS

When you build or change your groov View project, you have specific ideas in mind about which people will 
use the mobile operator interface and which software applications will have access to groov data. Managing 
these people and applications—your groov View users—is the key to maintaining security. Here are some 
examples:

People—You may want a line operator to monitor and control equipment on the line while a supervisor can 
see widget production but has no control over the equipment. Or, you may want a central station to monitor 
equipment at remote sites, and field technicians to control it from a tablet. 

Software—It’s not just people who may need access to data in groov View. You may also want software 
applications to access the data in a groov Data Store using the groov API (application programming interface). 
For example:
• A company database could write daily sales totals for managers to see on their phones. 
• A custom application written in C++, .NET, JavaScript, or another programming language could share 

operational data from remote automation equipment, which then appears to technicians in groov View. 
• A cloud data service like AT&T® M2X® or Amazon Web Services® (AWS) could provide data on trucks and 

freight containers to logistics personnel.
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• A Node-RED flow you build could tweet status to operators when pressure is unusually low. For more 
information on Node-RED, see the groov EPIC User’s Guide (form 2267) or the groov Box User’s Guide 
(form 2104).

Software clients that need to access data in groov View must be added as users in Build mode. We 
recommend that each software client be assigned a unique username, password, and API key. That way, if 
multiple software applications are using the API and one becomes compromised, the others can still operate 
securely. 

Because security is a top priority, restrict access to your groov View data and interface—or to parts of it—to 
make sure that only authorized people and software can use it, and only in the ways you intended. Here are 
three ways you can manage access: 
• Create an account for each user. Each person or software application that uses your groov View 

operator interface or accesses its data must have an account with a username and password. When 
people use your groov View interface, their passwords are encrypted. When applications access 
groov View data, they must use their assigned API key to verify their identity. 
Make sure all users understand the importance of security, keep their passwords and API keys safe, and 
understand how to change them. 
For instructions, see “Create a User”  below.

• Create user groups to control page access. With multiple users, groups are an easy way to define who 
sees which pages. For example, you could create one user group for central station monitoring personnel 
and two groups for field technicians, and then assign each user to the correct group. The Central Station 
group sees pages showing all remote sites for monitoring. The Field Technicians West group sees pages 
with controls for their geographic area; the Field Technicians East group sees similar pages for their area. 
For instructions, see “Manage User Groups” on page 86. 

• Create pages for specific purposes. If a line operator needs to monitor and control equipment, but a 
supervisor only needs to monitor it, create two pages—one for each purpose. The operator’s page 
includes controls while the supervisor’s doesn’t. For instructions, see “Working with Pages” on page 21.

Create a User

You must be an Admin user to create or change users.

1. In Build mode, choose Configure > Accounts.
2. Click the Users tab.

3. Click Create New User.

https://documents.opto22.com/2104_groov_Box_Users_Guide_for_GROOV-AR1.pdf
https://documents.opto22.com/2267_groov_EPIC_Users_Guide.pdf
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4. Enter a Username for the new user.
5. If this user will receive email notifications from groov View, enter the email address to use.

See Chapter 5: Using Events and Notifications.
6. Select a Role based on the security level for this user (Admin, Editor, Operator, or Kiosk).

For example, if you want a user to be able to log in and out of groov View and change their password, 
choose the Operator security level. If you want a user to use View but not be able to log out or change 
their password, choose Kiosk. 
For software users, choose Admin or Editor. Lower levels cannot access a groov Data Store.
This table shows the privileges available for each security level:

7. For Operator or Kiosk users, if you have already configured groups, select the groups the user belongs to.
Groups are used to restrict access to particular pages. For example, if a page is restricted to members of 
the group called West Wing, then an Operator or Kiosk level user must be in the West Wing group to 
access that page. See “Manage User Groups” on page 86.

8. Click Create User.
The user appears in the list.

Security Level

Admin Editor Operator Kiosk

P
ri

vi
le

g
e

Use and interact with the gadgets in 
groov View

   *  *

Log out and back in, and change their 
password in groov View

   *

Use Build mode to add devices, make or 
change pages, & set groups on pages

 

Use the groov API to securely access 
data in a groov Data Store

 

Create users and groups, assign users to 
groups, and generate new API keys



* Only for the user groups an Operator or Kiosk user belongs to. See page 86.
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9. Give the username and password (for a person) or API key (for software) to the user. 
API keys are automatically generated. To change an API key, see “Change a User’s Settings”  below.

Find a Software User’s API Key 

You must be an Admin user to see API keys.
1. In Build mode, choose Configure > Accounts.
2. Click the Users tab. 

3. Find the user in the list (if you have a long list of names, use the Filter by name field to help). Read 
across from the Username to the API Key column.

Change a User’s Settings

You must be an Admin user to change user settings.
1. In Build mode, choose Configure > Accounts.
2. Click the Users tab. 
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3. Find the user you want to change (if you have a long list of names, use the Filter by name field to help).
4. Click the edit button  in line with the user’s name.

5. Change the user’s settings as needed. (See more information in “Create a User” on page 82.) Note two 
things you can do here that weren’t available when you first created the user:
– API Key (applies to software users)—Click Generate to assign a new API key (you cannot create 

your own). After you update this user and return to Manage Accounts, you can see the new API key. 
The old key is automatically disabled.

– Password change—You can assign the user a new password here, or check the box if you want to 
force the user to change their password the next time they log in. (Note that the user’s current 
password is not visible. There is no way to retrieve a user’s current password, but you can assign a 
new one or require them to change theirs.)

6. Click Update User.
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Delete a User Account

You must be an Admin user to delete a user account.

A deleted user will no longer be able to log in.
1. In Build mode, choose Configure > Accounts.
2. Click the Users tab.
3. In the list, find the user you want to delete (if you have a long list, you can use the Filter by name field to 

find it). 
4. Click the trash can button  in line with the user’s name.

A confirmation message appears.
5. Click OK to confirm.

Manage User Groups

You must be an Admin user to create or change groups.

Groups are used to restrict access to particular pages for Operator and Kiosk level users. For example, if a page 
is restricted to members of the group called West Wing, then an Operator or Kiosk level user must be in the 
West Wing group to access that page.

To work with groups:
1. In Build mode, choose Configure > Accounts. 
2. Click the Groups tab.

– To delete an existing group, find the group name in the list (if you have a long list, you can use the 
Filter by name field to find it). Click the trash can button  in line with the group name.

– To create a new group, click Create Group. 
– To edit an existing group, find the group name in the list and click the edit button  in line with 

the group name.
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3. Enter or change the Group Name, select the users to be included in the group, and select the pages this 
group should see. 

NOTE: You must have already designated page permissions as Limited Access, or the page will not appear here. 
To change a page’s permissions, cancel this dialog box. In Manage Accounts, click the Pages tab. Find the 
page you want to change and click the edit button in line with the page name. Under Access Rights, choose 
Limited Access. For more information about page permissions, see “Change Page Properties” on page 21.

4. Click Create Group (or Update Group). 

Change a User’s Password

How passwords are changed depends upon the user’s security level.
• An Admin level user can change any user’s password; see “Change a User’s Settings” on page 84. 
• Admin and Editor level users can change their own passwords in either Build or View. 
• Operators can change their passwords in View. 

Changing your password in Build mode: 
Choose Security > Change Password.

Changing your password in View: 
Click the gear icon and select Change Password.
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Fill in the form with the old 
and new passwords; then 
click Change Password.

Log Out Users

An Admin user can log out all logged-in users in one step. The users will no 
longer get gadget updates, write values, or change pages.

In Build, choose Security > Log Out All Users.

MANAGING IMAGES IN THE IMAGE LIBRARY

All images you use in your groov View project are stored in the Image Library. You can use the same image in 
any number of places in your project, and if you change the image, it is updated everywhere it appears. 

groov View accepts many different kinds of images, including photos, drawings, and logos with file types of 
BMP, GIF, PNG, JPG, and SVG. You can even use an animated GIF. For best performance, use images no larger 
than 2000 x 2000 pixels at 72 dpi with 8-bit color information, or a total of less than 300 KB in size per image. 

You can upload images you make or obtain yourself and any of the drawings in the SVG Library on the 
Opto 22 website. If you have Microsoft Visio 2003, you can also make a compatible image using any of our free 
Visio libraries. 

You can use images in a variety of ways:
• Use multiple images in the Image Indicator to show status or value (see page 125).
• Put your logo in the caption bar at the top of the page (see Groov View Styling in “Changing the General 

Project Settings” on page 98).
• Orient your users by showing an image of the location or device they’re monitoring.
• Skin a button with an image (see page 117, page 118, and page 119).
• Use an image as a link to another page or internet location (see page 110).

One caution: It’s easy to overdo the use of images. Make sure you don’t clutter your operator interface with 
unnecessary graphics. Animations are especially distracting for users and should be avoided. Use images that 
will help your users, not distract them from what’s important on the screen. 

Add Images

You can add images to the Image Library directly, or you can add them while you’re assigning properties to 
gadgets.

https://www.opto22.com/support/resources-tools/image-library-svg-editors
https://www.opto22.com/support/resources-tools/image-library-svg-editors
https://www.opto22.com/support/resources-tools/visio-stencils-of-groov-epic-and-groov-rio
https://www.opto22.com/support/resources-tools/visio-stencils-of-groov-epic-and-groov-rio
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Adding Images Directly to the Image Library

1. In Build mode, choose Configure > Image Library. 

2. Click Add New Images and browse to the location of the image(s) you want (or drag the image(s) from 
their current location into the Image Library).

3. (Optional) Click inside the Notes area to add your own notes about the image.

Adding an Image to a Gadget

To add an image while setting the gadget’s properties:
1. Make sure the gadget is highlighted.
2. In the Properties panel (upper right), click Add Image or (depending on the gadget) choose Display 

Mode > Image, and click the broken image button.
3. In the Image Library, select the image you want (or click Add New Images, browse to the image, click 

Open, and then select it in the Library). 
The library closes and you return to the main workspace to choose image properties. See Chapter 4: 
Gadget Reference for details on each gadget.
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Change Image View

To see more details about the images in the library, or to view more images in the same space, choose a 
different view at the top of the library.

Image details view (default)

Image basics view
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Change an Image

If you change an image, you can upload the new version to replace the 
older one in the Image Library. You must have already made the change to 
the image in another software program.
1. Choose Configure > Image Library and locate the image you want 

to change.
2. Click the pencil icon at the left of the image and browse to the new 

version of the image. 
3. Click Open to replace the image.

Delete an Image

1. Choose Configure > Image Library and locate the image you want 
to delete.

2. Click the trashcan icon at the left of the image.
The image is deleted.

MANAGING SECURITY CERTIFICATES

Secure connections to OPC UA servers are supported in groov View R4.5 and higher. Some OPC UA servers 
offer security options; some require them. (See “Add an OPC UA Server” on page 45 for more information.) If 
you choose Message Security levels Sign or Sign & Encrypt for server connections, the server and the client 
(groov View) must trust each other’s security certificates.

For more information on security certificates, see “Managing the SSL Security Features” in the groov EPIC User’s 
Guide (form 2267). 

You can manage server and groov View client certificates in Build mode.

Image thumbnails view

https://documents.opto22.com/2267_groov_EPIC_Users_Guide.pdf
https://documents.opto22.com/2267_groov_EPIC_Users_Guide.pdf


MANAGING SECURITY CERTIFICATES

groov View User’s Guide92

To manage security certificates in Build mode:
1. Choose Configure > Certificates. 

2. Manage server certificates in this tab:
– To reject a certificate with a Trusted status, click Reject. Or, to trust a certificate with a Rejected 

status, click Trust.
– To see a server’s certificate, click View.
– To add a certificate, click Upload Server Certificate, navigate to the certificate’s location on your 

PC, and click Open. To replace an existing certificate, click Upload in the Replace column.
– To refresh this window, click .

3. To manage the groov View client certificate, click the Client Certificate tab.

You see the current certificate used by groov View’s OPC UA client. 
4. To download the certificate, click Download.
5. To manually create a new self-signed certificate and private key, click Create.

The default self-signed certificate is generic. You may want to add specific identifying details such as 
company name or email, so that when a remote server receives the groov View client certificate, the 
administrator of the remote server can see exactly who that certificate belongs to. Learn more about this 
identifying information at: https://knowledge.digicert.com/generalinformation/INFO1745.html

https://knowledge.digicert.com/generalinformation/INFO1745.html
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The Create Client Certificate dialog box opens:

a. Complete all fields.
(These fields conform to standards in RFC 5280: Internet X.509 Public Key Infrastructure Certificate.)

b. Click Create. 
The new certificate and private key replace the previous one, and the groov View OPC UA client is 
restarted.

6. To upload a public certificate and private key that you have saved on your PC, click Upload.

a. Click the buttons to load the certificate and private key from your PC.
b. Click OK to submit the files to the server for validation. 

If the files are valid, the new certificate appears in the Client Certificate tab. If they are not valid, 
errors appear in the dialog box. 

https://www.rfc-editor.org/rfc/rfc5280
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ADDING A PAGE CATEGORY

If you have a large project, you can organize pages in the operator interface by creating categories and 
assigning pages to them. 

For example, if you have a multi-story building, you could make a category for each floor, and then add pages 
to it that apply only to that floor. Or, categories can represent individual machines, rooms, or any number of 
things. 

When you create a new category, make sure to add at least one page to the category. Otherwise, the category 
is deleted automatically when you save and open View. For more, see “Working with Pages” on page 21.

To add a page category:
1. In Build mode, click Add Category under Pages on the left side.

2. Type a new name for the category. 
3. Click OK.

4. To put existing pages in the new category, in the Pages panel, use your mouse to drag and drop them 
below the new category name.

Drag existing pages below the 
new page category.
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Delete a Category

The process for deleting a category is similar to deleting a page. However, you can only delete a category that 
does not have any pages assigned to it. To delete a category with pages, first move or delete the pages, and 
then delete the category.

To delete a category:
1. Hover over the page or category name you want to delete in the Pages panel
2. Click the red X that appears.

3. Click OK.

Rename a Category

1. Right-click the name and select Rename.

2. Enter a new name and press the Enter key (or left-click in the work area).

VIEWING THE TAGS IN USE

To see all the tags being used in your project, select View > All Tags. The Tags in Use dialog box shows the 
tags in use, the gadget or event they are used in, the device, and the page in your groov View project. 

Click the red X.
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Click Sort by in the upper right to sort tags alphanumerically by tag name, device, page, or gadget. 

In the Page column, you can click the page name to go to the page. To return, choose View > All Tags again. 

VIEWING LOG MESSAGES

groov View continually logs messages about what it’s doing, including all activity that occurs while you are 
using groov View as well as events and event notifications. Seeing these messages in the Log Viewer can help 
you troubleshoot issues or track groov View progress. All messages are logged, but you can choose what you 
want the Log Viewer to show.

All users can view events. For instructions, see “Viewing Events” on page 139.

Only Admin or Editor level users can see the Log Viewer. 

To open the Log Viewer: 
• From Build mode, choose Help > View logs. (Note that the Log Viewer opens in View mode in a new 

tab; to return to Build mode, close the tab.)
• From View mode, choose Menu > View logs.

The Log Viewer opens in a new browser tab, showing the 500 most recent messages. New messages are 
added to the Viewer as they occur and continue to be added until you close the Viewer. If you reopen it later, it 
again shows the 500 most recent messages; older messages do not appear. 

To view older messages, scroll to the top of the log and click Fetch older entries. Each time you click it, the 
viewer shows an additional 100 of the older messages. 
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To save all messages to a text file, click Download Logs. You can open the text file in Notepad or save the 
text file. Downloading the logs saves all of the messages—not just the ones currently in the Viewer. The 
downloaded file may also include additional information for some errors, which is not shown in the Log 
Viewer. 

To clear the messages currently in the Log Viewer window, click Clear Viewer. This action does not clear all 
logged messages; you can see them again by clicking Reload or clicking Download Logs to retrieve them.

To filter messages in the window, such as for a key word within the message, type the word or phrase in the 
Filter field. The list immediately changes to show only those messages. To see older messages from the 
filtered list, click Fetch older entries.

To diagnose problems when working with Opto 22 Product Support, the support engineer may ask you 
to click the Configuration button to display a file that provides special features. Follow instructions from the 
engineer to modify the file. 

Modifications to this file change the priority level of the data shown. When changes to the file are saved, logs 
having a priority below the selected level are not shown. For example, selecting WARN excludes all INFO, 
DEBUG, and TRACE level logs from the display. Here are the possible levels:
• TRACE: Extremely fine-grained information. This level is primarily for diagnosing problems with the help 

of Opto 22 Product Support.
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• DEBUG: Fairly fine-grained information. Primarily for diagnosing problems with the help of Opto 22 
Product Support.

• INFO: Messages about the general progress of the app.
• WARN: Information about unusual situations that may indicate a problem in groov View or that 

groov View is improperly configured.
• ERROR: Errors within groov View that typically don’t affect how the program runs.
• FATAL: Problems that cause groov View to crash.

CHANGING THE GENERAL PROJECT SETTINGS

This section describes the General Settings for your project. To set up a groov View email account and 
configure the Email Settings, see “Setting Up Notifications” on page 141.

To configure the general project settings:
1. In Build mode, choose Configure > Project.

The Project Settings window appears.

2. Under General Settings, configure the following options:
– Default video gadget refresh period—Sets how often in seconds groov View refreshes the 

image from an IP camera. Use this option to set the default refresh period for video gadgets. The 
minimum video refresh rate is 0.5 seconds. Every instance of the video gadget uses this refresh 
period unless a different refresh period is set for an individual instance. To set an individual instance, 
see “Video Gadget” on page 112. For more information about how to use this setting, see “Changing 
the Video Gadget Refresh Period” on page 175.

– Do not expire Kiosk user login sessions [Option not shown in the above image. Only for 
groov Server and groov Box; for groov EPIC, use groov Manage.]—Use this setting if you want Kiosk 
users to never be logged out. This is helpful for TVs or other displays not associated with a particular 
user that need to remain on for long periods of time. Normally, a login lasts two weeks. If you have 
Kiosk users, also see “Automatic Refresh” on page 153. 

– Allowed Cross-Origin Request Domains—If you have developed a JavaScript application that 
uses the REST API for groov View and runs on a different domain, you may need to enter that 
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domain here to allow it to access groov View data. For more information, see the groov REST API/cors 
section on the Opto 22 Developer website. 

3. To change the behavior and look of your groov View project (navigation bar, page menu, colors, logo, and 
so on), scroll down to the View Mode box. 

4. Configure the following options:
– Navigation bar

Scroll or Fix—Choose whether the navigation bar at the top of the page scrolls off the top of the 
page when your user scrolls down, or stays fixed at the top of the page. 
Show Events—To keep users from seeing Events, uncheck this box to hide the Events icon at the top 
right of the page.

– Navigation bar color and Menu color
Click the box to change the default colors to match your brand or taste. Choose colors from the 
samples shown.

– Page Menu
Choose how the Page menu appears in your HMI. If you choose Do not show, users can see only 
the first viewable page. All other pages are not available to view (unless the first page includes a link 
to another page).

– Logo
Choose whether to show the default groov View logo, add your own custom logo, or show no logo. 
To add your own logo, click Custom and then click Choose Image. In the Image Library, locate or 
upload the image you want to use. A logo larger than 135 x 35 pixels is resized smaller.

– Design Helpers
See “Fitting Designs on a Page (Page Size Overlay)” on page 25 for an explanation and steps to use 
this option.

5. Scroll to the top and click Save Settings.
6. Click Close.

https://developer.opto22.com/groov/view/cors/
https://developer.opto22.com/
https://developer.opto22.com/groov/view/cors/
https://developer.opto22.com/groov/view/cors/
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SAVING YOUR PROJECT AND OPENING groov VIEW

To save your project, click the File menu and select one of the following.

Save All Changes—Saves your latest changes, but it does not update any open iterations of View.

Save All Changes and Switch to groov View—Saves your latest changes and opens an updated 
groov View. All new and updated pages for groov View are automatically updated and refreshed for all users. 

Switch to groov View—Opens groov View without incorporating any changes you have made since your 
last save.

Open groov View in New Tab—Use this option if you want to have both Build and View modes open at the 
same time in separate tabs.

To back up your groov View project, see the next section.

BACKING UP AND RESTORING YOUR PROJECT

You should back up groov View frequently because there is no automatic backup. During backup, your project 
is saved to a file on your computer. groov View project backups are interchangeable among groov EPIC, 
groov Server, and the groov Box. For example, you can restore to groov EPIC a project you backed up from a 
groov Box or vice versa.

If you have two groov View installations of different versions and you want to move a project to the older 
version, you may only be able to do this between lettered versions. For example, moving a project from a 
groov Box at R3.4b to a groov Server at R3.4a should be OK, but moving from R3.4 to R3.3 is not likely to work. 
For the best experience, keep your groov View software at the same release if you can. 

If you are using a groov Box, you can also back up using groov Admin. For more information, the groov Box 
User’s Guide for GROOV-AR1 (form 2104).

IMPORTANT: Your groov View project files are not encrypted or masked in any way. This means that most of the 
project information in them (except for the groov View user passwords) can be read, including:

• SMTP account info (includes password)

• User email accounts (does not include the groov View user passwords, which are securely encrypted before 
being stored)

• Device addresses

• Tag address information (PAC tag names, Modbus addresses, OPC node-id, etc.) 

Opto 22 recommends that you secure your backup files using file- or disk-based encryption provided either by the 
operating system or other software/hardware.

Also, be aware that if you send project files to Opto 22, our personnel will have access to the information listed above.

https://documents.opto22.com/2104_groov_Box_Users_Guide_for_GROOV-AR1.pdf
https://documents.opto22.com/2104_groov_Box_Users_Guide_for_GROOV-AR1.pdf
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Back Up Your Project

To back up your project:
1. Choose File > Backup Project to Computer. 

2. Check the boxes to include trend data and event notifications in the backup or to exclude user data. 
For example, if you are sending the backup to Opto 22 Product Support for help with an issue, you might 
want to exclude user data.

3. Click Download Project.

A backup file is downloaded to your computer.

Restore Your Project

To restore your project from a backup file:

CAUTION: Restore your project only if you have to. You will lose all work done since the last backup, and all users 
will be logged out.

1. Select File > Restore Project from Computer.

2. In the Restore Project dialog box, browse to the location of your tar.gz backup file.
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3. Enter the username and password for the Admin account.
4. Click Restore.

The following warning appears.

5. To proceed, click OK.
When the restoration process is complete, the restored project opens in groov View.

RESETTING YOUR groov PROJECT

If you need to start a new project, you can reset your project. Resetting deletes all your devices, pages, and 
trend data, so you can start over fresh. This feature is useful for system integrators or others who work on 
multiple projects for different customers or locations.

To reset your project:
1. Back up your existing groov View project (see page 100). 
2. Choose File > Reset Project. 

You return to a blank project. You can start a new project or choose File > Restore Project from 
Computer to restore a project you backed up earlier. 

UPDATING groov

You are eligible to receive groov View updates as long as your license is active. Updates add new capabilities 
and fix issues that may arise. 

Each groov View installation (each EPIC or Box or Server) is treated independently; updates are valid for a 
specific groov View installation only.

To see your version of groov View:
• In Build mode, choose Help > About.
• In View, click the gear icon and choose About.
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Check for Updates

To check for updates:
1. Log in to manage.groov.com.
2. Click Manage. 
3. Find your groov product in the list and click the Manage button next to its name. 
4. If you have not installed one of the latest updates, click the filename to download the file. 

In a groov Box or groov Server, if updates are available, an icon appears next to the groov logo in the 
upper-right corner of Build mode. (This icon does not appear in a groov EPIC.) 

Click the updates icon (or select Help > Check for Updates). The Check for Updates dialog box opens to 
show you what updates are available. Follow the on-screen instructions to download an update file or view a 
list of changes in the latest groov View Release Notes (readme).

To install an update file, follow the instructions below for your groov product.

Install Updates on groov EPIC

To install updates on a groov EPIC processor, use groov Manage on a computer. The update uses a single file to 
update groov View, PAC Project, CODESYS, Node-RED, Ignition Edge, groov Manage, and firmware for the EPIC 
processor. Installing the update requires careful planning. Follow instructions in the groov EPIC User’s Guide 
(form 2267). 

Install Updates on groov Server for Windows

1. Back up your groov View project (page 100). 
2. Double-click the downloaded update file and run the installation.

Install Updates on a groov Box

To install updates on a groov Box, use groov Admin. For more information about groov Admin, see the 
groov Box User’s Guide for GROOV-AR1 (form 2104). For the GROOV-AT1, see form 2077.

To update groov Admin or Ignition Edge, follow steps in the groov Box User’s Guide for GROOV-AR1 (form 2104).
To update groov View, follow these steps:
1. Back up your groov project (page 100). 
2. To open Admin from Build mode, select Configure > groov Admin.

3. Click Quick Start.
4. Click the Update groov View button.

Click the updates icon

https://documents.opto22.com/2104_groov_Box_Users_Guide_for_GROOV-AR1.pdf
https://www.opto22.com/support/resources-tools/documents/2077-groov-box-user-s-guide-for-groov-at1
https://documents.opto22.com/2267_groov_EPIC_Users_Guide.pdf
https://www.opto22.com/my-opto/manage-groov
https://documents.opto22.com/2104_groov_Box_Users_Guide_for_GROOV-AR1.pdf
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5. Click Choose File.
6. Navigate to the update file you downloaded and click Open.
7. Click Update.

Wait while the application is installed and restarted automatically, which may take several minutes. When 
the operation is complete, a success message appears.

UPDATING YOUR LICENSE/RENEWING groov MAINTENANCE

NOTE: This section applies to groov Server for Windows and groov Box only. It does not apply to groov EPIC.

To install groov View updates on groov Server for Windows or a groov Box, your license must be up to date. You 
may need to download and install a new license. For more information, see the groov Maintenance Technical 
Note (form 2130).

IMPORTANT: You must be logged into groov Build mode as an Admin to update your license. (If you’re using a 
groov Box, make sure you use the Admin username and password for groov View, not for the Box.)

To check the enabled options and expiration date, select Configure > Licensing (this menu item 
appears only if you are logged into Build mode as an Admin user). The expiration date appears under License 
type.

https://documents.opto22.com/2130_groov_View_Maintenance_Technical_Note.pdf
https://documents.opto22.com/2130_groov_View_Maintenance_Technical_Note.pdf
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When your license is about to expire, we send a reminder to the email account you used when you first 
purchased this groov Server or Box. Also, a small notice appears when you first open Build mode to remind 
you to renew. Once the license has expired, you’ll see a similar notice:

Renew Your License

1. Log into manage.groov.com and click Manage. 
2. Locate your groov product in the list.
3. Click its Maintenance Expiration Date (in red) to see renewal options.

4. Under Renewal Options, click the part number for the length of time you want to renew. (Because 
renewal is free, we recommend GROOV-MNT-10Y, which renews maintenance for ten years.)

International customers: Please contact your local Opto 22 Distributor to purchase a renewal.

License agreement 
expiration date

Click in the middle of the notice to go to the 
Licensing dialog box and renew your license. If 
you’re not ready to renew, click the gray x to dismiss 
the notice.

https://www.opto22.com/products/product-container/groov-mnt-10yr
https://www.opto22.com/my-opto/manage-groov
https://www.opto22.com/about-us/distributors/international-optodistributors
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5. Add the product to your cart or call your distributor to order.
When the order is complete, you receive an email or printed certificate with the Activation Key for the 
renewal. The Activation Key in your email or printed certificate is not specific to an individual 
groov product; you can apply it to any groov Server or groov Box you own. 

6. When you have your Activation Key from the email or printed certificate, go to manage.groov.com. 
7. Log in using the email address and password you used when you first activated your groov product.

8. Click the Activate button. Follow instructions on the screen to enter your Activation Key and apply the 
maintenance renewal to your groov Server or Box. Choose carefully to make sure it’s the right one.

9. In your groov product’s Profile page, click Download License File and save the file to your computer.
10. In groov Build mode, return to the License Management dialog box (Configure > Licensing) and click 

the Select License File button.
11. Browse to the new license file, highlight it, and click Open.

An Upload Successful message appears in the License Management dialog box.
12. Click Close.

Your renewal is complete.

https://www.opto22.com/my-opto/manage-groov
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Chapter 1

4: Gadget Reference

Build mode provides a collection of gadgets that allows you to create a graphical, on-screen operator 
interface. This chapter provides details on how to configure gadget properties.

Gadget Go to
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GROUP HEADER GADGET

Use the Group Header gadget to visually define a group of objects. Group related gadgets in the same area 
and place a Group Header as a box behind them. The box ties them together visually so operators know at a 
glance that they are related. 

TIP: If you need to move a Group Header (or any other gadget) behind another gadget, right click it and choose Send 
to Back.

Other gadgets placed on top

Align title at the left, center, or right. Default is left.
Choose title text size. Default is 12. 
Choose title font. Default is Arial.
Make title bold, italics, or both. Default is bold.
Change title text color (click the rectangle and choose).

Enter a title for 
the group.

Group Header 
gadget

NOTE: For any property with a link button, you can click to break the 
link and choose the property value independently for Desktop & 
Tablet versus Handheld layouts. See “Properties and Layouts” on 
page 75.

(Optional) For an explanation of this 
property, see “Make a Gadget Visible 
Based on a Tag” on page 76.
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LINE HEADER GADGET

Use the Line Header gadget to provide a label or title for organizing gadgets on a page. 

DIVIDER GADGET

The Divider gadget provides a simple gray horizontal or vertical line to separate groups of objects. You can 
make the divider longer or shorter by selecting the object and dragging its handles.

Align title at the left, center, or right. Default is left.
Leave title text size at Auto or choose size in pixels. 
Choose title font. Default is Arial.

Make title bold, italics, or underlined. Default is 
underlined, and the underline extends past the title 
to the full width of the gadget.

Change title text color and background color (click 
the rectangle and choose).

Enter title text.

NOTE: For any property with a link button, you can click to break the 
link and choose the property value independently for Desktop & 
Tablet versus Handheld layouts. See “Properties and Layouts” on 
page 75.

(Optional) For an explanation of this 
property, see “Make a Gadget Visible 
Based on a Tag” on page 76.

Horizontal or vertical

(Optional) For an explanation of this 
property, see “Make a Gadget Visible 
Based on a Tag” on page 76.
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PAGE NAVIGATOR GADGET

Use the Page Navigator gadget to link to another page in the project, to groov View Event Status or Event 
Logs, or to a webpage. The gadget can be displayed as a text link, a button, or an image.
• To link to a page in your groov View project, select the page from the list or search on the page name (or 

partial name).
• To link to Event Status or Event Logs, choose it from the Link To drop-down list.
• To link to a webpage, choose Web Page in the Link To drop-down list, and enter a full URL (for example, 

https://opto22.com). 

Page navigator gadget Display Modes

Button

Image

Choose whether to show the link as text, 
a button, or an image. 

Link

For a link or a button:
Enter the text for the link.
Leave link text at Auto or enter size in pixels. 
Choose title font. Default is Arial.
Make title bold, italics, or both. Default is neither.
Change title text or background color 
(click the rectangle and choose).

For an image:
Click the broken image button and choose an image from 
the Image Library (see page 88).

NOTE: For any property with a link button, you can click to break the link and 
choose the property value independently for Desktop & Tablet versus 
Handheld layouts. See “Properties and Layouts” on page 75.

To change how transparent an image is, enter a value between 0 and 100. 
Zero is completely transparent (invisible); 100 is completely opaque.

Choose where the link goes.

(Optional) For an explanation of this property, see 
“Make a Gadget Visible Based on a Tag” on 
page 76.
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AUTO NAVIGATOR GADGET

Use the Auto Navigator gadget to automatically move all viewers of the page this gadget is on to another 
page in the project. Note that this gadget is invisible in groov View. When the Boolean tag it is connected to 
becomes true, the page automatically changes. 

Remember that if you need a more complex condition, you can create an Event for the condition and use the 
Event tag as the trigger. For more on creating and using Events, see Chapter 5: Using Events and Notifications.

From the list, select the page that should appear 
when the tag becomes true. You can search on the 
page name (or partial name) if you have a long list.

Remember: this gadget is invisible to 
your groov View users. 
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VIDEO GADGET

The Video gadget displays iFrame-type video images from an IP camera; it does not interact with controller 
points/variables.

For information about entering a URL and setting up IP cameras, see the appendix on page 173 and your IP 
camera or server documentation.

Camera URL—Enter the URL of an IP camera or video server that provides access to your IP camera’s static 
image feed. If you are using a video server, use the server’s URL. For more information about entering a URL, 
see the appendix on page 173. 

Update Period—Set how often in seconds groov View updates the image from an IP camera for this 
individual video gadget. To set the default update period for all video gadgets, see “Changing the General 
Project Settings” on page 98. For more information about this setting, see “Changing the Video Gadget 
Refresh Period” on page 175.

Use groov View as a proxy—Provides a secure reverse proxy service for the video gadget. This service is 
useful when viewing from outside a firewall. 

When the box is checked, the video 
gadget requests video from 
groov View, which authenticates and 
forwards the request to the IP camera, 
eliminating the need to configure the 
firewall for each IP camera. 

In this case, groov View polls the IP 
camera over the local network at the 
set update period (in seconds) and 
buffers the images. When you look at 
your groov View project, you will see 
the images over the same secure connection as the rest of your groov View project.

When the box is not checked, the 
video gadget requests video directly 
from the IP camera. You must 
configure the firewall to allow the 
video feed for each IP camera. 

Video gadget

(Optional) For an 
explanation of this 
property, see “Make a 
Gadget Visible Based on 
a Tag” on page 76.

groov groov View

IP camera

groov

IP camera

groov View



CHAPTER 4: GADGET REFERENCE

groov View User’s Guide 113

Maintain aspect ratio—Check the box to keep the video at the same height-to-width ratio when the video 
gadget is resized.

Test Feed—Click the button to test the live IP camera feed in Build. 

IMAGE GADGET

Use the Image gadget to place an image in your project. See more about using images in “Managing Images 
in the Image Library” on page 88.

Click here to open the 
Image Library.

Image gadgets

To change how transparent an image is, 
enter a value between 0 and 100. 
Zero is completely transparent (invisible); 
100 is completely opaque.

(Optional) For an explanation of this property, see 
“Make a Gadget Visible Based on a Tag” on page 76.
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RECTANGLE AND OVAL GADGETS (SHAPE GADGET)

Use the Rectangle gadget to place a square or rectangle shape in your project, and use the Oval gadget to 
place a circle or oval. Both are essentially the same Shape gadget with most of the same properties. 

You can choose any color for the shape’s edge (Stroke) and body (Fill), and choose how transparent they are. 
You can also round a rectangle’s corners. 

You can use this shape for any purpose: alone or in combination with other shapes or other gadgets. In 
addition, you can set the width and/or height of the shape to change dynamically based on a tag. For 
example, you could use a shape to indicate the level in a tank. 

Enter the width of the Stroke (edge). 
To round a rectangle’s corners, increase the 
Corner radius value. Zero = square corners.

Choose the color for the inside of the shape. 
To change its transparency, move the slider.

Choose the color for the edge of the shape. 
To change its transparency, move the slider. 
Far left is completely transparent (invisible); 
far right is completely opaque.

To make the shape change in width, height, or both based 
on a tag’s value, choose the tag. Next, enter the minimum 
and maximum width or height for the shape (typically the 
Min and Max values of the tag). 

A rectangle or square expands from the Origin point. 
A circle or oval expands from its center, but the center is 
placed at the Origin point and the rest of the circle is cut 
off. For example, a circle with an Origin of Upper Left 
creates a quarter circle. A circle with an Origin of Center 
creates a complete circle. 
You can use these shapes next to each other or on top of 
each other to create more complex shapes and indicators.

Choose where the shape is drawn from. If 
you enter dynamic width or height, this is the 
starting point of the shape’s expansion.

(Optional) For an explanation of this property, 
see “Make a Gadget Visible Based on a Tag” on 
page 76.
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LED GADGET

An LED is a read-only gadget that typically indicates the state of a numeric value. It can be used with Boolean 
tags (on/off, true/false), with numeric values with multiple colors to indicate an exact value or a range, or with 
string values with multiple colors to indicate an exact match. For Boolean tags, the LED is off when the value is 
0 and on when the value is non-zero.

LED on

LED off

On and Off states for a blue LED

Leave label text at Auto or enter size in pixels. 
Choose label font. Default is Arial.
Make label text bold, italics, or both. Default is neither.

Change label text or background color (click the rectangle 
and choose).

Leave graphic size at Auto or choose size in 
page grid units. 

Enter a label for the LED.

Align label on the left or right 
side of the LED. Default is left.

For a Boolean tag: 
Click the colored circle and choose 
colors to indicate LED is on (True) or 
off (False).

NOTE: For any property with a link button, you can click to break the link and choose the property value 
independently for Desktop & Tablet versus Handheld layouts. See “Properties and Layouts” on page 75.

For a non-Boolean tag: 
Click the Add Range button to set 
colors for each range. 

Enter a specific value for Exact, or the start and end values for Range. 

Choose the range color.

Click to close editor for this range. 
To add another, click Add Range.

LEDs with multiple colors

Choose when the color should appear:
Exact: Color appears for the specified value. 
Range: Color appears for any value within a range.
Negate: If checked, color appears if value is outside the specified 
value or range.

(Optional) For an explanation of this 
property, see “Make a Gadget Visible 
Based on a Tag” on page 76.
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CHECKBOX GADGET

The Checkbox gadget is a read/write binary input that your user can toggle on or off by selecting the box. 
Off = zero, On = non-zero. 

 

Checkbox gadgets

NOTE: For any property with a link button, you can click to break the link 
and choose the property value independently for Desktop & Tablet versus 
Handheld layouts. See “Properties and Layouts” on page 75.

Leave label text at Auto or enter size in pixels. 
Choose label font. Default is Arial.
Make label text bold, italics, or both. Default is neither.
Change label text or background color (click the 
rectangle and choose).
Leave gadget size at Auto or choose size in 
page grid units. 

Enter a label for the Checkbox.

Align label on the left or right side of the LED. Default is left.

Click to require confirmation 
before a write.

(Optional) For an explanation of this property, 
see “Make a Gadget Visible Based on a Tag” on 
page 76.
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INDICATOR BUTTON GADGET

The Indicator Button gadget is a read/write binary button that your user can toggle on or off by clicking it. 
Off = zero, On = non-zero. This gadget can be displayed as a button (with an integral color to show status) or 
as two images (one for On and one for Off ). See more about using images in “Managing Images in the Image 
Library” on page 88.

Button display—configurable color

Button off

Button on

For a button: 
Leave label text at Auto or enter size in pixels. 
Choose label font. Default is Arial.
Make label text bold, italics, or both. Default is neither.
Change colors for On/Off indicator, button text, and button 
background (click the rectangle and choose).

For a button, enter a label for the Checkbox.

NOTE: For any property with a link button, you can click to break the link and 
choose the property value independently for Desktop & Tablet versus 
Handheld layouts. See “Properties and Layouts” on page 75.

Choose whether to display a button 
or images.

Click to require confirmation before a write.

For an image:
Click here to open the Image Library and 
choose an image to show when the 
button is On. 
Choose a second image for when the 
button is Off.

Opacity: To change how transparent an image is, enter a value 
between 0 and 100. Zero is completely transparent (invisible); 
100 is completely opaque.

Image display

Button on

Button off

(Optional) For an explanation of this 
property, see “Make a Gadget Visible 
Based on a Tag” on page 76.
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COMMAND BUTTON GADGET

The Command Button gadget sends a value to a numeric or string variable. The value is sent once when the 
button is pressed. 

Optionally, in addition to writing a value, the button can also immediately navigate to a groov View page (a 
page you’ve created, the Event Status page, or the Event Logs page) after successfully writing the value. The 
target page opens in the same window. 

This gadget can be displayed as a button or as an image. See more about using images in “Managing Images 
in the Image Library” on page 88.

Command button gadgets—Display Modes

Buttons

Image

For an image:
Click here to open the Image Library.

To change how transparent an image is, enter a value 
between 0 and 100. Zero is completely transparent (invisible); 
100 is completely opaque.

NOTE: For any property with a link button, you can click to break the link and 
choose the property value independently for Desktop & Tablet versus 
Handheld layouts. See “Properties and Layouts” on page 75.

For a button: 
Leave label text at Auto or enter size in pixels. 
Choose label font. Default is Arial.
Make label text bold, italics, or both. Default is neither.
Change colors for On/Off indicator, button text, and button 
background (click the rectangle and choose).

For a button, enter a label 
for the button.

Choose whether to display a 
button or an image.

Click to require confirmation 
before a write.

Enter the value to write.

(Optional) To also open a 
page, choose the type 
(and name) to open.

(Optional) For an explanation of this 
property, see “Make a Gadget Visible 
Based on a Tag” on page 76.
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MOMENTARY BUTTON GADGET

The Momentary Button gadget simulates a normally open button. It writes a value once when it is pressed, 
and another value when released. This gadget might be used to drive a motor to raise and lower a crane, or to 
start and stop a drill. You can choose to display the button as a button or as an image. See more about using 
images in “Managing Images in the Image Library” on page 88.

For a Boolean tag, select either True or False for the Press Value. 

For integers and floats, enter both a Press Value and a Release Value. Optionally, you can also enter a Toggle 
Value. When a Toggle Value is entered, the Press Value and Toggle Value are written alternately once per 
second while the button is pressed. The Press Value is always written first. When the button is released, the 
Release Value is written. 

For a Boolean tag, select either 
True or False. 

Momentary button gadget—Display Modes

For an integer or float, select a Press Value and a Release Value, and 
optionally a Toggle Value. 
A Toggle Value can help you detect a communication failure. Use controller 
logic to detect the failure while the button is pressed and to implement a 
failsafe if needed. 

For an image, click here to open the Image Library.

To change how transparent an image is, enter a value between 0 and 100. Zero is 
completely transparent (invisible); 100 is completely opaque.

NOTE: For any property with a link button, you can click to break the link and 
choose the property value independently for Desktop & Tablet versus 
Handheld layouts. See “Properties and Layouts” on page 75.

For a button: 
Enter a label for the button.
Leave label text at Auto or enter size in pixels. 
Choose label font. Default is Arial.
Make label text bold, italics, or both. Default is 
neither.
Change colors for button text and background 
(click the rectangle and choose).

Choose whether to display a 
button or an image.

Choose whether to display a button or an image.

Buttons

Image

(Optional) For an explanation of this 
property, see “Make a Gadget Visible 
Based on a Tag” on page 76.
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SLIDER GADGET

The Slider gadget is a read/write gauge that displays an analog or float-type value using a horizontal or 
vertical bar that fills to indicate the present position or value. This gadget is the same as the Level Indicator 
gadget (page 121) except that a user can grab and move the slider button to change the value and write it to 
the controller. You might use this gadget for room temperature setpoints, alarm values, PID settings, etc.

Enter the slider’s minimum and maximum values.

Enter the number of places to the right of the decimal 
point to be displayed.

Check to require confirmation before a new value is written.

Check the box to continually write values as the slider is dragged. 
If unchecked, value is written once you let go.

Choose to show the value as a value or a percent, or choose 
not to show the value.

Enter Engineering units for the value (gallons, amps, etc.).

Choose a horizontal or vertical slider.

Value

Color

PrecisionLabel

Button

Leave text at Auto or enter size in pixels (controls both label 
and value text, if shown).

Enter a title (label) for the slider.

NOTE: For any property with a link button, you can click to break the link and 
choose the property value independently for Desktop & Tablet versus 
Handheld layouts. See “Properties and Layouts” on page 75.

For the value (if shown):
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).

Change the slider’s indicator color or background.

Leave gadget size at Auto or choose size in page grid units. 

For the label:
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).

(Optional) For an explanation of this property, see “Make 
a Gadget Visible Based on a Tag” on page 76.
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LEVEL INDICATOR GADGET

The Level Indicator gadget is a read-only gauge that displays an analog or float-type value using a horizontal 
or vertical bar that fills to indicate the present position or value. You might use this gadget for a fuel gauge or 
a noise-level indicator, for example.

Value

Color

PrecisionLabel

Enter the slider’s minimum and maximum values.

Enter the number of places to the right of the decimal 
point to be displayed.

Choose to show the value as a value or a percent, or choose not 
to show the value.

Enter Engineering units for the value (gallons, amps, etc.).

Choose a horizontal or vertical slider.

Leave text at Auto or enter size in pixels (controls both label 
and value text, if shown).

Enter a title (label) for the slider.

NOTE: For any property with a link button, you can click to break the link and 
choose the property value independently for Desktop & Tablet versus 
Handheld layouts. See “Properties and Layouts” on page 75.

For the value (if shown):
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).

Change the slider’s indicator color or background.

Leave gadget size at Auto or choose size in page grid units. 

For the label:
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).

(Optional) For an explanation of this property, see “Make a 
Gadget Visible Based on a Tag” on page 76.
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TEXT AREA GADGET

The Text Area gadget is a read-only gadget for displaying numerical or string data. Enter text just as you want 
it to appear, and use enough pound signs (#) to accommodate numeric data to be displayed. For example, 
##.# could display 35.0, and ###.## could display 350.86. For string data, just use one #. 

Enter text and enough pound signs 
(#) to display the tag’s value.
Use one # for a string.

Value (data)Text

Background

Align text at the left, center, or right within the gadget. 
Default is left.
Align text at top, middle, or bottom within the gadget. 
Default is middle.

Choose font for the value. Default is Arial. 

Change text or gadget background color (click the 
rectangle and choose).

Choose text font and size. Defaults are Arial, 12.

NOTE: For any property with a link button, you can click to break the 
link and choose the property value independently for Desktop & Tablet 
versus Handheld layouts. See “Properties and Layouts” on page 75.

Choose bold, italics, and color for value. 

(Optional) To change the value style when the tag’s 
value reaches a specific level, click the button to add a 
format rule. You can add multiple rules.

Make text bold, italics, or both, and choose font color 
(A button).

Choose the condition from the drop-down list. 
Boolean tags show only True/False.
Enter values for the condition.
Choose the style and color to indicate this condition. 

(Optional) For an explanation of 
this property, see “Make a 
Gadget Visible Based on a Tag” 
on page 76.
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TEXT BOX GADGET

The Text Box gadget is a write-only field that your user can change to send numerical or string data. When 
the user clicks in the Text Box, a dialog box appears for entering data. For example, when entering a password 
for security, data the user enters can appear on screen as asterisks only. Data is sent when the OK button is 
clicked or tapped.

Select a text box size for user input. If you 
choose Unlimited, you cannot enter a label.

For numerical data, enter the minimum and 
maximum values your user can enter.

Enter a label (title) for the Text Box.

Label

Value

NOTE: For any property with a link button, you can click to break the link and 
choose the property value independently for Desktop & Tablet versus 
Handheld layouts. See “Properties and Layouts” on page 75.

Enter pre- and post-prompts for the Edit Value 
dialog box. The pre-prompt appears above the 
value they enter. The post-prompt appears 
below it, for example to indicate units.

Leave text at Auto or enter size in pixels (controls both label 
and value text).

For the value (if shown):
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).

For the label:
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).

Change gadget background color.

Pre-prompt

Align the label at left or right side of value. Default is left.

Enter the format of the text your user 
should enter. For a string, use one #.

(Optional) For an explanation of this property, see 
“Make a Gadget Visible Based on a Tag” on page 76.

To have input appear on the screen as asterisks, check this box.
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VALUE GADGET

The Value gadget is a read-only gadget for displaying numerical or string data. It has a uniform width to make 
it easy to line up multiple gadgets. The text format changes depending on the tag type, so you don’t have to 
configure it manually. For example, a float-type tag will have #.## while an integer tag will have just #. 

If you use a Boolean tag, you can use the default ON and OFF text for true and false values, or enter your own 
labels such as Running and Stopped. In the Label field, enter text just as you want it to appear. 

ValueLabel

Value format is entered for you based on the 
tag you choose. To add precision on a float, 
enter additional pound signs (#) after the 
decimal point. 
For a string, use the default of #.## 
For Boolean tags, you can customize the true 
and false text.

Change gadget background color.

NOTE: For any property with a link button, you can click to break the link and 
choose the property value independently for Desktop & Tablet versus 
Handheld layouts. See “Properties and Layouts” on page 75.

(Optional) To change the value style when the tag’s 
value reaches a specific level, click the button to add a 
format rule. You can add multiple rules.

Choose the condition from the drop-down list. 
Boolean tags show only True/False.
Enter values for the condition.
Choose the style and color to indicate this condition. 

Choose label font and size. Defaults: Arial, 12

Make label bold, italics, or underlined, and 
choose font color (A button).

Choose the width and alignment for the 
value field. Change font, format, and color.

Enter label name

(Optional) For an explanation of this 
property, see “Make a Gadget Visible 
Based on a Tag” on page 76.
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IMAGE INDICATOR GADGET

With the read-only Image Indicator gadget, you can use multiple images to represent the changing values 
of a tag. For example, you can use one image to indicate that a pump is on and one to indicate that it is off, or 
show different images of a tank depending on how full the tank is.

The Image Indicator can be used with Boolean tags (on/off, true/false) with numeric values with multiple 
images to indicate an exact value or a range, or with string values with multiple images to indicate an exact 
match. 

You choose each image you want to use from the Image Library and assign the status or value range to that 
image. (See “Managing Images in the Image Library” on page 88.) 

Click to add image.

To change how transparent the image is, 
enter a value between 0 and 100. Zero is 
completely transparent (invisible); 100 is 
completely opaque.

Image currently added

Click to change this image.

Image Indicator gadget changes the image based on the 
value of the tag (only one image appears).

Choose when the image should appear: 
Exact: Image appears for specific value. 
Range: Image appears for any value within 
a range.
Negate: If checked, image appears if the 
value is outside the specified value 
or range.

Enter exact value; or for a range, enter 
minimum and maximum values.

Click to close editor for this image. 
Click Add Image again to add the next image.

(Optional) For an explanation of this 
property, see “Make a Gadget Visible 
Based on a Tag” on page 76.
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ROUND GAUGE GADGET

The Round Gauge gadget is a read-only gauge that displays an analog or float-type value using a rotating 
needle and decimal numerical display to indicate the present value. Possible uses include water or gas 
pressure gauges, the speed of a conveyor belt, and so on.

Enter the gauge’s minimum and 
maximum values.

Choose colors for the 
needle and the gauge’s 
background.

Enter the number of places to the right of 
the decimal point to be displayed.

Enter Engineering units (gallons, PSI, etc.).

Enter the start and end values for this 
range. These must be not more or less than 
the gauge’s min and max values.

Check to display the value in the gadget.

Click here to add a color as a range 
indicator on the gauge.

Choose the range color.

Choose Custom to 
override the default tic 
marks. See descriptions 
above left.

Click to close editor for this range. 
To add another, click Add Range.

Current Value
Units

Range color

Needle color

Max Value
Min Value

Range Start Value

Range End Value

Panel continues at left.

If the value is very large (for 
example, 50,000 kilograms), you 
can scale the value so numbers 
are more readable.

For the markers around the gauge:
Leave at Auto or choose size. 
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).

For the current value:
Leave at Auto or choose size.
Choose font. Default is Arial.
Make text bold, italics, or both. Default is bold.
Change color (click the rectangle and choose).

More on Markers
For both major and minor intervals, if you use the 
default (0), groov View calculates the optimum 
number and spacing of tic marks to show on the 
gauge. If the Custom intervals you enter create 
more than 200 tic marks (major and minor 
combined), groov View overrides your entries and 
sets the number and spacing so markers and values 
are legible. (Your Custom entries still appear in the 
Properties panel but are not used.)

NOTE: For any property with a link button, you can 
click to break the link and choose the property 
value independently for Desktop & Tablet versus 
Handheld layouts. See “Properties and Layouts” 
on page 75.

Panel continued from right.

(Optional) For an explanation of this 
property, see “Make a Gadget Visible 
Based on a Tag” on page 76.
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RANGE INDICATOR GADGET

Use the Range Indicator gadget to show on a horizontal or vertical scale where data appears in a range of 
numbers. This gadget is commonly used as a thermometer, but it can indicate any kind of data within a range. 
If you arrange several of these together on a page, an operator can tell at a glance if a machine is operating 
correctly or see the status of several similar devices.

Enter the number of places to the right 
of the decimal point to display.

Enter a label for the gauge.

Enter Engineering units (for example, 
degrees, GPM, PSI).

Change background color for 
gauge. 

Select a horizontal or 
vertical gauge.

Choose Custom to override 
the default tic marks. 
See “More on Markers” on 
page 128.

Range 
color

Major tic

Label

Value

Units

Minor tic

Enter the gauge’s 
minimum and maximum 
values.

Choose to show the value as a value, a 
percent, or not to show it.

Enter the start and end values for this 
range. These must be not more or less than 
the gauge’s min and max values.

Click here to add a color as 
a range indicator on the 
gauge.

Choose the range color.

Click to close editor for this range. 
To add another, click Add Range.

For the markers on the gauge:
Choose font. Default is Arial.
Make text bold, italics, or both. 
Default is neither.
Change color (click the 
rectangle and choose). 

For the current value:
Choose font. Default is Arial.
Make text bold, italics, or both. 
Default is bold.
Change color (click the rectangle 
and choose).

For the label:
Leave at Auto or choose size.
Choose font. Default is Arial.
Make text bold, italics, or both. 
Default is bold.
Change color (click the rectangle 
and choose).

Leave gadget size at Auto or 
choose size in page grid 
units.

NOTE: For any property with a link button, you can click to 
break the link and choose the property value independently 
for Desktop & Tablet versus Handheld layouts. See 
“Properties and Layouts” on page 75.

If the value is very large 
(for example, 50,000 
kilograms), you can scale 
the value so numbers are 
more readable.

(Optional) For an explanation of 
this property, see “Make a 
Gadget Visible Based on a Tag” 
on page 76.
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More on Markers

For both major and minor intervals, if you use the default (0), groov View calculates the optimum number and 
spacing of tic marks to show on the range indicator. 

If the Custom intervals you enter create more than 200 tic marks (major and minor combined), groov View 
overrides your entries and sets the number and spacing so markers and values are legible. (Your Custom 
entries still appear in the Properties panel but are not used.)

TREND GADGET

Use the Trend gadget to create a trend that shows how a variable changes over time. You can configure up to 
4 pens (variables) per trend, each with a different tag.

Trending starts in groov View when you save your changes. If a page contains a Trend gadget that has 
accumulated data, the Trend gadget immediately has data when the page is opened in View. The scanned 
values are retained if groov EPIC, groov Server, or the groov Box is restarted.

In groov View, you can download data from each pen to a CSV (.csv) file, which you can open in an 
application like Microsoft Excel. See “Download Data from a Trend” on page 133. 

Classic or Interactive

When you configure the Trend gadget, you can choose between a Classic Trend or an Interactive Trend.

Classic Trend. For simple trends with a relatively small number of data points collected over a period of up 
to 7 days. You can hover over or touch a spot on the trend to see data for that time.

Interactive Trend. For showing a large number of data points or data over a longer period (up to 5 years). 
You can zoom in and out on the trend to see details. Because interactive trends can hold much more data, 
groov View provides additional navigation aids and manages the display of data differently than a classic 
trend.
• groov View displays raw data as a line chart when the zoom level matches the rate that the data is 

sampled (sampling rate). This is the default zoom level when you switch from Build mode to View mode, 
so you will see a line chart when you switch to View mode.

• If you switch to a zoom level that is larger than the sampling rate, then groov View displays data that is 
averaged as well as minimum and maximum values. groov View displays the averaged values as a solid 

Hover or touch to see trend details 
at any point. 

Time

Trend title

Left axis

Download 
Data button

Pen legend
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line, with the minimum and maximum values creating a shaded region around the line (see A Zoom 
tabs below).

A Zoom tabs. Click a tab to zoom in on data. groov View generates these tabs and assigns the time 
period based on the trend’s period.
– If you click on the tab with a time period that is close to the sampling rate, then groov View 

displays the trend as a line chart (like the one above).
– If you click on the tab with a time period that is larger than the sampling rate, then groov View 

displays an average with the minimum and maximum for each point. The trend will look like a 
line chart with additional shading around the line, like this one:

B Trend title. You create the title; for reference, you may want to include the trend period in the title.
C Download Data button. Downloads all data for the period, not just the current view. For more 

information, see “Download Data from a Trend” on page 133.
D Navigator line. Displays a thumbnail of the trend through one trend period, or as much as has been 

collected up to the current date/time.
E Date and time scale. Depending on the trend’s period, it may show only time or only date.
F View details. Hover or touch on the trend to see pen names and trend details at any point.

– If the period is close to the sample rate, groov View shows the raw data. The example at the top 
of the page shows the raw data of a data point taken on Monday, January 11, at 3:59 PM.

A B C

GF
ED
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– If the period is larger than the sampling rate, then groov View shows three points of data: 
average, minimum, and maximum. (The example below shows the details of a data point 
taken on Monday, January 11, at 1:42 PM (1).) The box that points to the center data point (2) 
shows the average value. The box that points to the bottom data point (3) contains the 
minimum and maximum; the minimum value applies to the bottom data point and the 
maximum value applies to the top data point.

G Data navigator. Helps you adjust the amount of data you see on the screen. To zoom in or out, drag 
the handles on either side (1). To keep the same zoom level but see a different date/time, put your 
cursor in the center of the navigator (2) and drag it to the left or the right. Or just click or tap on 
another date/time on the navigator line to see the data at that date/time.

In the example at the top of page 129, you can click or tap 13:30 to see the same limited view of 
data around that time. This method works especially well on mobile devices where a finger may not 
fit inside the zoom section.
To return to the current date/time, drag the navigator to the right until it stops.
After you drag or tap, wait for the data to fill in.

Note that there is no room in the interactive trend for a pen legend. If your users view your groov View 
interface on a device (such as a TV) where they cannot hover over a data point, use the Text Area gadget 
(page 122) to add a legend next to the trend to indicate pen colors.

1

2

3

1

2
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For the axes:
Leave text size at Auto or choose size.
Select the axis you want to configure (left or right)
Enter the axis title. To enter a degree symbol, see 
Appendix D.

Choose the trend’s background color.

Enter the Period (maximum 7 days for a Classic trend, 
5 years for an Interactive trend).

Enter a title for the trend. (For an Interactive trend, you can 
include the trend period in the title for reference.)

Click here to add pens. See “Configure Pens” below.

Enter how often you want data captured. No data is captured between intervals. 
A red text box indicates that you have entered a value less than the minimum. 
The minimum varies based on the Period you entered. 

Choose Custom to set the minimum and maximum values that make sense 
for the configured tag (pen). Auto sets these values for you; in View the trend 
zooms in or out to accommodate the real-time range of the pen. Also see 
“Configure Value Limits and Min/Max Values” on page 132.

For the markers:
Leave at Auto or choose size.
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).

For the trend title:
Leave at Auto or choose size.
Choose font. Default is Arial.
Make text bold, italics, or both. Default is neither.
Change color (click the rectangle and choose).

NOTE: For any property with a link button, you can click to break the 
link and choose the property value independently for Desktop & Tablet 
versus Handheld layouts. See “Properties and Layouts” on page 75.

Trend Gadget

Choose the type of trend (see “Classic or Interactive” on page 128).

Classic trends: A longer Update Interval uses less memory and may give 
better performance on a cell phone. Recommended interval is for a PC.

(Optional) For an explanation of this property, see “Make a Gadget Visible 
Based on a Tag” on page 76.
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Configure Pens

You can configure up to four pens for each trend. To add and configure a pen:
1. In the Trend Properties panel, click Configure Data Sources. 

The Edit Data Sources dialog box appears.

2. Select a tag.
3. Enter a title.
4. Depending on where you want the axis located for this pen, choose either Left or Right in the Axis 

field. Multiple pens can use the same axis.
5. Choose the line type.
6. Choose the color and whether you want to use a fill.
7. For each additional pen, click Add Pen and configure it as desired.
8. Click Done.

Z-Order. The pens are displayed in the order you configure them here. The first pen configured is on the 
bottom of the z-order, and the last one is on top. If you need to change the z-order, the quickest way is to 
change the tags configured for each pen. For example, if you want the bottom pen’s tag to appear on top, 
re-configure the top pen with that tag and move the other tag to the bottom pen.

Configure Value Limits and Min/Max Values

The Minimum Value and Maximum Value change automatically even when Value Limits is set to 
Custom, because groov View automatically adjusts the actual scaling lines and labels for optimum readability. 
For example, they may change when you do any of the following:
• Change the size of the gadget in Build
• Adjust the size of your browser in either Build or View
• Switch from Build to View
• Change the minimum or maximum values on the other axis
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Download Data from a Trend

You can download the data from any pen to a CSV (.csv) file, which can be used by other applications or 
opened in an application like Microsoft Excel. The file consists of a Java/JavaScript® timestamp and a value for 
each data update (determined by the trend’s update interval) during the period of the trend. 

For example, if you have a classic trend with a period of 24 hours and an update interval of 60 seconds, the 
data you download is for the latest 24 hours and shows a data value for each 60-second interval.

If you have an interactive trend with a period of 1 year and an update interval of 60 seconds, the data you 
download is for the latest year and shows a data value for each 60-second interval (a lot of data!). When 
downloading data from an interactive trend, remember:
• The download includes all data for the trend’s period, not just the time period you’re viewing.
• Data is for one pen only.

To download trend data: 
1. In groov View, click the Download Data button in the upper-right corner of the trend and choose 

the pen you want. 
2. When the file has been downloaded, save it in the location you want. 

If you open the file in Excel, it looks something like this:

3. The value in the Timestamp column isn’t really a date and time; it’s actually just a number of seconds. 
You can use Excel to convert it to a number that Excel can then format into a date and time:
a. For each row of data, copy and paste the following formula to an unused column in the 

spreadsheet. This formula converts the seconds into a (UTC time zone) date and time.
=(A2/1000 + ("1/1/1970"-"1/1/1900"+1) * 86400) / 86400

(Optional) To convert the UTC time to local time, add or subtract the number of hours that your time 
varies from UTC. For example, if your time zone is 10 hours ahead of UTC, you can use either of these 
formulas:
=(A2/1000 + ("1/1/1970"-"1/1/1900"+1) * 86400) / 86400 + (10/24)
=(A2/1000 + ("1/1/1970"-"1/1/1900"+1) * 86400) / 86400 + TIME(10,0,0)

b. Next, use Excel’s Format Cells feature to format the resulting number as a date value the way you 
want it displayed.
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Chapter 2

5: Using Events and Notifications

Use this chapter to set up event conditions in groov View and to view event logs. All events are logged, and 
authorized groov View users can see them from either View or Build mode (you can choose to hide them in 
View mode). In addition, all events appear as tags in the tag browser, so you can use an event as an input for a 
gadget.

This chapter also shows you how to set up optional email or text notifications when an event occurs. For 
example, if a machine’s temperature is critical, you can create an event and notify a maintenance technician 
via email or text message when the machine overheats. The technician can click a link in the notification that 
leads to the groov View screen with more data about the machine. 

You can customize messages, send them to groups or individuals, and include time/date stamps and other 
information. A notification can be sent when the event becomes active, inactive, or both. 

In this chapter:
Creating Events ........................................................................................................ 136
Viewing Events ......................................................................................................... 139
Setting Up Notifications....................................................................................... 141
Event Condition Types Reference..................................................................... 148
Using Multiple Conditions .................................................................................. 150

Events and Notifications

Control system

All data from devices in groov View is 
available for logging events and sending 
notifications

groov EPIC, 
groov Server 
for Windows, 
or groov Box

Tank level
If Full

If Empty

Boiler Temperature
If Too Hot! Text me

Email me

Email me
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CREATING EVENTS

You can create events based on one or more conditions. To create an event:
1. In Build mode, select Configure > Events.

2. Click Create New Event.

3. In Event Properties, enter a name for the event.
4. Configure the following fields under Event Conditions to create one or more conditions that define the 

event (for help understanding the conditions and the fields to complete, click the Info icon ):
a. Tag—Click None Selected. In the Select Condition Tag dialog box, browse to a tag to monitor for 

this condition. If the tag is an array, also enter the array index. Then, double-click the tag or click 
Select Tag.
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b. Condition—Click the drop-down menu and choose the condition type for the event. (For Boolean 
true/false or state tags, the condition Equal is chosen for you.) 

c. Complete additional fields as needed for the tag type and condition type you chose. 
For example, choose True or False for state tags. For analog or numeric tags, enter a comparison 
value. For Above Limit, enter the limit and choose whether the event should occur when the value 
is greater than the limit or greater than or equal to the limit. For some cases, you may also want to 
enter hysteresis values or debounce times. For more information, see “Event Condition Types 
Reference” on page 148.

d. After completing the fields, click Add New Condition to save your entries. The new condition 
appears at the right (or below on a smaller screen). 

NOTE: Be sure to click Add New Condition. If no conditions appear, you’ll receive an error message when you 
try to save the event. 

e. If you want the event to depend on additional conditions, choose another tag, complete the fields, 
and click Add New Condition again. 

For details on conditions, see “Event Condition Types 
Reference” on page 148.
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f. If the event depends on more than one condition, complete the This event is active when... 
sentence. Choose All if all of the conditions must be true to trigger the event. Choose Any if only 
one of them needs to be true to trigger the event. Also see “Using Multiple Conditions” on page 150.

5. (Optional) To show a custom message in the event log, scroll down to Notification Messages.
The event message in the log (and in an email or text notification if you send one) contains default text to 
identify the event. Default text includes the event name, date/time, and whether the event began or 
ended. You can enter a custom message in this section if you wish. 

6. Click Create Event to save the new event.
7. Click Close to return to the main workspace.

As soon as you save an event it is enabled, so if the event conditions become true it is logged. groov EPIC, 
groov Server for Windows, and the groov Box continually scan for the event tags and monitor for event 
conditions even if groov View is closed. 

When an event occurs, the events icon in the upper-right corner of 
groov View changes, showing the number of events that have occurred. To 
view event status, click the icon. Also see “Viewing Events” on page 139.

Use Events as Inputs for Gadgets

Once you have created an event, it becomes a read-only Boolean tag 
that you can use as an input for a gadget. To see these event tags, go to 
the Gadget Palette. Click the Tags tab, and then click the Events 
device (see image at right).

Enable and Disable Events

When a configured event is enabled, the event is logged (and 
notifications are sent if applicable) when the event conditions are met. 
To enable or disable an event, choose Configure > Events and find 
the event you want. Click its Enabled/Disabled button (see image 
below).

New conditions
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VIEWING EVENTS

As soon as you create an event, it is enabled; when the event occurs, it is logged. To view, sort, and filter 
logged event messages, click the Events icon (the bell) in the top right corner of either Build or View mode.

A list of configured events appears next to a menu of viewing options.

NOTE: If you don’t want your users to see Events, you can choose to hide the Events icon in View mode. See “Changing 
the General Project Settings” on page 98.

To see the status of all events: choose Current Status. You see a list of configured events and whether 
they are active (meaning that the event conditions have been met) or inactive. The text and indicator turn 
blue for events that are active; black for inactive. 

To see a list of all logged event messages: choose Message Logs.

Click here

Active event
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To sort logged event messages when looking at Current Status: click Sort By and choose one of the 
following:
• Event Name
• Active/Inactive
• Enabled/Disabled

To see only some events when looking at Message Logs: choose Filters and complete the fields.

To download a text file of all logged messages:, click Log Controls and choose Download Logs. You 
can open the text file in a text editor like Notepad or save the file for later viewing. 

NOTE: If you are using the groov View REST API, you can also download logs to the API endpoint using any HTTP client 
in either standard text or JSON format. (For more information on the REST API, visit developer.opto22.com.)

An active event is one that is enabled and is occurring right now. You can 
enable or disable events in Build mode (see page 148).

You can use one or a combination of these filters:
• In the fields for Event Name Filter and Message Filter, enter a 

text string. 
• In the Start and End boxes for Time Range Filter, click in the 

field and select a date and time for each one. 

https://developer.opto22.com/


CHAPTER 5: USING EVENTS AND NOTIFICATIONS

groov View User’s Guide 141

To delete all event messages from the log: click Log Controls and choose Clear Logs. Only users with a 
security level of Admin can clear logs.

Event Message Log Capacity

groov View checks the size of the Event Message Log every 30 minutes. If it is more than 200 MB (typically over 
a million entries), the oldest 25% of entries are trimmed. If this occurs, a message is posted to the Log Viewer 
noting that the oldest entries have been removed. For more about the Log Viewer, see “Viewing Log 
Messages” on page 96.

SETTING UP NOTIFICATIONS

You can choose to notify one or more authorized groov View users when an event occurs, at the beginning of 
the event, at the end of the event, or both. These steps assume you have already created the event (if not, see 
“Creating Events” on page 136).

Follow these steps to set up notifications:
1. Set Up the groov View Email Account...................................................... 141
2. Set Up groov View Users to Receive Event Notifications.................. 145
3. Add Notifications to Events ........................................................................... 147

1. Set Up the groov View Email Account

This section sets up the account that groov View uses to send email and text notifications. Beginning in May 
2022, for better security, most email accounts require you to generate and use a new application-specific 
password (called an app password) to send email in groov View. An app password is a long, randomly 
generated code that gives groov View permission to access your email account. 

Follow the setup instructions for your email account:
• For accounts other than Gmail®, see the next section.
• For Gmail accounts, see page 142.

Setting Up the groov View Email Account (not Gmail)

The steps below are generally applicable, but check with your email account for specific details. For Yahoo® 
accounts, for example, see the complete configuration instructions in Yahoo Help. 
1. Create an email account that’s used just for this groov View. 

A separate email account makes it clear where the email is coming from, and it provides a record of all 
successfully sent notifications in the Sent Mail folder of the groov View account. (Currently, groov View 
does not buffer notifications that failed to send.) 
Also, by creating a separate account for this groov View, you can change email settings and not impact 
your business or personal email account settings.

2. On your email account’s Security page, click Generate app password or a similar link.
3. For the app’s name, enter groov View.
4. Generate the app password.
5. Keep the generated password in a secure place so you can use it for any device you want to allow to use 

the account. Also, keep the app password backed up and safe in case you need to restore factory settings 
or the backup file fails or is lost.

6. Follow any other instructions for your email account, then click Done or Save.
7. Back in groov View’s Build mode, choose Configure > Project.

https://help.yahoo.com/kb/new-mail-for-desktop/SLN15241.html?impressions=true&guccounter=1&guce_referrer=aHR0cHM6Ly93d3cuZ29vZ2xlLmNvbS8&guce_referrer_sig=AQAAAJZJ-q54M9RnIkwKgJ8M5ksTkHzHEVYeJT5EqHcMrNzm4OlMP7vGeiPEW9Ko6BcwIxeN42Mw5Q-Rm2VZ5wgU4tIZcpAQONowaIoOqxMspUkEMOHs6ZUpYslsxd59AopBGGTksLz8ndfvfrvU4UKJTaFT_uxlRZ-DJN5-KS8jRWRX
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8. In the Email Settings section on the right, set up the groov View email account as follows:
a. SMTP server hostname—Enter the SMTP server address.
b. SMTP server port—Consider the following:

– The SMTP port is a number between 1 and 65535. Common ports are 25 and 587 for mail 
servers using STARTTLS or no connection security, and 465 for those using SSL.

– If you are outside a company network, you may need to try port 587. Other email servers might 
need different port numbers. Check with your IT group if you are using a company email server 
to send the emails.

c. Connection security—Choose STARTTLS if you are using a large service such as Yahoo. Other 
email servers may need a different setting.

d. Allow untrusted certificates—Check this if your internal mail server uses a self-signed 
certificate.

e. Sender address—Enter the email address of the groov View account you created previously. 
Some services might ignore this.

f. Username—Enter the username for the groov View email account.
g. Password—Enter the app password you just generated for the groov View email account.
h. Send a test email—Enter an email address that can receive a test email and can easily be checked.
i. Click Send Test Email to test your connection settings.

If a message in green letters appears that says , make sure it arrived in 
the inbox of the email account you sent the message to. If you see a red error message, try different 
settings in the groov View email account.

9. Scroll to the top, click Save Settings, and click Close.

Continue with step 2: “2. Set Up groov View Users to Receive Event Notifications” on page 145.

Setting Up the groov View Email Account Using Gmail

Follow these steps if you are using Gmail for the account groov View sends email from. If you are using an 
email service other than Gmail, see the more general guidelines starting on page 141.

Creating a separate Gmail account for groov View makes it clear where the email is coming from and provides 
a record of all sent notifications in the Sent Mail folder of the groov View account. The Sent Mail folder thus 
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functions as a kind of automatic, cloud-based log file. Also, by creating a separate account for groov View, you 
can change email settings and not impact your company or personal email account settings.

If you have more than one Opto 22 device sending email notifications, you may decide to give each device its 
own email address. That way the person who receives the email knows immediately which device it came 
from, and incoming emails can be automatically sorted into folders.

NOTE: Before you begin, ensure you have a phone number to receive a code when setting up Google’s 2-step 
verification.

1. Go to https://accounts.google.com, and log into the existing account for your device (or you can create a 
new account).

2. In the left column, click Security.
3. Scroll down to the How you sign in to Google section, and click 2-Step Verification. If prompted, 

enter your password.

4. If not already turned on, click Turn on 2-Step Verification. You may be prompted to enter your 
password again.

5. Set up the phone number for 2-step verification:
a. When prompted (or click Add Phone Number), enter the phone number you want to use.
b. Select Text message or Phone call from the drop-down menu.
c. Click Next (bottom right).
d. Enter the confirmation code received on the phone, and click Verify. This completes the 2-step 

verification setup.

NOTE: Enabling 2-step verification automatically turns off the Less Secure Access setting. The app password 
replaces that access and is more secure.

6. On the 2-Step Verification page, scroll down to the App passwords section, and click the arrow (>) icon.

https://accounts.google.com
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7. In the App Name field, enter a name for the device.
Multiple devices can use the same password if they use the same address for sending email, in which 
case you can enter a generic name (such as Opto 22 devices). Or, you can assign individual passwords 
under separate device names. 
For example, suppose you are an OEM and are using the same email address for machines at all your 
customer sites. If you want to revoke email for one customer, you can go into your email account and 
simply turn off that customer’s machine password rather than going on site or downloading new logic to 
turn off that machine feature.

8. Click Create.

9. Contrary to the note on the page, keep the generated password in a secure place. You may need this 
app password when restoring factory settings or if the backup file fails or is lost. This is the only 
opportunity you have to obtain this app password. If you lose it, you will need to delete it and generate 
another.
You can also use this app password for any device you want to allow to use this Google account. For 
example, you may have more than one PAC Control strategy that uses the same email account. You may 
also use the same app password for groov View events, Node-RED emails, and Google services.

10. Click Done.
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11. Back in groov View’s Build mode, select Configure > Project.

12. In the Email Settings window, set up the groov View email account as follows:
a. SMTP server hostname—Enter smtp.googlemail.com.
b. SMTP server port—Enter a number between 1 and 65535. For Gmail, common ports are 25 and 

587. 
– If you are inside a company network, you probably need port 25.
– If you are outside a company network, you may need port 587.

c. Connection security—Choose STARTTLS.
d. Allow untrusted certificates—Make sure this option is not selected.
e. Sender address—Enter the Gmail address of the groov View account you created previously. 
f. Username—Enter the Gmail address (the same as the Sender address). 
g. Password—Enter the app password you just generated for the groov View Gmail account. (Note 

that this password is only for your devices; for sign-in by a human, you use the same password you 
used before.)

h. Send a test email—Enter an email address that can receive a test email and can be easily checked.
i. Click Send Test Email to test your connection settings.

If a message in green letters appears that says , make sure it arrived in 
the inbox of the email account you sent the message to. If you see a red error message, try different 
settings in the groov View email account.

13. Scroll to the top, click Save Settings, and click Close.

Continue with the next section.

2. Set Up groov View Users to Receive Event Notifications

IMPORTANT: Before setting up notifications, make sure you and your users understand any limitations and 
charges that may apply to those who receive text or email notifications. Limitations and charges vary by carrier, plan, 
and country.

This section shows you how to set up email addresses for all groov View users who should receive event 
notifications as email or text messages.

Text message notifications are valuable when cell coverage is weak and you can receive only phone calls and 
plain text messages (SMS); even when your email client can’t update, you can still get important notifications. 
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SMS messages are generally limited to 160 characters, but limits vary by carrier and country, so check with 
your local carrier.
1. In Build mode, choose Configure > Accounts.
2. Click the Users tab.
3. Select the user’s name from the list.
4. Click the pencil (Edit) icon next to the name to open the Edit dialog box.

5. Enter one of the following in the Email field:
– For email notifications, enter a valid email address. For example, BPhang@foomail.com.
– For text message notifications, enter the user’s phone number followed by the domain used by 

the carrier to send text messages to phones. For example, to send a text message to a Verizon® 
phone, use the recipient’s mobile phone number followed by @vtext.com. If the phone number 
is 555-123-4567, you type 5551234567@vtext.com
For a list of carriers and email addresses, see the next section, “Email Addresses for Text Messaging.”

NOTE: if you want the same person to get both email and text message notifications, you need to create two 
user accounts: one for email and one for texts.

6. Click Update User. Notice that the email or text address is now shown in the list of users. 

Email Addresses for Text Messaging

By using an email-to-SMS (Short Message Service) email address you can send a text message notification 
from groov View. Check with your carrier for SMS character limits.

Here is a list of common cell phone carriers in the U.S. and Canada with the email-to-SMS email addresses they 
use for sending text messages via email to a cell phone. Choose the carrier for the phone you want to receive 
event notifications.

Carrier  Email-to-SMS Email Address

AT&T® 10digitphonenumber@txt.att.net

Comcast® 10digitphonenumber@comcastpcs.textmsg.com

MCI® 10digitphonenumber@pagemci.com

Nextel® 10digitphonenumber@messaging.nextel.com

Qwest® 10digitphonenumber@qwestmp.com
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For carriers not listed here, see the following websites:
• http://martinfitzpatrick.name/list-of-email-to-sms-gateways/
• http://www.emailtextmessages.com/

3. Add Notifications to Events

1. In Build mode, choose Configure > Events.
2. Click the name of the event you want to send a notification for.
3. Scroll down to Notification Recipients and configure the following options:

a. For Send Email On Event, check the boxes to send the email when the event begins, when it ends, 
or both.

b. Select the users to receive notifications using one of these options:
– Check the Send to every user with an assigned email address option. The To: list is 

ignored.
– Click in the To: text box and select the users who should be notified.
All recipients must have an email address configured to receive event notifications. You can add 
users who don’t have email addresses, but they won’t receive notifications until addresses have 
been assigned. To assign and edit user email addresses, choose Configure > Accounts and edit 
the user (see page 145).

TIP: If you have configured a group, you can add the group in the To: field, and all the users in that group will 
receive the notification.

4. Customize your message in the Notification Messages section. If you leave the subject line or message 
empty, a default subject line or message is used.

Sprint® 10digitphonenumber@messaging.sprintpcs.com

T-Mobile® 10digitphonenumber@tmomail.net

US Cellular® 10digitphonenumber@email.uscc.net 

Verizon® 10digitphonenumber@vtext.com

Carrier  Email-to-SMS Email Address

http://martinfitzpatrick.name/list-of-email-to-sms-gateways/
http://www.emailtextmessages.com/
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You can add Condition Tags, Project Tags, or a Timestamp to a message. When you add a Condition Tag 
or a Project Tag to a message, the < Tag Name > placeholder is replaced in the email by the tag’s value 
at the time of the event beginning or end. 

Click the icons above to add the following:
a. Condition Tags—The tags that you have referenced in the conditions for this event. When using 

condition tags, if you alter the conditions for this event, make sure that your tag references in these 
messages are updated to match.

b. Project Tags—All of the device tags in this groov View project.
c. Timestamps—All < Timestamp > placeholders are replaced in the email by the current local 

time of the event’s beginning or ending.
– On a groov EPIC processor, the timestamp is from the processor. To adjust the time and date, 

see Chapter 10 in the groov EPIC User’s Guide (form 2267).
– In groov Server for Windows, the timestamp uses the local time the PC is set to.
– On a groov Box, make sure your time zone is correctly set in groov Admin. By default, the 

groov Box is set to UTC. If you change the time zone in groov Admin, you must restart the 
groov Box for the change to propagate through groov View. Once restarted, event timestamps 
use the configured time zone. For more information, see “Changing the Time Zone” in the 
groov Box User’s Guide for GROOV-AR1 (form 2104). (For the GROOV-AT1, see form 2077.)

5. Scroll back up to the top of the window and click Update Event.
6. Click Close to return to Build mode. 

Once you save or update an event, it becomes active. If the event conditions become true, a notification is 
sent to groov View even while you are in Build mode. groov View continually scans for the event tags and 
monitors for event conditions even if you have groov View closed. 

When an event occurs, the events icon in the upper-right corner of 
groov View changes, showing the number of events that have occurred. To 
view event status, click the icon. Also see “Viewing Events” on page 139.

EVENT CONDITION TYPES REFERENCE

Use the information in this section when creating events (page 136). If you want to use multiple conditions, 
also see “Using Multiple Conditions” on page 150.

Not Equal

The event is active when the tag value is not equal to the Comparison Value. The event is inactive when the 
tag value is equal to the Comparison Value.

Debounce Time. Debounce time filters out tag value noise. It specifies how long the tag’s value must satisfy 
the condition before the event becomes active or inactive. If in that time the tag returns to a value that does 
not satisfy the condition, the event does not become active (or inactive).

Debounce time is an integer value in units of seconds.

Condition Tags Project Tags Timestamp

http://www.opto22.com/site/documents/doc_drilldown.aspx?aid=4382
https://documents.opto22.com/2104_groov_Box_Users_Guide_for_GROOV-AR1.pdf
https://documents.opto22.com/2267_groov_EPIC_Users_Guide.pdf
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Equal

The event is active when the tag value is equal to the Comparison Value. The event is inactive when the tag 
value is not equal to Comparison Value.

Debounce Time. Debounce time filters out tag value noise. It specifies how long the tag’s value must satisfy 
the condition before the event becomes active or inactive. If in that time the tag returns to a value that does 
not satisfy the condition, the event does not become active (or inactive).

Debounce time is an integer value in units of seconds.

Above Limit

The event is active when the tag value is greater than (or equal to) the Limit Value. To become inactive, the tag 
value must drop to the Limit minus the hysteresis offset or below.

Hysteresis. A hysteresis offset value is used to determine when an active event may be considered inactive. 
It establishes an offset from the condition limit that the tag must reach before the event may transition from 
an active state to inactive.

For Above Limit conditions with hysteresis, the tag value must drop below the Limit Value minus the 
hysteresis offset. For example, if you want to know if a boiler's temperature exceeds a safe limit of 200 degrees, 
you could create an Above Limit condition that monitors the tag assigned to the boiler temperature sensor.

Setting the Limit Value to 200 and a Hysteresis to 20 indicates that if the boiler temperature exceeds 
200 degrees, it should not be considered safe/stable until the temperature drops to 180 degrees or below 
rather than the maximum 200-degree limit.

Debounce Time. Debounce time filters out tag value noise. It specifies how long the tag’s value must satisfy 
the condition before the event becomes active or inactive. If in that time the tag returns to a value that does 
not satisfy the condition, the event does not become active (or inactive).

Debounce time is an integer value in units of seconds.

Below Limit

The event is active when the tag value is less than (or equal to) the Limit Value. To become inactive, the tag 
value must rise up to the Limit plus the hysteresis offset or above.

Hysteresis. A hysteresis offset value is used to determine when an active event becomes inactive. It 
establishes an offset from the condition limit that the tag must reach before the event changes from an active 
state to inactive.

For Below Limit conditions with hysteresis, the tag value must rise above the Limit Value plus the hysteresis 
offset. For example, if you want to monitor a settling pond to determine when it is below capacity and is ready 
to receive more water, you could create a Below Limit condition that monitors the tag assigned to a water 
level sensor.

Setting the Limit Value to 4 (meters) and a Hysteresis of 2 indicates that if the pond drops below 4 meters in 
depth, it should not be considered to be at capacity until the level reaches 6 meters or greater rather than the 
minimum 4-meter limit.

Debounce Time. Debounce time filters out tag value noise. It specifies how long the tag’s value must satisfy 
the condition before the event becomes active or inactive. If in that time the tag returns to a value that does 
not satisfy the condition, the event does not become active (or inactive).

Debounce time is an integer value in units of seconds.
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Outside Range

The event is active when the tag value is less than (or equal to) the Lower Limit or greater than (or equal to) 
the Upper Limit. To become inactive, the tag value must rise up to or above the Lower Limit plus the Lower 
Hysteresis, or drop to or below the Upper Limit minus the Upper Hysteresis.

The hysteresis values are used to determine when an active event tag becomes inactive. They establish a value 
range that the tag must reach before the event changes from an active state to inactive. The Upper Hysteresis 
and Lower Hysteresis are independent of each other and either one may be left blank.

Also, for an Outside Range condition, hysteresis must be less than the difference between the Upper Limit and 
Lower Limit.

Debounce Time. Debounce time filters out tag value noise. It specifies how long the tag’s value must satisfy 
the condition before the event becomes active or inactive. If in that time the tag returns to a value that does 
not satisfy the condition, the event does not become active (or inactive).

Debounce time is an integer value in units of seconds.

Inside Range

The event is active when the tag value is between the Lower and Upper Limits. To become inactive, the tag 
value must drop to or below the Lower Limit minus the Lower Hysteresis, or rise up to or above the Upper 
Limit plus the Upper Hysteresis.

The hysteresis values are used to determine when an active event tag becomes inactive. They establish a value 
range that the tag must reach before the event changes from an active state to inactive. The Upper Hysteresis 
and Lower Hysteresis are independent of each other and either one may be left blank.

USING MULTIPLE CONDITIONS

Using multiple conditions for a single event is a good way to reduce event duplication and to capture events 
that depend on the state of multiple tags. When using more than one condition for an event, the “event is 
active when” statement has the following effect:

Any: The event is active when condition 1 is active OR condition 2 is active OR condition 3 and so on. The 
event becomes inactive only when ALL of the conditions are inactive.

Example uses:
• You have multiple tags that all monitor the same type of condition.
• You want to be notified of a problem in your process that could be caused by any one of a number of 

sub-processes.

All: The event is active when condition 1 is active AND condition 2 is active AND condition 3 and so on. The 
event becomes inactive when ANY of the conditions is inactive.

Example uses:
• Multiple components along a process line turn off sequentially when not in use. It is normal to have 

some components off at any given time. If all of the components are off at the same time, however, that 
may indicate a problem.

• You have a system monitoring multiple boilers. If any one of those boilers becomes too hot, a separate, 
per-boiler event notification is sent to your on-site technicians. If several boilers all become too hot at the 
same time, a notification is sent to your on-call technicians and your engineers.



groov View User’s Guide 151151

Chapter 3

6: Viewing Your Operator 
Interface

The operator interface developed in Build mode can be securely accessed by an authorized user who is using 
groov View from any of the following:
• a groov EPIC’s integral touchscreen 
• a computer’s web browser
• a smartphone, tablet, or other mobile device that has the groov View mobile app or a web browser

In this chapter:
Opening View ........................................................................................................... 151
Opening a Page ....................................................................................................... 152
Logging Out .............................................................................................................. 152
Changing Your Password ..................................................................................... 153
Refreshing the Operator Interface................................................................... 153
Automatic Refresh .................................................................................................. 153
Setting Up groov View Mobile Apps .............................................................. 154
Using groov View over the Internet................................................................ 162

OPENING VIEW

From the groov EPIC Touchscreen

1. Log into the EPIC’s touchscreen.
2. Tap groov View.

From a Computer or Mobile Device’s Web Browser

1. Open your web browser. (To use the groov View mobile app, see “Setting Up groov View Mobile Apps” on 
page 154.)

2. Type https:// and the groov EPIC, groov Server, or groov Box’s hostname as the URL. 
Make sure you type the s: https:// when entering the URL.
– On groov EPIC, use the EPIC’s hostname (chosen when the EPIC was initialized).
– If groov Server is installed on the same computer you’re using, type https://localhost 

If groov Server is installed on a different computer, type https:// and the computer’s hostname. 
For example, if the computer’s hostname is RStarr-w10, you type https://RStarr-w10 
You can use the IP address of the host PC instead of the hostname. However, if the PC is on a 
network with DNS and DHCP, the IP address is subject to change.
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– On a groov Box, the default hostname is printed on the bottom of the Box. For example, if the 
hostname is opto-00-d2-dc, you type: https://opto-00-d2-dc
If you’ve assigned a static IP address to the Box, use the IP address instead of the hostname.

3. Log in with your username and password. For groov EPIC, select groov View. 
groov View opens.

OPENING A PAGE
1. Click the navigation icon in the upper left of the screen to see the pages and page categories.

2. Select the page you want to open. If your pages are displayed in folders, first expand the folder, and then 
select the page you want to open.

LOGGING OUT
1. Click the gear (Menu) icon on the top right.

Navigation icon

Page category

Page

Page you are 
currently viewing

Pages displayed as a flat list.

Pages displayed in folders.
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2. Click Sign out ‘username’.
The login dialog box appears.

CHANGING YOUR PASSWORD
1. Click the gear (Menu) icon on the top right.
2. Choose Change Password.

3. Enter the current password in the Original password field.
4. Enter the new password in the New password field and again in the Confirm password field.
5. Click Change Password.

REFRESHING THE OPERATOR INTERFACE

The operator interface can be refreshed automatically or manually in groov View.

Automatic Refresh

In groov View version R3.5a and higher, any changes you make to your groov View operator interface (new and 
updated pages) are automatically pushed out to all users. Users do not need to refresh their screens. 

Updated groov View Versions

In groov View version R3.2a and higher, when your groov version is updated (for example, from R3.2a to R3.2b), 
clients are automatically updated as well.
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Manual Refresh

If changes have been made and saved in Build mode, you can manually 
refresh View at any time and the new changes appear.

To manually refresh View:
1. Click the gear (Menu) icon on the top right.
2. Click Refresh groov View.

SETTING UP groov VIEW MOBILE APPS

Opto 22’s free groov View apps for iOS and Android are the best way to view your operator interfaces on your 
iPhone, iPad, or Android smartphone or tablet. In the mobile app, you can see one or more groov installations 
in full-screen mode without the address bar, toolbars, and other things you see in a browser. 

To connect to groov View the first time:
1. Download the app: 

– groov View for iOS
– groov View for Android

2. Install the app on your iOS or Android device.
3. Tap the groov icon to start the app.

Continue with the instructions for iOS or Android:
• “Use the iOS Mobile App” (below)
• “Using the Android App” on page 159

Use the iOS Mobile App

In this section:

“Adding a Connection to a groov Device or Server in the iOS App” 
“Connecting, Editing, and Setting a groov View Connection as the Default in the iOS App” 
“Configuring iOS Mobile App Settings” 
“Navigating Through the groov View iOS App” 

Adding a Connection to a groov Device or Server in the iOS App

Use these instructions in the groov View iOS mobile app to connect to a groov EPIC processor or groov Server 
for Windows. You need to perform this task to create the first connection and every time you want to connect 
to a new groov device or server.
1. Tap the groov View icon to open a list view for adding one or more connections.

https://apps.apple.com/us/app/groov-view/id639797810
https://apps.apple.com/us/app/groov-view/id639797810
https://play.google.com/store/apps/details?id=com.opto22.aWD
https://play.google.com/store/apps/details?id=com.opto22.aWD


CHAPTER 6: VIEWING YOUR OPERATOR INTERFACE

groov View User’s Guide 155

2. Tap  to add a new connection. 

3. Enter the following information (tap on the screen outside of the text boxes to hide the keyboard and 
reveal any hidden options):
a. Hostname—Enter https:// and the hostname or IP address of a groov EPIC processor or 

groov Server for Windows.

NOTE: If you are within the company network and have a valid hostname that is registered with the 
domain server, you still might have to enter the fully qualified domain name. For example, if the hostname 
is petrovsgroov and the domain name is somecompany.com, you would enter 
petrovsgroov.somecompany.com.

b. Display Name—Enter a name for the connection (it appears in the connection list).
c. Port—Enter the port number (usually 443).
d. Username and Password—Enter the username and password for this connection.
e. Full Screen—Enable this option to hide navigation to the groov View list. (With this option 

enabled, swipe right to return to the groov View list.)
f. Passcode—Enable this option to add another security layer by requiring a passcode each time this 

connection is viewed on this device. The next time you connect to this groov device or server, you 
are prompted to enter this new passcode.

g. Ignore SSL Warnings—Enable this option to have the device ignore browser security warnings.
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h. Handheld Layout (iPad only)—Enable this option to force the display to use the groov View 
Handheld layout rather than the Desktop layout.

4. Tap Done.

Connecting, Editing, and Setting a groov View Connection as the Default in the iOS App

Follow these steps in the groov View iOS app to connect to a groov device or server, edit the connection 
settings, or set a default connection.
1. Start the groov View app to open a list of connections.

If you haven’t connected a groov device or server, see “Adding a Connection to a groov Device or Server 
in the iOS App” . If you have set and enabled a default connection, groov View automatically attempts to 
connect to the default groov View connection. To return to the list view, swipe right.

2. Tap a connection in the list to view the Options menu:

– Connect—Connects to the selected connection.
– Edit—Opens the selected connection so you can edit connection settings. The screen is filled with 

the data from the selected connection, and the title is the Display Name (if configured) or the 
hostname of the connection. For information about the options, see “Adding a Connection to a 
groov Device or Server in the iOS App” .

– Set as Default—Sets the selected groov View connection as the default so that when you start the 
groov View app it bypasses the connection list and opens the default connection automatically. For 
this to work, also tap the Settings icon at the top of the screen and turn on Enable Default 
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Connection (see “Configuring iOS Mobile App Settings” ). The default connection is indicated with 
a check mark. Only one connection can be the default.

– Delete—Deletes the selected connection from the list.
– Cancel—Closes the Options menu.

Configuring iOS Mobile App Settings

To configure the iOS groov View app settings:
1. Tap the gear (Settings) icon.

2. Configure the following settings:
a. Hide Status Bar—Hides the status bar that normally appears at the top of the screen.
b. Connection Timeout—Sets how long the app spends trying to connect to the groov device or 

server. The timer starts as soon as the Connect menu option is selected.
c. Enable Default Connection—Bypasses the connection list when starting the groov View app and 

goes directly to the default connection. To enable this, you also need to assign a default connection 
in the groov View Options menu. See “Connecting, Editing, and Setting a groov View Connection 
as the Default in the iOS App” .

d. Lock Settings—Locks the settings so that no connections can be added, modified, or deleted, and 
the settings themselves can’t be changed. When using this option, you also need to require a 
passcode. Otherwise, anyone can unlock the settings.

Default connection

Tap the gear icon
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e. Require Passcode—Requires a user of this mobile device to enter a passcode to change the 
settings or to add, modify, and delete connections. You are prompted to enter a new passcode 
when you enable this option.

3. Tap Done to return to the connection list.

Navigating Through the groov View iOS App

• To return to the connection list without closing the current groov View connection, swipe right. This 
works in normal view or with Full Screen enabled (see “Adding a Connection to a groov Device or 
Server in the iOS App” ). The active connection is shown in green.

• To return to the current connection, do one of the following:
– Swipe left from the connection list.
– Tap the active connection and tap Resume from the menu.

• To disconnect from the current connection, tap the connection in the list, and tap Disconnect.
• When you navigate to an external webpage that opens when you tap a URL link in a groov View HMI, 

use the navigation bar at the bottom of the page to return to groov View and tap the groov View icon.

Active connection

Return to groov View
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Using the Android App

In this section:

“Adding a Connection to a groov Device or Server in the iOS App” 
“Connecting, Editing, and Setting a groov View Connection as the Default in the iOS App” 
“Configuring iOS Mobile App Settings” 
“Navigating Through the groov View Android App” 

Adding a Connection to a groov Device or Server in the Android App

Use these instructions in the groov View Android mobile app to connect to a groov EPIC processor or 
groov Server for Windows. You need to perform this task to create the first connection and every time you 
want to connect to a new groov device or server.
1. Tap the groov View icon to open a list view for adding one or more connections.

2. Tap  to add a new connection.

3. Enter the following information:
a. Hostname—Enter https:// and the hostname or IP address of a groov EPIC processor or 

groov Server for Windows.
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NOTE: If you are within the company network and have a valid hostname that is registered with the 
domain server, you still might have to enter the fully qualified domain name. For example, if the hostname 
is petrovsgroov and the domain name is somecompany.com, you would enter 
petrovsgroov.somecompany.com.

b. Display Name—Enter a name for the connection (it appears in the connection list).
c. Port—Enter the port number (usually 443).
d. Username and Password—Enter the username and password for this connection.
e. Full Screen—Enable this option to hide navigation to the groov View list. (With this option 

enabled, swipe right to return to the groov View list.)
f. Require Passcode—Enable this option to add another security layer by requiring a passcode each 

time this connection is viewed on this device. The next time you connect to this groov device or 
server, you are prompted to enter this new passcode.

g. Handheld Layout—Enable this option to force the display to use the groov View Handheld layout 
rather than the Desktop layout.

4. Tap OK.

Connecting, Editing, and Setting a groov View Connection as the Default in the Android App

Follow these steps in the groov View Android app to connect to a groov device or server, edit the connection 
settings, or set a default connection.
1. Start the groov View app to open a list of connections.

If you haven’t connected a groov device or server, see “Adding a Connection to a groov Device or Server 
in the iOS App” . If you have set and enabled a default connection, groov View automatically attempts to 
connect to the default groov View connection. To return to the list view, tap the back button  or 
swipe right.

2. Tap a connection in the list to view the Options menu:

– Connect—Connects to the selected connection.
– Edit—Opens the selected connection so you can edit connection settings. The screen is filled with 

the data from the selected connection, and the title is the Display Name (if configured) or the 
hostname of the connection. For information about the options, see “Adding a Connection to a 
groov Device or Server in the iOS App” .

– Set as Default—Sets the selected groov View connection as the default so that when you start the 
groov View app it bypasses the connection list and opens the default connection automatically. For 
this to work, also tap the Settings icon at the top of the screen and turn on Enable Default 
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Connection (see “Configuring iOS Mobile App Settings” ). The default connection is indicated with 
a check mark. Only one connection can be the default.

– Delete—Deletes the selected connection from the list.
– Cancel—Closes the Options menu.

Configuring Android Mobile App Settings

To configure the Android groov View app settings:
1. Tap the gear (Settings) icon.

2. Configure the following settings:
a. Enable Default Connection—Bypasses the connection list when starting the groov View app and 

goes directly to the default connection. To enable this, you also need to assign a default connection 
in the groov View Options menu. See “Connecting, Editing, and Setting a groov View Connection as 
the Default in the iOS App” .

b. Connection Timeout—Sets how long the app spends trying to connect to the groov device or 
server. The timer starts as soon as the Connect menu option is selected.

c. Lock Settings—Locks the settings so that no connections can be added, modified, or deleted, and 
the settings themselves can’t be changed. When using this option, you also need to require a 
passcode. Otherwise, anyone can unlock the settings.

d. Require Passcode—Requires a user of this mobile device to enter a passcode to change the 
settings or to add, modify, and delete connections. You are prompted to enter a new passcode 
when you enable this option.

3. To return to the list view, tap the back button  or swipe right.

Default connection

Tap the 
gear icon
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Navigating Through the groov View Android App

• To return to the connection list without closing the current groov View connection, swipe right. This 
works in normal view or with Full Screen enabled (see “Adding a Connection to a groov Device or 
Server in the iOS App” ). The active connection is shown in green.

• To return to the current connection, do one of the following:
– Swipe left from the connection list.
– Tap the active connection and tap Resume from the menu.

• To disconnect from the current connection, tap the connection in the list, and tap Disconnect.
• When you navigate to an external webpage that opens when you tap a URL link in a groov View HMI, 

use the navigation bar at the bottom of the page to return to groov View and tap the groov View icon.

USING groov VIEW OVER THE INTERNET

If you’re using a PC or mobile device to communicate with groov View over the internet rather than from 
inside your local area network, we recommend you use a VPN for security. Talk with your IT Department to get 
a VPN set up. For more information about using a VPN, see the Guide to Networking groov Products (form 2161).

Active connection

Return to groov View

https://documents.opto22.com/2161_Guide_to_Networking_groov.pdf
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Chapter 4

7: Troubleshooting and 
Additional Help

This chapter provides troubleshooting information and answers questions you may have about groov View.

In this chapter:
Troubleshooting ...................................................................................................... 163
Working with groov View.................................................................................... 170
Opto 22 Systems ..................................................................................................... 171

TROUBLESHOOTING

In addition to the questions and answers in this chapter, see “Viewing Log Messages” on page 96. Admins for 
groov may also find it useful to create an Admin-only page to show system information such as uptime, 
number of user sessions, CPU usage, and so on. See “Add System Tags” on page 54. 

Q: In groov View on my laptop/HDTV/phone/tablet, all I see is a blank page.

A: There are two possibilities:
• Your web browser may not fully support the modern standards groov is based on. Try downloading the 

latest version of your browser, or try a different browser. We generally recommend Firefox or Chrome, but 
your device might work better with Apple® Safari® or Microsoft Edge®.

• You may be logged in as a user who doesn’t have access to any pages. Go to Build mode and check your 
users and groups to make sure the user has access. See “Managing User Access” on page 81 for help.

Q: In groov View on my mobile device, I can't get the pages to load.

A: If pages won’t load, first, make sure you have at least the minimum OS for your device:
• Android: 4.0.1 (Ice Cream Sandwich)
• iOS: 5.0

If you’re still having problems, here are some things to try:
• Try adding your own company domain to the hostname of the groov EPIC controller, groov Box, or 

groov Server for Windows. Sometimes the DNS (domain name server) won’t resolve the hostname unless 
you add your domain. For example, instead of https://opto-02-81-c2 try 
https://opto-02-81-c2.opto22.com (Your domain will be different. Note the period 
between the hostname and domain.)

• Try adding the port number to the hostname. Port 443 is the default; port 8443 is the secondary, so try 
them in that order. For example, instead of https://opto-02-81-c2 try 
https://opto-02-81-c2:443 (Note the colon between the hostname and port.)
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Q: In groov View, why are some gadgets grayed out with a yellow triangle?

A: If a gadget is grayed out with a yellow triangle, one of these communication problems is occurring:
• groov View isn’t communicating with the groov EPIC, Server, or Box.
• groov View isn’t communicating with the device the tag comes from (for example, a PLC or PAC, OPC UA 

server, etc.). 
• If you’re using the Ignition Edge free trial, the trial may have expired. See the groov EPIC User’s Guide 

(form 2267) or the groov Box User’s Guide for GROOV-AR1 (form 2104) for steps to restart it or to license 
Ignition Edge. 

• The device the tag comes from (for example, an OPC UA server or PLC) is not communicating with your 
control system or equipment.

Click the yellow triangle to display an information dialog box.

• If the information box says that a tag is not available on a SNAP PAC controller, make sure the strategy 
running on that controller matches the idb.txt file you have associated with that IP address.

• If the information box reports Bad_ShelvingTimeOutOfRange, your Ignition Edge trial has probably 
expired, and the internal OPC UA server cannot be reached. 

Once you have fixed communications, groov View automatically restores the gadget to working order.

NOTE: groov View polls the device (for example, a PAC/PLC or OPC UA server) for data once per second. This frequency 
cannot currently be changed.

Q: In groov View, why are some gadgets grayed out with a manila tag?

A: If a gadget is grayed out with a no-tag symbol, the gadget does not have a properly configured tag 
associated with it.

Once you have configured a tag for the gadget, groov View automatically restores the gadget to working 
order.

Q: Why am I not receiving event notifications for properly configured events?

A: You may have lost connection with the device that has the tags (Modbus/TCP device, EPIC, PAC or PLC, OPC 
UA server, etc.). If so, groov View cannot check the tags it’s supposed to be watching, so you won’t receive 
event notifications for those tags.

If you are sending notifications via email, make sure you have updated security for your email account. See the 
Configuring Email Applications for Opto 22 Products Technical Note (form 2384).

Click the Events (bell) icon to open the Events Viewer. If you see the Could not connect... error, you’ll need 
to track down what happened to your lost connection. See also “Viewing Events” on page 139.

Click the yellow 
triangle

No-tag symbol

https://documents.opto22.com/2384_Configuring_Email_Apps_for_Opto22_Products_Technical_Note.pdf
https://documents.opto22.com/2104_groov_Box_Users_Guide_for_GROOV-AR1.pdf
https://documents.opto22.com/2267_groov_EPIC_Users_Guide.pdf
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Q: In Build mode, where are the dialog box buttons?

A: If you can’t see dialog box buttons, your browser’s font size may be set too high. Reduce the browser’s font 
size so that you can see them.

Q: I have groov Server and I’m not able to open groov View. 

A: There might be a conflict with another service running on your computer. In this case, you might need to 
change one or both of the ports groov Server uses to run.

Before changing port numbers, consult with your IT manager as needed.

To change a port number:
1. Open the jetty.conf file installed on the groov Server computer (located in 

Opto22\groov\jetty).

2. Change the port number as necessary.
3. Save and close the file.
4. Restart groov Server and try again.

To restart groov Server:
5. Open the Windows Task Manager and click the Services tab.
6. Right-click groov Server and choose Restart from the pop-up menu.
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Q: I cannot locate my groov EPIC, groov RIO, or groov Box on the network.

A: If your browser can’t connect to your groov RIO module, groov EPIC processor, or groov Box using its 
hostname, you can use groov Find to locate groov devices on your network. You must use groov Find if your 
network does not provide DHCP and DNS services.

For Windows

1. Download groov Find from our website (go to www.opto22.com and search for groov Find).
2. Save the file to your computer.
3. Open groov Find.
4. If you have User Account Control (UAC) turned on, click Yes when asked if you want groov Find to be 

allowed to make changes to your computer.

NOTE 1: If you are using a Windows account that does not have Administrator privileges (such as Guest), you 
need to enter the Administrator username and password to use groov Find. If you do not have this information, 
contact your IT department.

NOTE 2: Clicking Yes permits groov Find to have temporary administrative privileges to create an additional 
temporary IP address for each network interface on the computer. This enables groov Find to locate a 
groov device on a network that does not have DNS and DHCP. If the network does not have DNS and DHCP, you 
need to assign a static IP address to the groov device to maintain communication. (See the device’s user’s guide.) 
If the network does have DNS and DHCP, the temporary IP address is not used and is removed when you exit 
groov Find.

5. Click Yes.
groov Find opens and automatically searches for groov devices on the network.

https://www.opto22.com/
https://www.opto22.com/support/resources-tools/downloads/groovfind-exe
https://www.opto22.com/support/resources-tools/downloads/groovfind-exe
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6. Locate the serial number on the groov device label. 
– On a groov EPIC, open the LCD display and the label is on the back of the display.
– On a groov RIO, the label is on the side of the unit. The serial number is indicated by SN.
– On a groov Box, the label is on the bottom of the unit.

7. Locate the matching serial number in groov Find.

If you do not see the serial number right away, wait 60 seconds and click Search For Devices.
8. Note the groov device’s IP address. Enter this IP address instead of the hostname as the URL in your 

browser: https://<ip address>
Or you can click the link for groov Manage, groov Admin, or groov View depending on your device and 
the software you want to open.

For Macs

1. Go to the App Store and search for Opto 22.
2. On the groov Find app, click Get. If requested, enter your Apple Store ID and password.
3. Click Open. 

Within a minute, groov Find begins locating groov RIOs, groov EPICs, and groov Boxes on your network 
and displays them in a list.

4. Locate the serial number on the groov device label. 
– On a groov EPIC, open the LCD display and the label is on the back of the display.
– On a groov RIO, the label is on the side of the unit. The serial number is indicated by SN.
– On a groov Box, the label is on the bottom of the unit.

5. Locate the matching serial number in groov Find and note the groov device’s IP address. Enter this IP 
address instead of the hostname as the URL in your browser: https://<ip address>

Q: I’m having trouble using Internet Explorer 10 with groov View. 

NOTE: If you have a groov View version higher than 4.4, you cannot build HMIs with Microsoft Edge versions prior to 
79 or with any version of Internet Explorer. However, you can still view your HMIs with these older browser versions.

A: If available to you, try the Microsoft Edge, IE11, Chrome, or Firefox browsers instead. If you have to use 
Internet Explorer 10, make sure the browser is not reverting back to version 9 mode; groov View is not 
compatible with Internet Explorer 9. To do this:
1. Open Internet Explorer 10.

Serial number
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2. If the menu bar is not already showing, right-click anywhere in the top border of the browser and select 
the Menu bar option.

3. Open the Tools menu, and make sure that Compatibility View is not selected.

4. Select Tools > Compatibility View settings.
5. In the Compatibility View Settings dialog box, make sure that no groov IP addresses or hostnames are 

listed under Websites you’ve added to Compatibility View. 
6. Make sure the compatibility options at the bottom of the dialog box are not checked.

Make sure this option is 
not selected.
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7. Click Close.

Q: My cell phone disconnects from groov View after about 30 seconds 
(groov Box). 

A: The settings on your phone can cause a connection to the soft access point on the GROOV-AR1 to 
disconnect.

If you are a Sprint customer, try turning off the Connections Optimizer. 
1. On your phone, go to Settings > More... > Mobile Networks > Connections Optimizer.
2. Uncheck the box for Connections Optimizer.

If you are not a Sprint customer, check your WiFi options.
1. On your phone, go to Settings > WiFi > Advanced.
2. Make sure the Avoid poor Internet connection and Internet Unavailable options are not checked.

Q: I can’t read (or write to) my Modbus/TCP device or the data I get from my 
Modbus/TCP device doesn’t make sense.

A: Although based on a standard protocol, Modbus/TCP devices may be set up differently from one another. 
Some use zero-based addressing and some use one-based addressing. Some devices don’t support all 
Modbus functions. Modbus/TCP devices also vary in the way they present float data. Additionally, device 
documentation sometimes doesn’t specify how the device is set up.

If you’re having trouble reading or writing to your device, or if the data is clearly wrong, start by reading the 
explanations in “Add a Modbus/TCP Device” on page 35. Consult your device’s documentation for help, and 
change the settings for your Modbus device in Configure > Devices and Tags. You may need to try 
different combinations of settings to see what works. 

Make sure these 
options are not 
checked.

Make sure no groov IP 
addresses or hostnames 
are listed.
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If data from the Modbus device doesn’t make any sense (looks like garbage or is completely abnormal), 
change the Use base one addressing setting or change the combination of Value Orders. 

One of the best ways to figure out how to connect with any Modbus/TCP device and get the data presented 
in the right format is to use a Modbus/TCP test utility like ModScan32 from www.Win-Tech.com. Our Product 
Support Group recommends this utility.

You can also use the utility Wireshark (www.wireshark.org) to see the Modbus/TCP traffic between your 
devices, so you know exactly what message was sent and what the specific reply was. 

If you need help, be sure to contact Opto 22 Product Support (see page 7). Product support is free.

Q: I want to check when my license expires or renew my license, but I don’t 
see the Licensing item in the Configure menu. 

A: If groov View is running on a groov EPIC processor, your license does not expire. 

For groov Server or a groov Box, you must be logged into Build mode as an Admin security level user to see 
licensing information or update your license. If you’re logged in as an Editor, you won’t see Licensing in the 
Configure menu.

NOTE: If you’re using a groov Box, it’s easy to confuse groov Admin, the software that administers the Box, with the 
Admin user security level in groov View. For licensing, use the Admin username and password for groov View. 

Q: Is there a forum for groov View? 

A: Yes! There's a groov OptoForum. Find it at www.opto22.com: click Community > Opto Forums and 
choose groov from the categories drop-down list. This is the place to ask and answer questions. 
Experienced engineers and integrators all over the world contribute to OptoForums, so it's a great way to get 
help at any time.

WORKING WITH groov VIEW

Q: How safe is groov View in terms of information security?

A: groov products use the same security as your bank: the latest 256-bit encryption plus authentication with 
usernames and passwords. For communications over the internet, we recommend a virtual private network 
(VPN).

Q: Can I VPN into my groov EPIC?

A: Yes. The groov EPIC processor includes an OpenVPN client. See the groov EPIC User’s Guide (form 2267) for 
information about setting it up. 

Q: Can I VPN directly into my groov Box?

A: The groov Box is not a VPN server. Find out if your company network has a VPN server. Most companies do 
and use it to let employees safely access the network from home or a remote site. Most smartphones have a 
VPN client built into them. For more information, see the Guide to Networking groov Products (form 2161).

http://www.win-tech.com/html/modscan32.htm
https://documents.opto22.com/2161_Guide_to_Networking_groov.pdf
http://www.wireshark.org
https://forums.opto22.com/c/groov
https://www.win-tech.com/
https://www.wireshark.org/
https://www.opto22.com/
https://documents.opto22.com/2267_groov_EPIC_Users_Guide.pdf
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Q: How often does the groov View operator interface update its data?

A: Your interface in groov View polls tags once per second by default. You can change this rate for each device 
as needed. See “Working with a Device” on page 29 and follow the steps for your type of device.

Q: Can I change more than one tag with a single gadget or stack gadgets to do 
two things at once?

A: Sorry, not for control. Currently, groov View supports only one tag per gadget. If you stack gadgets, the one 
on top wins: it’s the only one that will be functional.

But from a monitoring standpoint, if indicators on the gadget at the back are still visible with another gadget 
in front, stacking gadgets can work. See Chapter 4: Gadget Reference for details on each gadget, including 
transparency (opacity) options and using images or colors to indicate values within a range. 

Q: Can gadgets be restricted to particular operators?

A: Operator permissions are based on a page, so everything on one page must be OK for everyone in a user 
group to see and change. If some operators should be able to see a gauge and some should not, for example, 
just create two pages—one that includes the gauge and one that doesn’t. Then assign user rights to the 
pages appropriately. See “Manage User Groups” on page 86.

However, a page can be different for operators using it on a desktop or tablet versus those using it on a 
handheld device. You can stash individual gadgets so they don’t appear in one view while making them still 
visible in the other. See “Use the Page Stash” on page 26. 

Q: Can you choose who can edit which pages?

A: Currently, anyone designated as an Editor can edit all pages in one groov View installation (groov EPIC, 
groov Server, or groov Box). A second groov product would give you the option to assign different Editors to 
different pages.

OPTO 22 SYSTEMS

Q: I'm talking to Opto 22 equipment and can't find my strategy .idb.txt file.

A: Your groov EPIC or SNAP PAC controller is running the control program (strategy) you built in PAC Control. 
When you saved that strategy, the .idb.txt file was automatically created on your PC in the same directory 
as your other strategy files. If you’re now using a different PC, you need to get the .idb.txt file from the 
other computer.

If your computer hides common file type extensions (some do), you’ll see two files with the same name (the 
name of your strategy). Just select the file that does not have the PAC Control icon next to it.

NOTE: If you’re using groov View with an OptoEMU Sensor, you can get the OptoEMU Sensor.idb.txt file from 
www.opto22.com.

Q: What’s the minimum PAC firmware requirement for groov View?

A: The SNAP PAC controller your groov EPIC, groov Box, or groov Server connects to must be running R9.2 or 
higher firmware. If you’re using groov View with an OptoEMU Sensor, you need update file R3.0a or higher.

https://www.opto22.com/
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Q: If a PAC controller is connected to B3000 serial brains, can I get those tags 
in groov View?

A: Yes. If the tag is in the controller, it can be displayed in groov View. 

Q: Can I use groov View to access I/O points on my SNAP PAC brain?

A: Yes, as of version R3.5a, groov View can access memory map tags on a SNAP PAC I/O unit. See “Add an 
Opto 22 I/O Unit” on page 31. 

If you need to access legacy I/O units, it’s possible to do so using KEPServerEX (see next question). 

Q: Can I use groov View with my FactoryFloor system? I have an Ethernet 
card.

A: Yes, but not directly. groov View works with all groov EPIC processors, SNAP PACs running 9.2 firmware or 
higher (SNAP PAC S-series controllers, SNAP PAC R-series controllers, and the SoftPAC software-based 
controller), and with OptoEMU Sensor energy monitoring units running update file R3.0a or newer.

groov View does not work with Opto 22 FactoryFloor, SNAP Ultimate I/O, SNAP-LCSX, other legacy controllers, 
or pre-9.2 SNAP PACs.

However, it’s still possible to use groov View with these legacy systems by installing KEPServerEX with the OPC 
Connectivity Suite. Connect to your FactoryFloor OPC Server (which is an OPC-DA server). groov View (which is 
an OPC UA client) can then connect to KEPServerEX, and you can import your tags.

Q: Can I use tables in groov View?

A: You can select individual elements (indexes) of a table. groov View supports all of these data types: integer, 
float, and string variables and tables, and analog and digital I/O.

Q: How do I use timers/PIDs/Scratch Pad in groov View?

A: groov View supports integer, float, timer, and string variables and tables, and analog and digital I/O. To use 
elements in a PID loop, memory-map Scratch Pad elements, or other data you need in a groov View interface, 
just periodically move the data you want into a variable. 
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Appendix A

A: IP Cameras

The Video gadget works with IP cameras that can serve a single image in response to an HTTP request without 
the need for an ActiveX® control. Make sure that the IP camera or server is configured to provide a single frame 
at a time. IP cameras serve content in a variety of ways, but single-frame display is a very common 
configuration option.

We have successfully used the following IP cameras in our projects:
• Foscam® Fi8910w
• Foscam® Fi9802w
• Vivotek® FD8361
• Vivotek® IP8352

If you are using an IP camera make or model other than the ones listed here, you can try using one of the 
example URLs described in the following sections.
In this appendix:
Serving a Single Image in Response to an HTTP request ..................... 173
Setting up the IP Camera’s Username and Password ............................. 174
Foscam IP Cameras................................................................................................. 174
Vivotek IP Cameras ................................................................................................. 175
Viewing an IP Camera Outside the Network .............................................. 175
Changing the Video Gadget Refresh Period................................................ 175

SERVING A SINGLE IMAGE IN RESPONSE TO AN HTTP REQUEST

groov View does not support streaming. Instead, it uses a web browser to retrieve a sequence of images from 
an IP camera. Therefore, when you set up a Video gadget, you cannot simply paste the IP camera’s IP address 
(like you can in your browser). Nor can you use the link that leads to the IP camera video stream. Instead, you 
need to construct a link that retrieves a single image from your IP camera. Your link may look something like 
this: http://123.123.123.123/snapshot.cgi

Every IP camera is different, so you have to look in your IP camera’s documentation to find out what your 
specific IP camera uses. It might be called either a snapshot or single shot.

TIP: To find URL information for your IP camera on the internet, try searching for your IP camera model number and 
the word snapshot.
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SETTING UP THE IP CAMERA’S USERNAME AND PASSWORD

If your IP camera requires a password, you will need to include the username and password in the URL that the 
browser passes to the IP camera.

NOTE: Not all IP cameras use the same format, so you refer to your IP camera’s documentation for the exact syntax. 

1. Construct the URL to include the username and password.
For example:

http://123.123.123.123/snapshot.cgi?user=yourusername&pwd=yourpassword

Make sure to use your IP camera’s IP address and link information, and use the appropriate username and 
password to replace yourusername and yourpassword. If you do not provide the username and password 
in the URL, groov View displays an empty box instead of the image and prompt you for the username and 
password.

NOTE: The link is not secure because you are passing the username and password in plain text, so it is easy to 
sniff.

2. Open the URL in a new browser tab. 
You should see a static picture.

3. Click Refresh or Reload in the browser.
If the static picture updates to a new picture, this means you have an IP camera and a URL that will work 
with groov View.

4. Copy and paste the URL into the video gadget, and then save the project.
In groov View the image is refreshed at the rate you set in Configure > Project in Build mode.

NOTE: It is the browser, not groov View, that polls the IP camera. This means the browser (not groov View) needs 
to have network access, permissions, and so on to access the IP camera.

If you use this procedure and cannot get the web browser to display a static image from the IP camera, it is not 
an issue with groov View. Check the IP camera itself and its configuration, the browser and its settings, the 
network and subnet, and network permissions. For more information, see “Viewing an IP Camera Outside the 
Network” on page 175.

FOSCAM IP CAMERAS

Foscam Fi8910w
Sample URL:
http://123.123.123.123/snapshot.cgi?user=UUUU&pwd=PPPP

Change the IP address to match your internal or external IP address. Change UUUU to the username for the IP 
camera, and change PPPP to the password for the IP camera.

Foscam Fi9802w
Sample URL:

1. Change the IP address to match your internal or external IP address.
2. Change UUUU to the username for the IP camera, and change PPPP to the password for the IP camera.

http://123.123.123.123/cgi-bin/CGIProxy.fcgi?cmd=snapPicture2&usr=UUUU&pwd=PPPP

http://0.0.0.0/snapshot.cgi?user=yourusername&pwd=yourpassword
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3. If you are using a different port than port 80, you need to add that to the URL.
For example, some Foscam IP cameras use port 88, so 88 is added to the URL as follows:

VIVOTEK IP CAMERAS

IP cameras tested: 
• Vivotek FD8361
• Vivotek IP8352

For details about how to construct a URL for a Vivotek IP camera and configure security, see the 
documentation that came with the IP camera.

Example URL:

Here is an example of a URL to use with a Vivotek IP camera that is compatible with groov View.

This IP camera is on port 8082, and it has been configured with a user (viewer) that has no username or 
password. Your IP camera may be configured differently.

VIEWING AN IP CAMERA OUTSIDE THE NETWORK

If you wish to view your IP camera image from outside your network, you have two options:
• Option 1: Make sure your IP camera can be accessed from outside the local area network it is configured 

on. Discuss access with your IT department so they can set up a VPN or allow a port forward on your 
router to the IP camera.

• Option 2: Use the Proxy option for the video gadget. In this case, groov View polls the IP camera over 
your local area network and presents the updated video frames to the client at the rate (in seconds) set 
on the video gadget.

CAUTION: Be aware that anyone with access to Build mode can view the username and password to the IP camera 
in clear text. This should be accounted for when setting up access to Build mode and access to the IP camera.

CHANGING THE VIDEO GADGET REFRESH PERIOD

The video gadget refresh period sets how often in seconds groov View refreshes the image from an IP camera. 
You can set the default update period for all instances of the video gadget, or you can set the refresh period for 
an individual instance.

If you have a fast internet connection and are not concerned about data use, then you can use the fastest 
setting (0.5 seconds) for a smoother video. However, if you have a slower connection, the video might not be 
able to keep up, and you should set a slower rate by entering a higher value. Also, if you have a data use cap, 
you should probably set a slower rate.

Satellite or cell modem networks may require refresh rates of 5 seconds or slower. For example, the default 
0.5 seconds may be too fast for some ADSL (Asymmetric Digital Subscriber Line) connections.

To set the default update period for all video gadgets:
1. In Build mode, choose Configure > Project.
2. In the General Settings section, enter a value in the Default video gadget refresh period field.

http://123.123.123.123:88/cgi-bin/CGIProxy.fcgi?cmd=snapPicture2&usr=UUUU&pwd=PPPP

http://opto22.groov.com:8082/cgi-bin/viewer/video.jpg?channel=1&resolution=640x480&quality=3
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3. Click Save Settings at the top of the page.
4. Click Close.

To set the update period for an individual video gadget:
1. In Build mode, click the Video gadget to display the Video Gadget Properties.
2. Enter a value in the Update period field.
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Appendix B

B: OPC UA Data Types Supported

The following table shows the official Browse Name for OPC UA data types and the corresponding names 
used in groov View. The official OPC UA data type names are defined in the UA Specification (Part 5, 
Section 12). For information about the data types supported by a specific OPC UA server, see that company’s 
documentation.

OPC UA Type groov View

Boolean Boolean

String String

SByte Signed Byte

Int16 16-bit Signed Integer

Int32 32-bit Signed Integer

Int64 64-bit Signed Integer

Byte Unsigned Byte

UInt16 16-bit Unsigned Integer

UInt32 32-bit Unsigned Integer

UInt64 64-bit Unsigned Integer

Float Single Float

Double Double Float

https://opcfoundation.org/developer-tools/specifications-unified-architecture/part-5-information-model
https://opcfoundation.org/developer-tools/specifications-unified-architecture/part-5-information-model
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Appendix C

C: Data Simulator Tags

The tags provided with groov View’s built-in Data Simulator allow you to experiment with adding tags to 
gadgets, configuring the tags, and running your project in groov View. This appendix lists the Data Simulator 
tags and briefly describes what they do. The first section describes the Basic Tags. For Advanced Tags, see 
page 182.

BASIC TAGS

“Variables” (below)

“General” on page 180

“Square Waves” on page 181

“Sine Waves” on page 182

Variables

Unlike many other tags in the Data Simulator, you can read and write these basic variable tags. There are five 
each of Boolean, float32, integer32, and string data types.

Variable Name Data Type 

bool Variable A boolean

bool Variable B boolean

bool Variable C boolean

bool Variable D boolean

bool Variable E boolean

float32 Variable A 32-bit float

float32 Variable B 32-bit float

float32 Variable C 32-bit float

float32 Variable D 32-bit float

float32 Variable E 32-bit float

int32 Variable A 32-bit integer

int32 Variable B 32-bit integer

int32 Variable C 32-bit integer

int32 Variable D 32-bit integer

int32 Variable E 32-bit integer
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General

The complex and jagged waves have various ranges so that they don’t overlap too much when placed on the 
same Trend.

Sample Stepper, Sawtooth, and Ramp Waves

string Variable A string

string Variable B string

string Variable C string

string Variable D string

string Variable E string

Variable Name Data Type Description

Complex Wave A 32-bit float
A complex but smooth wave, composed of various sine waves, 
with values ranging from -6 to 6.

Complex Wave B 32-bit float
A complex but smooth wave, composed of various sine waves, 
with values ranging from 2 to 14.

Complex Wave C 32-bit float
A complex but smooth wave, composed of various sine waves, 
with values ranging from 0 to 40.

Complex Wave D 32-bit float
A complex but smooth wave, composed of various sine waves, 
with values ranging from -10 to 10.

Jagged Wave A 32-bit float
A jagged wave, composed of various sawtooth patterns, with val-
ues ranging from 0 to 15.

Jagged Wave B 32-bit float
A jagged wave, composed of various sawtooth patterns, with val-
ues ranging from 5 to 25.

Jagged Wave C 32-bit float
A jagged wave, composed of various sawtooth patterns, with val-
ues ranging from 10 to 40.

Ramp A (0 to 10, 30 sec) 32-bit float A ramp pattern, from 0 to 10, with a 30 second period.

Ramp B (0 to 10, 60 sec) 32-bit float A ramp pattern, from 0 to 10, with a 60 second period.

Sawtooth A (0 to 10, 30 sec) 32-bit float A sawtooth pattern, from 0 to 10, with a 30 second period.

Sawtooth B (0 to 10, 60 sec) 32-bit float A sawtooth pattern, from 0 to 10, with a 60 second period.

Stepper A (0 to 4, 30 sec) 32-bit integer Steps from values 0 to 4 over a period of 30 seconds.

Stepper B (0 to 9, 60 sec) 32-bit integer Steps from values 0 to 9 over a period of 60 seconds.

Stepper C (0 to 9, 90 sec) 32-bit integer Steps from values 0 to 9 over a period of 90 seconds. 

Variable Name Data Type 
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Sample Complex and Jagged Waves

Square Waves

Variable Name Data Type Description

Square Wave A (1 sec true/false) boolean
A square wave with a period of 2 seconds: 
TRUE for 1 second then FALSE for 1 second

Square Wave B (2 sec true/false) boolean
A square wave with a period of 4 seconds: 
TRUE for 2 seconds then FALSE for 2 seconds

Square Wave C (5 sec true/false) boolean
A square wave with a period of 10 seconds: 
TRUE for 5 seconds then FALSE for 5 seconds

Square Wave D (10 sec true/false) boolean
A square wave with a period of 20 seconds: 
TRUE for 10 seconds then FALSE for 10 seconds

Square Wave E (Random period) boolean
A square wave with random TRUE/FALSE periods. 
Each TRUE and FALSE state will be within 2 and 4 seconds.

Square Wave F (Random period) boolean
A square wave with random TRUE/FALSE periods. 
Each TRUE and FALSE state will be within 4 and 8 seconds.

Square Wave G (Random period) boolean
A square wave with random TRUE/FALSE periods. 
Each TRUE and FALSE state will be within 6 and 12 seconds
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Sine Waves

Sample Sine Waves

ADVANCED TAGS

“Variables (Extra)” (below)

“Arrays” on page 183

“User Controllable” on page 183

“Static Values” on page 184

Variables (Extra)

These variables have data types that are used less often. Unlike many other tags in the Data Simulator, you can 
read and write these variable tags. There are three of each type.

Wave Name Data Type Description

Cosine (30 sec) 32-bit float Cosine wave with a 30 second period and amplitude of 1

Cosine (60 sec) 32-bit float Cosine wave with a 60 second period and amplitude of 1

Sine (15 min) 32-bit float Sine wave with a 15 minute period and amplitude of 1

Sine (30 min) 32-bit float Sine wave with a 30 minute period and amplitude of 1

Sine (30 sec) 32-bit float Sine wave with a 30 second period and amplitude of 1

Sine (5 min) 32-bit float Sine wave with a 5 minute period and amplitude of 1

Sine (60 sec) 32-bit float Sine wave with a 60 second period and amplitude of 1 

Variable Name Data Type 

float64 Variable A 64-bit float

float64 Variable B 64-bit float

float64 Variable C 64-bit float

int16 Variable A 16-bit integer

int16 Variable B 16-bit integer

int16 Variable C 16-bit integer

int64 Variable A 64-bit integer

int64 Variable B 64-bit integer

int64 Variable C 64-bit integer
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Arrays

The arrays have the most common data types. Like the variables, you can read and write to the elements in 
the array tags.

User Controllable

There are two user-controllable waves (or patterns) that provide you something to interact with in the 
groov View interface.

Ramp A: 0 to 10 is a ramping float32 value that you can start and then clear back to 0.

Sine is a sine wave that you can control for period and amplitude. You can also disable the sine wave, during 
which time it has a value of 0.

int8 Variable A 8-bit integer

int8 Variable B 8-bit integer

int8 Variable C 8-bit integer

uint16 Variable A 16-bit unsigned integer

uint16 Variable B 16-bit unsigned integer

uint16 Variable C 16-bit unsigned integer

uint32 Variable A 32-bit unsigned integer

uint32 Variable B 32-bit unsigned integer

uint32 Variable C 32-bit unsigned integer

uint64 Variable A 64-bit unsigned integer

uint64 Variable B 64-bit unsigned integer

uint64 Variable C 64-bit unsigned integer

uint8 Variable A 8-bit unsigned integer

uint8 Variable B 8-bit unsigned integer

uint8 Variable C 8-bit unsigned integer

Array Name Data Type 

bool Array [100] boolean table

float32 Array [100] 32- bit float table

int32 Array [100] 32-bit integer table

string Array [100] string table

Wave Name Data Type Notes

Ramp A: 0 to 10 (Clear Flag) boolean A boolean flag to clear the ramp

Ramp A: 0 to 10 (Current Value) 32-bit float The current value of the ramp

Ramp A: 0 to 10 (Start Flag) boolean A boolean flag for starting the ramp

Sine (Amplitude, 1 to 1000) 32-bit float The amplitude of the sine wave (0 to 1000)

Sine (Enabled Flag) boolean
The enable flag for the sine way (Setting this tag to False will 
disable the sine wave and set its current value to 0.)

Sine (Period, 1 to 1000 sec) 32-bit float The period of the sine wave (1 to 1000 seconds)

Sine (Value) 32-bit float The current value of the sine wave

Variable Name Data Type 
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Sample Ramp and Sine Waves

Static Values

These tags have static values, which means that they never change.

Static Value Name Data Type Notes

bool Always False boolean Always boolean “false“

bool Always True boolean Always boolean “true“

float32 Always +INF 32-bit float Always float32 “+INF”

float32 Always -INF 32-bit float Always float32 “-INF”

float32 Always 0.0 32-bit float Always float32 “0.0“

float32 Always 1.0 32-bit float Always float32 “1.0“

float32 Always NaN 32-bit float Always float32 “NaN”

float64 Always +INF 64-bit float Always float64 “+INF”

float64 Always -INF 64-bit float Always float64 “-INF”

float64 Always NaN 64-bit float Always float64 “NaN”

int32 Always 0 32-bit integer Always an int32 “0“

int32 Always 1 32-bit integer Always an int32 “1“

string Always ABC string Always a string of “ABC“

string Always Opto 22 string Always a string of “Opto 22“
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page, 21
page category, 94
SNAP PAC controller, 29
system tags, 54
tags to gadgets, 72
user, 82

address
changing device, 68
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Android
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API, 67
API key, 82
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finding, 84
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apps for mobile devices, 3, 154

Auto Navigator gadget, 111
properties, 111

automatic refresh of groov View, 153
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backing up project, 100
Bad_ShelvingTime, 164
below limit, 149
blank page, 163
browsers, 6
Build mode, 2, 9

opening in groov Server for Windows, 10
opening on a groov Box, 10

Button gadget, 117
button, normally open, 119
byte order, 37

C
camera, 112
category

adding, 94
deleting, 95
renaming, 95

changing
API key, 84
gadget properties in different layouts, 75
images, 91
page properties, 21
user password, 87
users, 84
z order for Trend pens, 132

Checkbox gadget, 116
properties, 116

checking
groov version, 102

classic Trend gadget, 128
Color Ranges (LED gadget), 115



groov View User’s Guide186

Command Button gadget, 118, 119
properties, 118

condition tags, 148
configuring

events, 136
gadget properties, 75
notifications, 141
pens for Trend gadget, 132

controller
adding, 29
deleting, 70
disable communication, 69
editing, 68

copying
gadgets, 76
page, 27

creating
events, 136
page, 21
user, 82

CSV file, 44
downloading Trend pen data to, 133
exporting, 43
importing, 41

cutting gadgets, 76

D
data

downloading Trend pen data, 133
settings for Modbus, 37
types for OPC UA, 177
update frequency, 171
zoom in on Trend gadget, 128

data simulator, 179
Data Store, 67
debounce time, 148
deleting

controller, 70
gadgets, 76
I/O unit, 70
images, 91
Modbus/TCP device, 70
OPC UA server, 70
page, 26
page category, 95
users, 86

desktop layout, 77
device

adding, 29
disable communication to device, 69
editing information, 68
working with, 29

disable communication
device, 69

disabling events, 138
disconnecting from groov on phone, 169
Divider gadget, 109

properties, 109
drag page, 28
duplicating a page, 27
dynamic tags, 50

E
editing

device information, 68
images, 91
pages, 171
security level, 83
users, 84

email
setting up, 141

email-to-SMS, 146
enabling events, 138
enlarging a page, 23
equal, 149
event conditions, 148

above limit, 149
below limit, 149
debounce time, 148
equal, 149
hysteresis, 149
inside range, 150
multiple conditions, 150
not equal, 148
outside range, 150

event message log capacity, 141
events

creating, 136
enabling/disabling, 138
notifications, 141
receiving notifications, 145
viewing, 139

expiration, license, 104
exporting

interface pages, 28
Modbus tags (CSV), 43

F
FactoryFloor, 172
finding API key, 84
firewall, 52

video gadget, 112
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G
gadget

Auto Navigator, 111
Button, 117
Checkbox, 116
Command Button, 118, 119
Divider, 109
Group Header, 108
Image, 113
Image Indicator, 125
LED, 115
Level Indicator, 121
Line Header, 109
Momentary Button, 119
Oval, 114
Page Navigator, 110
Range Indicator, 127
Rectangle, 114
Round Gauge, 126
Shape, 114
Slider, 120
Text Area, 122
Text Box, 123
Trend, 128
Value, 124
Video, 112

gadgets
adding, 72
aligning, 77
changing z order, 76
copying, 76
cutting and pasting, 76
fitting on page in View mode, 25
how size is determined in View mode, 22
locking into position, 76
moving, 74
moving to front or back, 76
multiples, 77
properties, 75
resizing, 74
sizing, 74, 77
stacking, 76
video, 173
video refresh, 98

general settings, 98
Gmail account, 142
graphics, 88
grayed out tags, 164
grid units, 22
grid, showing or hiding, 23
groov API, 67
groov EPIC controller, 29

groov Find, 166
groov product

locating on network, 166
groov Server can’t open groov, 165
groov View, 3

changing password, 153
logging out, 152
navigation, 152
opening, 151
opening pages, 152
refreshing pages, 153
refreshing pages automatically, 153
resetting project, 102
switching to from Build mode, 100
using over the Internet, 162

groov View, mobile
Android, 3
iOS, 3, 154

groov, updating, 102
Group Header gadget, 108

properties, 108
groups of users, 86

H
handheld layout, 77
help, 163

Opto 22 Product Support, 7
Product Support, 7

hysteresis, 149

I
I/O unit

adding, 31
deleting, 70
disable communication, 69

idb.txt file, 31, 171
Image gadget, 113

properties, 113
Image Indicator gadget

properties, 125
image library, 88
images

adding, 88
changing, 91
changing view in library, 90
deleting, 91
file types, 88
image library, 88
replacing, 91
uses, 88

importing
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interface pages, 28
Modbus tags (CSV), 41

Indicator Button gadget
properties, 117

inside range, 150
interactive Trend gadget, 128
Internet Explorer, 167
Internet, using groov, 162
iOS app, 154
IP address, 10
IP camera, 112, 173

refresh period, 98

K
KEPServerEX, 45
kiosk

automatic refresh, 153
do not expire login, 98
security level, 83

L
languages, Unicode support, 75
layout

optimizing, 77
types, 77

layout guides, 24
LED gadget

properties, 115
Level Indicator gadget, 121

properties, 121
license

expiration, 104
updating, 104

limiting
users, 83
users by groups, 86

Line Header gadget, 109
properties, 109

locating groov product on network, 166
locking gadgets, 76
Log Viewer, 96
logging events, 139

capacity, 141
logging out

all users, 88
of groov View, 152

logo, adding, 88

M
maintenance

expiration date, 104
renewing, 104
update, 104

managing
users, 81

message log, 139
message log capacity, 141
messages, viewing, 96
min/max values for Trend gadget, 132
mobile apps, 3, 154
mobile devices, 3, 154
Modbus/TCP

adding Modbus device, 35
adding Modbus tags manually, 38
cannot read/write data, 169
creating Modbus tags import file, 41
data, 169
data settings, 37
deleting device, 70
disable communication to device, 69
editing device, 68
exporting Modbus tags import file, 43
importing Modbus tags from CSV file, 44
scaling data, 40
slave ID, 37
tag address, 39

Momentary Button gadget
properties, 119

moving
gadgets, 74
gadgets to front or back, 76
page, 28

multiple conditions, 150

N
Namespace Index, 52
navigation, 110, 111, 118
not equal, 148
notifications, 145

configuring, 141
not being received, 164

O
On/Off Colors (LED gadget), 115
OPC UA

browse name, 177
data types, 177

OPC UA server, 45
adding, 45
deleting, 70
disable communication, 69
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editing, 68
Windows firewall, 52

opening
Build mode, 9
groov View, 151

operator security level, 83
Opto 22 controller, 29
Opto 22 I/O unit, 31
Opto 22 Product Support, 7
OptoEMU Sensor, 171
OptoMMP device

adding, 31
deleting, 70

organizing pages, 94
OS app, 3
outside range, 150
Oval gadget, 114

properties, 114

P
PAC Control

adding strategy, 29
updating tags, 31

Page Navigator gadget, 110
properties, 110

pages
adding, 21
categorizing, 94
changing name, permissions, 21
deleting, 26
duplicating, 27
editing, 171
exporting, 28
fitting gadgets on pages, 25
gadget size in View mode, 22
hide grid, 23
hide rulers, 23
importing, 28
layout guides, 24
navigating between, 110, 111
opening in groov View, 152
organizing, 94
page size overlay, 25
renaming, 27
show grid, 23
show rulers, 23
size, grid, layout, 22
stash, 26
won’t load, 163

password, 82
changing, 87
changing in groov View, 153

IP camera, 174
pasting gadgets, 76
pens for Trend gadget, 132
phone layout, 77
photos, 88
Product Support, 7
project, 148

backing up, 100
exporting and importing pages, 28
restoring, 100
saving, 100
settings, 98

properties
Auto Navigator gadget, 111
Checkbox gadget, 116
Command Button gadget, 118
Divider gadget, 109
gadgets, 75
Group Header gadget, 108
Image gadget, 113
Image Indicator gadget, 125
Indicator Button gadget, 117
LED gadget, 115
Level Indicator gadget, 121
Line Header gadget, 109
Momentary Button gadget, 119
Oval gadget, 114
Page Navigator gadget, 110
Range Indicator gadget, 127
Rectangle gadget, 114
Round Gauge gadget, 126
Shape gadget, 114
Slider gadget, 120
Text Area gadget, 122
Text Box gadget, 123
Trend gadget, 128
Value gadget, 124
Video gadget, 112

properties, gadget
changing in different layouts, 75

proxy, 112

R
Range Indicator gadget, 127

properties, 127
receiving event notifications, 145
Rectangle gadget, 114

properties, 114
refresh period for Video gadget, 98, 175
refresh rate, video, 98, 175
refreshing groov View, 153

automatic refresh, 153
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registers for Modbus, 37
release number, checking, 102
removing

page, 26
users, 86

renaming
page, 27
page category, 95

renewing maintenance, 104
replacing images, 91
requirements, system, 6
reset project, 102
resizing gadgets, 74, 77
restoring

to older groov version, 100
restoring groov project, 100
Round Gauge gadget, 126

properties, 126
rulers

showing or hiding, 23

S
saving groov project, 100
scaling, 40
security level, 83, 170
setting up

events, 136
notifications, 141
users, 81

settings, video refresh period, 175
Shape gadget, 114

properties, 114
simulator, 179
size, of page, 23
sizing

handles, 74
multiple gadgets, 77

slave ID, 37
Slider gadget, 120

properties, 120
smartphone layout, 77
SMTP server, 145
SNAP I/O unit, 31
SNAP PAC controller, 29
SoftPAC, 30
stacking gadgets, 76
STARTTLS, 145
stash, 26
static IP address, 10
static tags, 48
strategy

adding, 31

idb.txt file, 171
updating tags, 31

system
adding system tags, 54
requirements, 6

T
tablet layout, 77
tag address, 39
tags, 148

adding Data Store, 67
adding gadgets, 72
adding Modbus/TCP device, 35
adding OPC UA server, 45
adding Opto 22 controller, 29
adding Opto 22 I/O unit, 31
adding System, 54
dynamic, 50
grayed out, 164
in data simulator, 179
Modbus/TCP, 44
static, 48, 49
updating PAC Control strategy, 31
viewing, 95

Technical Support. See Opto 22 Product Support, 7
test email, 145
Text Area gadget, 122

properties, 122
Text Box gadget, 123

properties, 123
text message notifications, 146
text messaging, setting up, 141
text, Unicode support, 75
time stamp, 148
Trend gadget, 128

changing pen z order, 132
classic trend, 128
configuring pens, 132
downloading pen data, 133
interactive trend, 128
min/max values, 132
properties, 128

troubleshooting, 163
Bad ShelvingTime, 164
blank page, 163
can’t open groov (groov Server), 165
cannot read/write Modbus data, 169
disconnecting from groov on phone, 169
grayed out tags, 164
Internet Explorer, 167
Log Viewer, 96
notifications not received, 164
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Opto 22 Product Support, 7
pages won’t load, 163
yellow triangle, 164

U
Unicode support, 75
updating

data, frequency, 171
groov software, 102
license, 104
PAC Control strategy tags, 31
users, 84

User Account Control, 166
username, 82

for IP camera, 174
users

adding, 82
changing, 84
changing password, 87
creating, 82
deleting, 86
groups, 86
kiosk login, 98, 153
limiting access, 86
logging out all users, 88
security level, 83, 170
types, 81

V
Value gadget, 124

properties, 124
verify tags, 49
version, checking, 102
version, restoring to older groov version, 100
Video gadget, 112

properties, 112
refresh period, 98
setting up camera, 173

video refresh period, 98, 175
video refresh rate, 98
viewing

events, 139
log messages, 96
tags used in events, 95
tags used in the project, 95

VPN, 170

W
web camera, 173
Windows firewall, 52

working with
devices, 29

Write continuously (Slider gadget), 120

Y
yellow triangle, 164

Z
z order, 76

changing, for Trend pens, 132
zoom, 128
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